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Welcome to Petrel 2014 
Finding, characterizing, and exploiting new and existing reservoirs is increasingly complex. To overcome these 
challenges, we must continually improve and innovate the way we work. With the Petrel* E&P Software Platform, 
Schlumberger revolutionized the oil and gas industry by bringing disciplines together with best-in-class science in an 
unparalleled productivity environment.  
 
Our commitment to Petrel resulted in dramatic strides forward in the way we develop and deliver a software 
platform, and with the Petrel 2014 Platform and Update releases, we continue to deliver on our promise of better 
integration, deep science, and productivity. Today we support an engineering team unrivalled in size and expertise, 
empowered by the Ocean software development framework. More than ever before, we are positioned to help you 
develop critical insights into reservoirs throughout the oilfield lifecycle.  
 
This document is updated for the 2014.6 release. The following sections are organized, as far as possible, by domain. 
Within each section you will find the New Features and any significant behavioral changes listed, grouped by the 
release in which they first appeared; with the newest release appearing first. Note that not all domains will have 
New Features in every release. 
 
Refer to the companion documents, Petrel E&P Software Platform 2014 Release Notes and Petrel 2014 Installation 
Guide, for information on licensing and system requirements. 
 
Documentation for all prior Petrel releases is available from the Software Integrated Solutions (SIS) Support Portal. 

http://support.software.slb.com/Pages/ProductDocumentation.aspx?tsLeaf=Petrel&pathFilter=Petrel+Family
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Petrel 2014 User Experience 
Petrel 2014 delivers a step change in User Experience, keeping focus on relevant workflows, and providing quick 
access to the data in a productive and ergonomic working environment. Based on the widely accepted user interface 
methodologies from Microsoft, Petrel 2014 uses the Ribbon concepts to support a logical flow of activities for each 
individual user. Workflows are driven from in-context activities, where the user selects interactive tasks, interacting 
with and operating on the data directly. Petrel gives total freedom to access tools across the whole workflow by 
lifting the concept of an active process. Workflows productivity improvements have been measured and preliminary 
results show: 
• Reduction of long mouse travel between 50-80% 
• Reduction of mouse clicks by 30-40% 
• Increase of the time spent on the data/interpretation tasks by 30-40% 

The clean, aesthetic and logical design makes Petrel easier to adopt and learn, and makes the available technology 
more easily accessible. Petrel 2014 enables you to truly focus on your workflows and on your data, delivering you a 
step change in productivity. 
 

User Experience: General 
Process freedom 
A significant improvement in workflow flexibility and productivity in Petrel 2014 is the removal of the concept of an 
active process, allowing dialogs to be opened and closed whenever you want while, at the same time, maintaining 
full access to all other Petrel tools. 
 
A long standing constraint to workflow productivity has been lifted by disconnecting the availability of tools from the 
concept of active process. The tools and dialogs are instead re-distributed in the interface and made available where 
and when you need them, either in larger scale workflows or close to the objects they apply to. 
 
Not only are the tools disconnected from the processes, we are removing process concept in its entirety. The 
combined effect allows tools to be available all the time: 

- You can interpret seismic and adjust polygons without the need to switch processes  
- You can interpret well tops in the Well section window, edit polygons in the 2D window, and de-spike 

surfaces without the need to switch processes 
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New User Experience/Interface Elements 
Figure 1: Overview and terminology of the user interface components contributing to the new Petrel user experience 

 

Ribbon 
The most visibly noticeable aspect of Petrel 2014 is the user interface redesign, part of which is an implementation of 
the ribbon concept known from Microsoft’s “Fluent UI” technology. Petrel exploits this technology by laying out 
industry relevant workflows in domain tabs, where each tab re-organizes and -distributes the familiar Petrel dialogs 
and tools in left-to-right sequences, guiding you through the work steps necessary to accomplish these end-to-end 
industry workflows. 

Perspectives 
Providing a targeted set of workflows and tools tailored to a key set of user profiles and themes, perspectives focus 
the user interface by only displaying a subset of the available tabs, workflows and tools in Petrel 2014. 
 

Petrel as a platform contains and enables a large number of domains and sciences, each with a specific set of tools 
and workflows. Providing users with a mechanism to modify the user interface in line with their user type, domain or 
workflow, perspectives allow Petrel to offer a targeted working environment for the heterogeneous work force all the 
way down to the individual user. 
 

Figure 2: Using Perspectives, the Petrel user interface can be targeted to your task at hand 
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Tool palettes 
Interactive tools and their associated settings are logically organized into tool sets that are available in a dedicated 
tool palette that can be launched in context of the current workflow or data object. 
 

The tool palette is a floating window that indicates which interactive tool is active. It allows you to select the tools 
you need to complete your workflow without leaving the display window. Many tools have settings that refine the 
way they work, and when active those settings are also available through the tool palette in a dedicated callout 
section. 
Figure 3: Interactive tools are now gathered in a common location with easy access to settings influencing their operation 

 

Contextual tool access 
Petrel now provides the tools you require to complete your current task through a more intuitive interface using 
contextual tabs and mini-toolbars. 
 

Contextual tabs provide access to common tools that you can use to modify the selected object, or alter the view in 
the selected window. The contextual tabs are automatically added to the end of the ribbon when a context is set, 
meaning that whenever a window is active, a window contextual tab is added, and whenever an object is selected an 
associated object contextual tab is added.  

Figure 4: Tools that only apply in the context of windows or objects are gathered in contextual tabs  
and toolbars that surface only when the tools apply 
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Window contextual tab 
Tools, dialogs, and settings that target how a Petrel window is set up, how it displays data, and how it is annotated 
and exported in terms of visual captures, are all collocated and presented in a window contextual tab. 
 
Each window has its own contextual tab with tools that are specific to the window type (e.g., 3D window, 
Interpretation window, etc.). This is where you find functionality to set up the view, link windows, add display 
elements, annotations, and more. The window contextual tab is automatically appended to the ribbon when a 
window becomes active. 

Figure 5: Example of a (3D) window contextual tab 

 

Window toolbar 
The most frequently used tools for each type of Petrel window are made available for quick and easy access inside 
windows themselves; thereby, significantly reducing the amount of mouse travel needed when working with multiple 
windows. 
 
Window toolbars are displayed along the top edge inside the window and move from window to window as they are 
activated. The window toolbars are closely linked to the associated window contextual tabs. Whereas the contextual 
tabs contain the full set of tools applying to the active window, the window toolbar brings a subset of that 
functionality into the display window, close to where you are working. 

Object contextual tab 
Tools, dialogs, and settings that target a specific object type, either by operating on it or consuming it as input, are 
collocated and presented in an object contextual tab. 
 
Each object has its own contextual tab with tools that are specific to the object type (e.g., surface, polygon, 3d grid, 
etc.). This is where you find functionality that acts on or consumes the selected object, such as setting color tables, 
editing tools, operations, database synchronization, and more. The object contextual tab is automatically appended to 
the ribbon when an object becomes selected in the active window or pane. 
 

Figure 6: Example of an (surface) object contextual tab 
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Mini-toolbar 
The most frequently used tools for each object type are made available for quick and easy access close to the data, 
displaying above the familiar context menu that appears when clicking with the right mouse button on objects 
displayed inside a window.  
 
Mini-toolbars only appear in the context of objects and are closely linked to the associated object contextual tabs. 
Whereas the contextual tabs contain the full set of tools applying to the object in context, the mini-toolbar brings a 
subset of that functionality into the display window, close to the object and where you are working. 

Players 
All players in Petrel are now available in a common dialog, sharing the same general look and feel, and when being 
displayed are visible irrespective of active window and active object. 
 
Gathering the Petrel players in a single control interface that you can explicitly display and hide allows for a more 
stable user interface. The players can be accessed when and where needed by invoking context dependent launchers 
on contextual tabs and mini-toolbars, or from the Home tab. 
 
Figure 7: Players in Petrel have been consolidated in a common location with a consistent look-and-feel shared by all the 

players 
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Quick Access Toolbar 
All tools available anywhere on the ribbon can be added to the Quick Access Toolbar which sits at the very top left of 
the application, is available irrespective of the chosen perspective and tab, and has efficient shortcut access via 
KeyTips. 
 
Right-clicking with the mouse on any tool or tab group in the ribbon gives the option to add to the Quick Access 
Toolbar. 

Figure 8: The Quick Access Toolbar is a user customizable area where you can add tools and tab groups 
 by right-clicking these elements in the ribbon 

 

 
 

KeyTips 
The keyboard can be used to access all tools available anywhere on the ribbon by simply hitting the Alt key and 
following the subsequent sequence of auto-generated key tips appearing on the screen. 
 

The KeyTips are provided as a pure usability feature for easy keyboard access to functionality available in the ribbon. 
The auto-generated nature of these KeyTips makes them different from the standard Petrel shortcuts. 
 

Figure 9: KeyTips offer easy keyboard access and navigation of the ribbon, and is consistent with  
similar functionality in Microsoft Office products 

 

 

  

 Quick Access Toolbar (QAT) 
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Shortcuts 
Greater flexibility and re-use of shortcuts between interactive tasks is now possible due to a more explicit focus on 
the various levels of shortcuts available in the system.  
 

The tool sets found in the Tool Palette have in Petrel 2014 been introduced as a new shortcut scope. Previously 
scoped to active process, shortcuts for interactive tools are now reused in accordance with the tool set they belong 
to. The new shortcut scope works in cooperation with the application and window level scopes. 
 

This means that when in polygon editing, shortcuts will refer to tools within polygon editing, the window, or the 
system. Shortcuts relating to seismic interpretation for example are not accessible, until the moment you switch to 
any of the seismic interpretation tools (and thus change the “shortcut scope”). 

Figure 10: Petrel shortcuts are logically organized in various levels (or scopes), offering flexibility  
and re-use of shortcuts between interactive tasks 

 

Layout 
Petrel 2014 comes with a new default pane layout offering a more logical organization of panes that better support 
user profiles and associated work and pane access patterns. 
 

The new organization optimizes data access patterns by distributing commonly accessed panes in non-conflicting 
locations. For instance, geologists and geophysicists commonly switch between the Input and Models panes, 
whereas reservoir and production engineers often access the Cases and Results panes. Hence, to minimize pane  
tab switching, the panes belonging to each pair are now split and put into the upper and lower pane sections 
respectively. The Favorites pane will now, when pinned, appear to the right of the Input/Models or Cases/Results 
pane pairs for easy dragging and dropping of favorite data entries. In addition, the process pane is no longer part  
of the default layout since Petrel does not use the concept of processes anymore, as explained in the section, 
General, Process freedom on page 19.  
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Searching 
New Ctrl+F search functionality provides quick searching, selection and execution of Petrel project data and dialogs 
found in panes. 
 
The search tool traverses all panes in Petrel and presents matches in a list tagged with the panes where they appear. 
Selecting any of the results causes the entry to become selected and the pane brought forward. 
 

Figure 11: A new and powerful Ctrl+F search functionality is introduced, providing you a quick  
and easy way of locating data in your Petrel project 

 
 

Tool Tips 
Improved description of tools and their shortcuts are now available in Tool Tips that appear when hovering over 
buttons in the interface. 

Figure 12: Petrel 2014 comes with richer and more elaborate set of tool tips 
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Mini-toolbar and Context Menu access in View mode 
It is now possible to bring up the object mini-toolbar and context menu while in View mode by simply clicking with 
the right mouse button on objects. This allows you to more efficiently navigate and interact with the data in the 
display window. 

Enrich Your Workflow 
Enrich Your Workflow is a new feature in Petrel 2014 that gives you the information you need to get the most out of 
your Petrel experience. See “Enrich Your Workflow” on page 250 for more information. 

User Experience: Geophysics 
General 
Seismic Interpretation tab 
In the new 2014.1 User Experience, key Geophysics features and tools can be accessed through any of the following 
workflow perspectives: Seismic to Simulation, Geology and Geophysics or Advanced Geophysics. These 
perspectives give access to the Seismic Interpretation tab, which provides these features and tools in the 
following main sequence grouping starting from the left: 
• Setup 
• Seismic-well calibration 
• 2D/3D interpretation 
• Attributes 
• Volume interpretation 
• Structural framework 
• Depth 
• Utilities 
 
Since processes are not used in the new 2014.1 User Experience, some of the Geophysics features and tools are 
located in a different location. The following screen shots demonstrate the differences between the Classic view in 
Petrel 2014.1 and the new Petrel 2014.1 User Experience. 
 

Figure 13: New Petrel 2014.1 User Experience view – Geophysics Tools/Features 
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Figure 14: Petrel 2014.1 Classic View – Geophysics Tools/Features 

 
 
 
Features/tools are grouped logically within each group of tasks located under the Seismic Interpretation domain 
tab so you can find tasks quickly based on the context of your work, for example Volume attributes and Surface 
attributes can be found in the Attributes group, while Geobody interpretation is found in the Volume interpretation 
group. In a typical project, you may start your work path from the left of the tab, with Setup tasks, and progress 
towards the right of the tab, to Depthing tasks.   
 
Alternatively, key features and tools can be accessed directly from and in context of selected data. 
As you work interactively with your seismic data, you can use the following ribbon features, most of which 
automatically adapt their tools and information for the type of data object being manipulated: 

• Tool palette (well tie editing, seismic interpretation, geobody interpretation, polygon editing) 
• Toolbar and contextual tabs for windows  (Interpretation window) 
• Mini-toolbar, contextual tabs and  context menu for objects (seismic, horizon interpretation, fault interpretation, 

fault patch, probe, geobody, multi-Z interpretation) 
• Inspector (seismic, horizon interpretation, fault interpretation, multi-Z interpretation) 
• Player (Intersection) 

The tools located on the Seismic Interpretation toolbar that exist in the Classic user interface are regrouped 
separately to be in closer reach from the different objects of interest. As in the Classic user interface, you can access 
a selection of the seismic tools readily via the Inspector. You can now access the remaining seismic and 
interpretation tools via the new object interfaces e.g., the Seismic mini-toolbar by right-clicking anywhere on a 
seismic section. The current active interpretation objects are indicated towards the left corner of the ribbon. 
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Figure 15: The Classic Seismic interpretation tool has been regrouped for easy access in the 2014.1 ribbon user interface 

 

Modeless access 
The new modeless access to features and tools allows multiple dialogs to be opened simultaneously for a productive 
workflow, for example in the following combination from:  
• Make/edit surface  
• Make velocity model 
• Seismic interpretation  
• Geobody interpretation  

 
This allows for continuous seismic interpretation tasks while engaged in the following example simultaneous 
activities, without the need to change a process:  
• Seismic interpretation 
• Creating polygons 
• Generating surfaces 
• Generating volume attributes. 

Focused object and process activation 
When working in a display window, objects and process modes are now activated and focused automatically. For 
example: 
• Clicking an object in Select mode, automatically activates the object for subsequent use. 
• Creating a new horizon, fault or multi-Z object, automatically puts you in the appropriate Interpretation mode. 
• Inserting a crop volume, automatically puts you into Select mode. 
• When generating a surface, choose the option to automatically display it upon completion. 
 

  

In ribbon  
user interface: 

The Seismic  
interpretation  
toolbar  
in Classic user interface: 
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Quantitative Interpretation  

Quantitative Interpretation tab 
In the new 2014.1 User Experience, key Geophysics features and tools can be accessed through any of the following 
workflow perspectives: Seismic to Simulation, Geology and Geophysics or Advanced Geophysics. The 
Advance Geophysics perspective gives access to the Quantitative Interpretation tab, which provides these 
features and tools in the following main sequence grouping starting from the left: 
 
• Setup 
• Rock physics 
• Seismic-well calibration 
• 2D/3D interpretation 
• AVO 
• Seismic inversion 
• Crossplot 
 
Features/tools are grouped logically, with each group of tasks located under the Quantitative Interpretation tab, so 
you can find tasks quickly based on the context of your work. 
 

Figure 16: New Petrel 2014.1 User Experience view – Quantitative Interpretation tools and features

 

User Experience: Geology 
General 
Corner Point Gridding is available in two ribbon perspectives: Seismic to Simulation and Geology and 
Geophysics.  These processes now work concurrently, for example you can have the Make Horizons dialog open 
while updating the input in Make/Edit Surfaces.  The Make/Edit Surface process, which is fundamental to many 
workflows, can be found in most domain tabs. 
 
Tools for the Pillar Gridding and Fault Modeling processes are combined into a single tool palette. Tool palettes 
are also available for Surface editing and 3D Grid editing. The tools to create and edit a proposed well are available 
in the Well Design tool palette.   
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Figure 17: The Fault model tool palette 

 
Other usability improvements include: 

• Option to display fault models in a new 2D window using the right mouse button 
• Option to display surfaces when running Make/Edit surfaces  

 
Mini-toolbars provide immediate and localized access to object specific functionality.  These are available for Wells, 
Well Tops Logs, Fault Models, Surfaces, and 3D Grids. 
 

Figure 18: Mini toolbar for a fault. 
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Structural Framework 
Process conversion into dialogs 
The workflow steps of the construction of a Structural Model, going from the creation of a Fault Framework to the 
calculation of a Depospace will no longer block anymore the user from being able to use other tools simultaneously. 
 
Several processes in Petrel have been update so that they can be used in combination with others. For example, you 
can have Horizon Modeling and Fault Framework open while still being able to edit a seismic horizon or a fault 
interpretation. 

Fault and Horizons Mini-Toolbars 
Globally in Petrel, mini-toolbars have been introduced to allow easy access to tools related to displayed objects in 
any given window. Faults and Horizons of the Structural Model are adhering to the rule. 
 
Bringing the QC and editing tools in context with the workflow motivated the creation of the mini-toolbars. 

Figure 19: Illustration of the mini-toolbars for Faults and Horizons of the Structural Model 

 
 

For Faults and Horizons, the set of tools are logically outlined to guide the user though the QC workflow. You will 
always be able to open the Fault and Horizon Modeling dialogs directly from the object, as well as call open the 
interpretation tool palette to get access to the interpretation editing tools. 
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Modeling 
Property Modeling is available in two ribbon perspectives: Seismic to Simulation and Geology and Geophysics.  
The Property Modeling ribbon contains all the functionalities for performing Facies and Petrophysical modeling. The 
ribbon tools are classified by function groups and organized in a logical order from left to right, to capture typical 
reservoir modeling workflows. The tool dialogs now work concurrently, for example you can have both the Facies 
and Petrophysical modeling dialogs open while updating the input in Data Analysis. 
 
The new Petrel user experience increases productivity by keeping the focus on your workflow, and more importantly, 
on your data. In addition to the context menu, the mini toolbar gives you access to key interactive tools for the 
displayed property. For example, the mini toolbar provides quick access to the Facies tool palette, property settings, 
and the most useful tools for window display options such as the Property player.   
 

Figure 20: Property mini toolbar and context menu, opened from the data in the window display 
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Figure 21: Property player, opened from mini-toolbar 

 
 
 
 
 
 
The Facies tool palette combines tools for interactive facies editing into one location.  When you select a tool, the 
tool palette expands the settings callout so that you can easily change the tool settings. 
 

Figure 22: Facies tool palette, expanded to show Brush tool options 
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User Experience: Reservoir Engineering 
The new Petrel 2014 user experience brings a clearer, easier to learn, more logical Petrel for each user. Reservoir 
engineering users particularly benefit from the new 2014 interface which can be configured in domain perspectives 
that present, for example, reservoir and production functionality in logical left to right order for petroleum engineering 
workflows. New UI widgets such as the mini-toolbars, players and the Inspector greatly improve your productivity by 
enabling you to access the functionality you want when and where you need it.  
 
A selection of videos to help users migrate to 2014, illustrating reservoir engineering and simulation workflows being 
carried out in the new user experience is available from the SIS software download center. 
In the Reservoir and Production perspective, there are five tabs: Home, Reservoir Engineering, Well 
Engineering, Simulation and Production. 
1. In the Home tab, common to all perspectives, you set up your project, arranging the windows and managing 

data through Studio or Reference project tool.  
2. The Reservoir engineering tab takes you left to right from data import to a reservoir model ready for 

reserves calculation and simulation initialization.  
3. The Well engineering tab is for well and completions design and well performance calculation, leading to 

the field development strategy built either in Development Strategies for ECLIPSE or in Field Management for 
INTERSECT 

4. The Simulation tab provides the tools to import or create, manage, and analyze single and multiple dynamic 
reservoir models, including history matching, uncertainty and production optimization studies. 

5. The Production tab provides the tools for production analysis and production interpretation workflows. 

Generic usability and performance enhancements 

Visual filters tool 

The Visual Filters tool on the Home tab allows you to see at a glance the filters that are applied to wells and grids 
displayed in the 2D or 3D window, and then reset or change applied filters. 

The Visual filters tool can be displayed or hidden by clicking Visual filters  in the View group on the Home tab 
or by using the Ctrl+F8 shortcut. Currently the Visual filters panel supports 2D or 3D windows only.  

Filter display 
 
The Visual filters panel shows the filters that are applicable to the wells, 3D properties or faults currently displayed 
in the active display window. For example, if a well is displayed in the active window then Saved searches and 
Well filters are visible.  
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When a filter is applied and the filter's settings deviate from their default state, the caption of the corresponding 
filter item in the Visual filters panel is shown in bold to provide you with a visual cue that the filter is in use in the 
active display window.  

Every displayed filter contains the shortcut link  on the right side of the filter name. Click the shortcut to navigate 
quickly to the filter in the Petrel tree. For some filters, a dialog with the filter's setting will open.  

Supported filters 

The following filters are supported and displayed by the Visual filters panel:  

Generic  
• 1D filter  

Wells  
• Saved searches  

• Well filters  

3D model and simulation properties  
 
In the caption of the Grid section of the filters, 3D property name is displayed next to the grid name. If a simulation 
property is displayed, case name is also displayed.  

 
 
Buttons under the Grid name provide you with quick access to:  
• I, J, K slicing  

• Property slice player  

• Solid and/or grid rendering  

• Upscale filter  
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Shortcuts are provided to the following filter types:  
• Segment filter  

• Zone filter  

• Local grid filter  

• Value filter - high level control for the Value filter  

• Index filter - high level control for the Index filter  

In addition to the Value and Zone high level filter controls, the Visual filters panel also displays filter settings 
defined on the Filter tab of the corresponding 3D property folder.  

 

Faults  
• Fault filter  

Reset filters 

To reset all applied filters to their default state, click  Reset filters. The default state depends on the filter type. 
Only the filters that are applied to the objects displayed in the active display window are reset.  

Settings 

You can change the transparency and re-size behavior of the Visual filters panel by modifying its properties. To do 
this, click Settings . By default, the resizing of the Visual filters panel occurs automatically based on the size the 
individual filters displayed.  
 

 

Global search 
The global search tool (CTRL-F) is a new general Petrel tool to find data or dialogs throughout your Petrel project.  
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Large model performance  
The whole Petrel platform, all domains, has addressed aspects of the performance of Petrel for large well count, 
large grid-cell count projects in the 2014.1 release. Performance covers the interactivity of Petrel when a large project 
is in use, as well as the time taken for calculation intensive tasks or an overall user workflow. Projects with tens of 
thousands of wells, and containing grids with hundreds of millions of cells have been targeted. Large simulation case 
export performance improvements have targeted INTERSECT simulation cases, but improvement has also been 
achieved for ECLIPSE simulation cases. The interactivity of the Petrel 3D window when visualizing 15,000 wells, or 
using an intersection plan through a grid of over 200 million cells has been improved by 1-2 orders of magnitude. 
 

User Experience: Exploration Geology 
Exploration Geology processes on Petroleum Systems and 
Risk tab 
Exploration Geology processes within the context of Geology and Geophysics are now part of Petrel’s ribbon structure 
and are accessed on the Petroleum Systems and Risk tab. 
 
The position of the processes on the tab guides you through the workflow of screening a petroleum system, preparing 
petroleum system models for simulation in PetroMod, and performing risk assessments. Access to PetroMod 3D 
petroleum systems model simulation results has been simplified. When connected to a PetroMod project, all 3D model 
data can be found on the Results pane, a pre-selection of properties has become unnecessary. 
 
In the new 2014.1 User Experience, key Exploration Geology features and tools can be accessed on the Petroleum 
Systems and Risk tab, which provides these features and tools in the following main sequence grouping starting 
from the left: 
• Model 
• [Simple gridding] 
• [Stratigraphy] 
• Properties 
• Quick look 
• 1D model 
• 3D model 
• Play to prospect risk 
• Analysis 
• [Utilities] 
 
 

Figure 23: Petroleum Systems and Risk tab in Ribbon view 
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This setup guides you through the entire workflow of screening a petroleum system, preparing petroleum system 
models for simulation in PetroMod, and performing risk assessments. 

User Experience: Drilling 
General 
In the Petrel 2014.3 ribbon mode, the Drilling perspective gives access to the Well Design, Well Positioning, 
Offset Well Analysis and Real-time tabs. 
 
• The Well Design tab consists of the key well design tool groups, such as Target, Well path, and some other 

groups which could be used in the Well design workflow such as Well, Trajectory uncertainty, Drilling 
simulation, Completion and Utilities groups. 

 
• The Well Positioning tab consists of the Trajectory uncertainty, No-go zone and Anti-collision tool 

groups and some other groups which could be used in the Well positioning workflow such as Well and Well 
path groups. 

 
• The Offset Well Analysis tab gives accesses to import offset well data, manage EDM data index items and 

manage the drilling risks. You can also use the Well, Well tops and zones, and Utilities tool groups to help 
you manage wells and make marks.  

 
• With the Real-time tab, you can stream real-time data, such as logs, events, and trajectories from InterACT*, as 

well as other third-party WITSML data and files servers. 
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User Experience: Production 
Well Deliverability 
Well Deliverability now supports the new ribbon design. It co-exists under both perspectives Production and 
Reservoir, and Seismic to Simulation. This brings easier, clearer, and organized steps to follow a workflow in a 
logical order from left to right. Having a reservoir and well model, you start by quality checking the well model, 
retrieving fluid properties, associating fluids to the well and reservoir, and optimizing the algorithms for an enhanced 
Well performance simulation. The following features are available from the Well Deliverability group ribbon. 
 

Option Name Description 

PIPESIM import  Importing fluid and well data from PIPESIM  

New fluid properties  Creating a new fluid property, and performing fluid property 
data matching 

IPR manager  Associating the fluid-well and reservoir mode, managing IPR 
properties for perforations, and generating IPR curves 

FC data matching  Creating or editing a flow correlation data matching case for 
single or multiple wells, and optimizing flow correlation for 
vertical and deviated wells 

VFP tables  Creating or editing a VFP table collection for single or 
multiple wells 

VFP Results  Displaying Performance Table Results, and applying quality 
control rules to prepare the table for Predictive Development 
Strategy 

Nodal analysis  Creating a nodal analysis case for single or multiple wells, 
running a nodal analysis case, and creating a nodal analysis 
chart 

 

As part of the Microsoft Fluent UI elements, Well Deliverability functionalities contain contextual tabs for all of the 
objects created after a simulation is run. 
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The following features are available from the Nodal Analysis Tools contextual tab. 
 

Option Name Description 

Run for all wells  
Running a nodal analysis case 

Settings  Viewing and editing the general appearance settings for a 
nodal analysis case 

Reload results  Loading nodal analysis results for a different nodal analysis 
case 

Spreadsheet  Viewing nodal analysis results in a spreadsheet, and creating 
nodal logs 

Summary and details  Viewing, searching, and exporting the output summary and 
details log file for a nodal analysis case 

 
The following features are available from the FC Data Matching Tools contextual tab. 
 

Option Name Description 

Settings  Viewing and editing the general appearance settings for a 
flow correlation data matching case 

Reload results  Loading simulation results for a different flow correlation 
data matching case 

Chart  Displaying flow correlation data matching results graphically 

Spreadsheet  Viewing flow correlation data matching results in a 
spreadsheet, and committing the results 

Summary and details  Viewing, searching, and exporting the output summary and 
details log file for a flow correlation data matching case 

 
Well Deliverability also provides the following Custom element. 
 

Inspector Description 

Nodal analysis Viewing a nodal chart X/Y values of an inflow or outflow 
curve 

Flow correlation data matching  Viewing the X/Y values of a curve displayed on a flow 
correlation data matching chart 
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Production Analytics 
Production Analytics Group is part of the Production domain tab. The Production domain tab exists under the 
Reservoir and Production perspective. All Production Analytics now supports the new ribbon design. The following 
features are available from the Production ribbon. 
 

Option Name Description 

Import (Well data group)  Importing OFM well data 

Results charting  Creating or editing a crossplot chart for analyzing well 
information in time 

Production mapping  Creating or editing a production grid map to identify 
geospatial trends and anomalies in production data 

Production bubble mapping  Creating or editing a production bubble map to display large 
amounts of data to help identify trends, anomalies, or 
potential problems in an area of interest 

New split set  Creating a new split set to back allocate wellbore production 
to the completion level 

Split set manager  Managing split sets by reallocating wellhead production 
rates to completion levels 

 
Production Analytics also provides the following Custom element. 

Inspector Description 

Bubble map Viewing bubble map attributes (property rates and associated 
percentages, values and units), and changing the bubble map 
style  

Production grid map  Viewing production grid map attributes (cell value, nearest 
node, oil production rate, X/Y values), and changing the grid 
map style  
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Geophysics 
Geophysics: General 

2014.5 
Horizon 3D snap (behavioral change) 
The “3D snap” has been updated with a new fixed-size sinc interpolator to produce more accurate results when 
snapping. Additionally, the amplitude attribute stored with the 3D tracked horizon will be updated accordingly.  

In the case where a 3D horizon is autotracked on low frequency (e.g., broadband) seismic data, subtle stair-stepping 
artifacts may be observed. Applying the renewed “3D snap” option with “Max vertical delta” set to 0 will remove 
these artifacts by correctly snapping the horizon to the relevant signal feature. 

Performance 
The following enhancements include: 

• Improved robustness in saving projects when working with horizon interpretations. 
• Closing a project with large regional seismic and temporary interpretation now takes seconds. 

2014.4 
Synthetic seismogram (behavioral change) 
The synthetic seismogram bitmap now displays with smooth interpolation in the 3D and Interpretation window. 

Horizon Interpretation (behavioral change) 
An option to switch off the live update display of the 3D autotracker has been added to the Style tab of the Seismic 
Interpretation Settings dialog. This setting is valid for the duration of a session only; however, it will also be saved 
with the project from version 2015.1 onwards. 

Geobody probes (behavioral change) 
The option to use the Opacity: sum mode when co-rendering triple volumes has been added. 

Performance (behavioral change) 
The speed of amplitude display for a random line in the Interpretation window has been improved in the case 
when the random line with restricted horizons is rotated in a linked 3D window. 
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2014.3 
New file import format “General 3D interpretation lines” 
Horizon interpretation data defined in columns of inline, crossline and z can now be imported via File > Import and 
by using the new file format “General 3D interpretation lines”. 

Seismic Overlay in the Interpretation window 
Seismic Overlay allows co-visualization of seismic attributes/vintages within the same survey, in the Interpretation 
window, which is advantageous for numerous seismic interpretation workflows. Seismic Overlay is available in the 
Interpretation window through the Inspector. Overlay vintages are automatically filtered, based on the geometry of 
the background vintage to avoid a long list of vintages. It is available for both 2D and 3D seismic data. You can 
interpret horizons, faults and also run reconstruction for QC and validation of interpretation, while co-visualizing two 
vintages.  
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Figure 24: Seismic Overlay display in the Interpretation window: Seismic Amplitude vintage 
with wiggle as background and Seismic Velocity vintage as foreground 

 
 

Figure 25: Seismic amplitude vintage with variance vintage as overlay and zones from the reconstruction process, for 
picking and validation of seismic interpretation in the Interpretation window. (Data courtesy of Geoscience Australia) 
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Volume attributes (behavioral change) 

Updated and improved “Consistent Dip” attribute 

The updated Consistent Dip provides a very precise volumetric Dip estimation.  
 
The Consistent Dip estimation is based on an iterative global optimization method to calculate the dip and honors 
global consistency constraints of reciprocity, causality, consistency, and continuity.  

Consistent dip properties: 

Reciprocity  
This principle states that there should be symmetry in the estimate of seismic dips between neighboring traces (both 
in inline and crossline directions and increasing and decreasing trace index numbers).  
 
Causality 
The causality principle describes the relation between a cause and an effect, where the effect is the consequence of 
the cause. In sedimentary layers, the law of superposition states that the sedimentary layers are deposited in a time 
sequence, with the oldest on the bottom and the youngest on the top. This is extended to seismic reflections unless 
layers are disturbed due to tectonic or other reasons. The principle of causality is violated if seismic reflectors (e.g., a 
peak and a trough) swap places from one trace to the next (i.e., they have flipped) and if this happens, the dip 
calculation should be discarded. 
 
Consistency 
If the correct dips have been estimated at each location both in inline and crossline directions, any chosen path from 
one sample at an arbitrary location (x, y) should lead to the same sample at another arbitrary location (xi, yi). 
 
Continuity 
In presence of discontinuities due to faults/channel cuts or due to poor signal-to-noise ratio, a robust method should 
not try to estimate the dip, but instead the method should generate a byproduct (residual dip or dip quality attribute) 
highlighting the area where the dip estimation is not valid.  
 
XYZ versus IJK Space 
Consistent Dip estimation operates in XYZ space (Cartesian coordinate system) for the correct computation of seismic 
dips rather than IJK space (Image coordinate system), which works on a basic assumption that seismic samples are 
equidistant in all three dimensions. Dip estimation methods that do not honor the true bin spacing will amplify the 
apparent dip in one direction (with more spacing, in general crossline direction). Dip estimation in the XYZ space imply 
that the dip fields are stored in the correct (signed) unit, which is in ‘ms m-1’ for seismic data in the time domain, and 
‘m m-1’ for seismic data in the depth domain. 
 
Surface reconstruction 
For proper reconstruction of a local surface from a dip model, negative and positive dips need to be estimated at each 
seismic sample location, both in inline and crossline directions instead of estimating the average dip, which 
measures a single slope value extending over two traces. 
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Figure 26: Shows the schematic of global consistency constraints, which Consistent Dip honors 

 
Instead of the nine Consistent Dip outputs, you can now generate only two outputs based on the selected output 
method type: Dip and azimuth, Inline and crossline Dip, High resolution Dip, or Residual dip and Dip RMS. 
 

Figure 27: a) Consistent Dip attribute now provides two outputs based on the method selected  
b) You have the choice of four different output methods 
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Figure 28: Example of high resolution inline Consistent Dip attribute, highlighting the salt domes and fault system 

 
 
 

Figure 29: Example of Volumetric Azimuth and azimuth calculated along the surface, black arrows show the correlation 
between the volumetric azimuth and the azimuth calculated along the surface 
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Volume attributes 

New “Consistent Curvature” attribute 

Consistent curvature provides the most accurate curvature estimation for precise interpretation of geologic structures 
or subtle stratigraphic features from seismic data. 
 
Consistent curvature properties: 

• Consistent curvature takes the inline and crossline dip or the high resolution consistent dip as an input for 
various curvature attribute generation. This is unlike the traditional volumetric curvature calculations where 
the dip estimation is done on the fly from the seismic amplitude and then, the curvature is computed from 
the dip. Consistent curvature is inherently benefited by the input consistent dip, as consistent dip is the most 
accurate dip estimated by iterative global optimization and honors the global consistency constraints of 
reciprocity, causality, consistency, and continuity. 

• The Consistent curvature algorithm requires four consistent dip cubes, namely negative and positive dip in 
the inline and crossline direction for all the samples. Positive inline and crossline dips are reconstructed by 
the algorithm  from the user input, negative inline and cross line dip (for example, inline and crossline high 
resolution dip models) while honoring the consistency.  

• Calculations of Consistent curvature are done in XYZ space, honoring the true bin spacing of the seismic; 
hence, avoiding exaggeration in the curvature estimation of seismic lineaments in one direction (inline or 
crossline) as in the IJK space curvature calculation. 

 
Figure 30: A schematic showing the inline and cross line negative and positive (reconstructed on demand by algorithm) for 

a sample (Tij) required for the calculation of consistent curvature 
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The following are different Consistent Curvature outputs types:  

- K1 and K2 Curvature 
- Kmax and Kmin Curvature 
- Inline and crossline Kmax curvature 
- Shape index and curvedness 
- Most positive and most negative 
- Azimuth of maximum and minimum curvature  

 
Figure 31: Consistent Curvature attribute dialog showing different Output type 
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Figure 32: Example of Consistent Most Negative Curvature, highlighting the salt domes and fault system 

 
 

New “Directional Blending” attribute 

The directional blending attribute generates a directional dip or curvature attribute highlighting the geologic features 
in a specific azimuthal direction. 
 
A directional dip or curvature attribute generated in a desired azimuthal directions can provide an enhanced image of 
deformation or sweet spots, which could help in correlation with borehole, microseismic, and other production 
measurements. 
 
The directional blending volume attribute requires two inputs (inline and crossline components of a chosen vector 
attribute), and provides one single (blended) output volume at a user-defined azimuthal direction. You can choose the 
azimuth, relative to survey North direction or relative to inline direction and change the azimuth interactively. 
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Figure 33:  Example of Dip Directional Blending a) Highlighting the discontinuities in W-E direction  
b) Highlighting the faults system within N-S orientation 

 
                   a) 

 
                  b) 
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Notes on Consistent Dip, Consistent Curvature, or Directional blending volume attributes: 
 
Case 1: If virtual Consistent Dip, Consistent Curvature, or Directional blending volume attributes are 
created in Petrel 2014.3 and accessed in earlier Petrel 2014 versions, the following applies: 

• Virtual Consistent Dip, Consistent Curvature (with exception of Azimuth of Maximum and minimum 
curvature), or Directional Blending volume attributes can be visualized, interpreted on, and realized. 
However, attribute parameter settings cannot be accessed through the Settings, the Inspector, and the 
Interactive Parameter Control.  

• Virtual Consistent Dip, Consistent Curvature, or Directional Blending volume attributes visualized or realized 
in earlier Petrel 2014 versions may differ from the same attributes visualized or realized in Petrel 2014.3. 

 
Case 2: If a virtual Consistent Dip volume attribute is created in Petrel 2014.2 or earlier versions and opened 
in Petrel 2014.3 or later, the following applies: 

• Virtual Consistent Dip volume attributes can be visualized, interpreted on, and realized. However, attribute 
parameter settings cannot be accessed through the Settings, the Inspector, and the Interactive Parameter 
Control. 

• A virtual Consistent Dip volume attribute visualized or realized in earlier Petrel 2014 versions may differ from 
the same attribute visualized or realized in Petrel 2014.3. 

 
It is recommended to create a Consistent Dip volume attribute in Petrel 2014.3, as it is the most accurate.  

2014.2 
Settings callout for key interpretation tools 
As part of the 2014 User Experience, productivity is further increased for key workflows in seismic interpretation. Via 
the Seismic interpretation tool palette callouts, interpretation objects can be easily activated and horizon, fault and 
multi-Z interpretation tools have easy access to their Settings. 
 
In horizon interpretation, click any of the four horizon tracking tools to activate the selected tracking mode, and also 
open a callout to immediately identify the active horizon interpretation. Two settings buttons below it give you direct 
access to the Autotracking settings tab of the active horizon, and to the Autotracking process defaults for parameter 
tuning. With pre-tuned parameters, you can fluidly initialize new horizons, provide seed interpretations and run 3D 
track, all within close reach of the cursor.  
 

 
 
Similar tool settings callouts are also enabled for Fault interpretation and multi-Z interpretation. 
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Copy 3D horizon interpretation across surveys 
Through a single dialog you can now easily copy all 3D horizon interpretations associated with one survey to another 
3D survey within the same project. The target survey can be of different extent, orientation, annotation, interval 
spacing and coordinate reference system.  If you have a new survey with a larger areal extent, you can use the copy 
function to ‘extend’ the containing survey of your existing interpretation data. 
 
Using the copy function, you can also transfer interpretation data to a new survey defined with different XY 
coordinates. The copy function includes associated horizon attribute data and information about the 3D interpretation 
modes as used in the ‘3D interp inclusion’ filters.   
 

 
 

Geobody probes 
Since the removal of the 4GB memory limitation in the Seismic Texture Cache setting in Petrel 2014, further 
optimization has been done on how Petrel utilizes GPU memory beyond 4GB when handling large seismic data sets in 
geobody interpretation workflows. Petrel now fully supports GPU memory allocation above 4GB, utilizing all the 
available hardware and the latest graphics cards from NVIDIA®. With the latest Kepler cards, seismic volumes of 
tens of GBs are handled with high performance and high quality display. 

2014.1 
SEG-Y 2D toolbox (behavioral changes) 

Original CRS preserved 

When loading 2D SEG-Y files into a project defined with a different CRS, and merging with navigation information 
external to the project (that is using the options “SEG-Y trace coordinates” or “Separate navigation file”), the 
edited/output SEG-Y file now preserves the original file CRS. Previously, such edited SEG-Y files were output in the 
CRS of the project. 
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Figure 34: Updated CRS selection dialog 

 
Access  

To access the SEG-Y 2D toolbox in the new User Interface, right-click anywhere in the background of the Input tab 
and select Import file. Under Files of type, select SEG-Y toolbox (2D)(*.*). Alternatively, on the Home tab, in the 
Manage data group, click Import file. 
 

Figure 35: Access to SEG-Y 2D toolbox is now via the common Import file dialog 

 
 

Seismic compression 
There is now the ability to specify an output path for the compressed ZGY file. 
 

Figure 36: Option to specify an output path for the compressed ZGY file 

 
 

Survey Manager (behavioral change) 
The following column headers have been renamed and now reflect the consistent values reported in the Statistics 
tab of the seismic data Settings dialog. 
 

• The previous column “File size” is now correctly labeled “Bytes consumed by samples”. Note that file sizes on 
disk may be a smaller value due to compression or presence of null traces, or larger due to multi-resolution data 
handling. The values have been reformatted to be more readable and readily comparable in MB and GB units. 
This improvement also allows for better sorting results.   

• The previous column “Format” is now correctly labeled “Bulk value format”.  
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Figure 37: Survey manager  renamed column headers "Bytes consumed by samples" and "Bulk value format" 

 

Interpretation window  

Horizontal slice indicator 

In the Interpretation window, you can find horizontal slice indicators along its vertical axis. These represent available 
time slices and their positions are synchronized across display windows, allowing for fast and easier slice 
manipulation.  
 

Manipulating a time slice in a 3D window for example, updates the vertical position of the corresponding slice 
indicator providing relative orientation. Conversely, manipulating a slice indicator within vertical zones of interest 
identified in the Interpretation window will update its time-slice positioning in the 3D window.  
 

Figure 38: New horizontal slice indicators in the Interpretation window are linked with other  
display windows to easily view and manipulate time slices 

 

 
 

2D seismic line selection (PgUp/PgDn) 

In an active Interpretation Window, easily review 2D lines in the sequence listed in the Input tree or Favorites pane, 
by using the new keyboard shortcuts Page Up and Page Down.  
 
For a selected vintage, use Page Up/Page Down to step through the individual 2D lines. Also, to step through 
virtual, calculated and other child objects of each 2D line, use Shift+Page Up and Shift+Page Down. 
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Compared to the Up and Down arrow keys, using the Page Up/Page Down keys provide the advantage of circular 
selection within a seismic folder. 

Figure 39: Use of keyboard shortcuts Page Up/Page Down in an Interpretation window 

 
 

Color Interpolation 

The Interpretation window uses RGB interpolation to get full true color (24bit) displays of seismic data. 
 
Improvements have been made to the color interpolation of seismic data in the Interpretation window. The same 
technique as already used for seismic data displayed in the 3D window is now also applied for seismic data 
displayed in the Interpretation window. It uses RGB interpolation to get full true color (24bit) displays of seismic data. 
This enhancement is specifically noticeable for seismic color tables that are significantly compressed. 
 

Figure 40: Color interpolation comparison between Petrel 2013 and Petrel 2014 

 
 

Seismic Inspector  

Frequency spectrum 

Understanding the frequency spectrum of seismic data is one of the fundamental tasks of any geoscientist working 
with seismic data. The Inspector enables quick and interactive interrogation of the frequency spectrum as you select 
an area of interest. 
 

Petrel 2014 Petrel 2013 
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Moving the pointer inside the graph display, you can read-out the dB level for each frequency. A fixed window 
covering lengths of 64,128, and 256 samples and a maximum of 9x9 neighboring traces centered on the picked 
sample is analyzed. Graphs are shown for the selected trace and several averages of neighboring traces.  
 
The frequency spectrum display can be used to interrogate 3D and 2D seismic sections. 
 
The graph can be exported as a bitmap or a table of numbers for external reporting. 

Figure 41: Frequency spectrum display in the Seismic Inspector 

 
 

Colors 

It is now possible to set Global (shared) or Local (private) color table for seismic data from the Inspector. 
 
In the Inspector, you can set the Global option, which allows sharing the same color table by many seismic objects at 
a time; or the Local option, which applies a private color table for a selected object. This local color table will only be 
used by this object. A local copy of the global color table can be created and applied for a selected object. 
 

Figure 42: Global and local color tables settings in the Seismic Inspector 

 
In the 3D window, the Colors tab is now accessible for Composite lines. 

  



 

Petrel Platform What’s New Guide 2014 59 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Performance improvements 
Various targeted improvements have been made to Petrel Geophysics: 
 

• Random line visualization: There is performance improvement in panning of random line sections compared to 
2013. Improvements have been made for faster data access and faster interpolation rendering when working 
with different levels of detail. The benefits depend on the hardware specification of the machine used, mainly 
the memory, graphic cards and disk access speed. 

• Horizon interpretation transfer: a 60% improvement in transfer speed between Petrel and Studio. 

Volume attributes (behavioral changes) 

Phase shift 

In 2013.5, a new volume attribute Phase shift (full trace) was introduced to provide enhanced support for low 
frequencies, typical in broadband data. In 2014.1, the Phase shift volume attribute now defaults to Phase shift (full 
trace) calculation. Both algorithms (full trace and fast calculation) can be accessed from the single Phase shift volume 
attribute). 
 

Figure 43: Phase shift attribute now provides two methods "Full trace calculation" using the full trace'  
and "Fast calculation", which is the same as the 'Phase shift' in earlier releases 

 
 
For more information on Phase shift (full trace calculation), see the 2013.6 What’s New document and the online 
Help. 
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Notes on virtual volumes for phase shift: 
• Virtual "Phase shift (full trace)" attribute volume using both "Full trace calculation" and "Fast calculation" 

methods created in Petrel 2013.5 and later releases will continue to work in the same manner, except when 
going to the Settings > Virtual attribute tab, where the Attribute is now shown as “Phase shift.” 

• Virtual “Phase shift” attribute volumes created in Petrel 2013.5 and earlier releases will not be fully accessible. 
These deprecated virtual cubes can be viewed and used as normal, but, when going to the Settings > Make 
virtual attribute tab, their existing parameters are unavailable. 

• To access the new Phase shift parameters, create a new virtual attribute by choosing the type “Phase shift”. 
Similarly, to run an existing Workflow containing virtual attributes, first update the workflow by creating a new 
“Phase shift” virtual attribute. 

Relative Acoustic Impedance 

A new parameter is enabled to allow control of the low-cut frequency applied for the Butterworth filter. 
 
Previously, this value was hard-coded at 10Hz. The current implementation allows for preservation of ultra-low 
frequencies, typically observed within broadband seismic data. 
 
Notes on virtual volume: 
• Virtual “Relative acoustic impedance” attribute volumes created in Petrel 2013 and earlier releases will not be 

fully accessible. These deprecated virtual cubes can be viewed and used as normal, but, when going to the 
Settings > Make virtual attribute tab, their existing parameters are unavailable. 

• To access the new low-cut frequency parameter, create a new virtual attribute by choosing the type “Relative 
acoustic impedance”. Similarly, to run an existing Workflow containing virtual attributes, first update the 
workflow by creating a new “Relative acoustic impedance” virtual attribute. 

Velocity and dix conversion 

Starting from Petrel 2014.1, “Velocity cube” attribute and “Dix conversion” attribute are combined in one “Velocity 
and dix conversion” attribute, which preserves functionality existing in earlier Petrel versions. 
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Figure 44: Combined Velocity and Dix conversion attribute in Volume Attributes 

 
 
Notes on virtual volume: 
• Virtual “velocity cube” and “Dix conversion” attribute volumes created in Petrel 2013 and earlier releases will 

not be fully accessible. These deprecated virtual cubes can be viewed and used as normal, but when going to the 
Settings > Make virtual attribute tab, their existing parameters are unavailable. 

• To access the new velocity parameters, create a new virtual attribute choosing the type “Velocity and Dix 
conversion”. Similarly, to run an existing Workflow containing virtual attributes, first update the workflow by 
creating a new “Velocity and Dix conversion” virtual attribute. 
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Horizon interpretation 

Autotracker: live visual update while tracking 

3D autotracked points are now visualized live in the 2D or 3D window as the tracker progresses. 
 
The live update allows you to do visual QC as the autotracking progresses, and if deemed necessary, the tracker can 
be stopped as soon as the tracker tracks incorrectly. Confidence in tracking results can be achieved from an early 
stage, thereby reducing the amount of corrective work later. 

Autotracker: arbitrary polyline intersection through parent points 

The ‘Select parent points’ tool has been enhanced to help identify and validate wrongly autotracked points easily, by 
enabling the creation of an arbitrary polyline intersection through selected parent points. 
 
When working with challenging seismic datasets, it can be difficult to determine the tipping point when the 
autotracker is set off onto a wrong track. You can now automatically generate an arbitrary polyline intersection 
through selected parent points on a 3D horizon interpretation to help identify and validate these points easily.  
 
As normally done to select all parents points associated with a point, use “Select parent points’ together with the 
‘Single point select’ selection option, and pick a point of interest on the off-track section of an auto-tracked horizon.  
 
Next, press the number 1 key, to create an arbitrary polyline intersection through these points.   
 
Within the 3D window (or an additional Interpretation window), it is easy to see the path tracked by the horizon, 
visualized on the newly created polyline intersection. In this profile, you can quickly identify and validate potential 
mis-picks.  
 

Figure 45: Autotracker - generate a polyline intersection through selected parent points to  
quickly identify mispicks and validate tracking 
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Dip angle and azimuth 

Dip angle and dip azimuth attributes can now be generated directly from horizon interpretations. 
 

In the Settings dialog of the 3D interpretation grid, go to the Operations tab, Curvature operations folder. 
Dip angle and Dip azimuth computation are available, with the option to output in degree or radian units. 
 

Figure 46: Dip angle and azimuth computation is accessed from the Settings dialog of the 3D interpretation grid 

 

 

Multi-Z 

Interpretation upgrade  

Once a 2013 project is open in Petrel 2014, multi-Z interpretation objects do not have normals assigned. In order to 
assign normals, go to Settings of the multi-Z object > Operations > Seismic Operations > Assign normals to multi-Z 
interpretation operation. After this, the multi-Z object(s) will be displayed with the respective normals. 

RPT/Studio  

To be visible within RPT, multi-Z interpretation objects must have normals assigned. Assign normals first, then open 
Reference project tool to transfer the data. The same behavior persists within the Studio environment. 

New styles for interpretation normals  

You can change Style settings for normals in 3D/2D/Interpretation/Intersection windows.  
 

In the Style tab for the multi-Z interpretation object, you can toggle on/off the normals’ display in 
3D/2D/Interpretation/Intersection windows, as well as change the normals parameters (color, thickness and length). 
 

In Interpretation/Intersection windows, you can set different styles for points and corresponding normals interpreted 
on the same section vs. points and corresponding normals interpreted on crossing seismic sections. These points and 
normals are called crossing points and crossing normals (defined by the white color in the following example). 
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Figure 47: Example showing crossing points and crossing normals 

 

Create new interpretation in the Workflow editor 

In Petrel 2014, it is now possible to create a new empty multi-Z interpretation by applying the “Create multi-Z” 
operation. This new multi-Z interpretation can be used in other workflow processes/operations. 
 
The new command is located in the Seismic operations folder of Operations. It allows the ability to specify the name 
of a new object, location (Interpretation folder), and domain (time or depth). 
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Regenerate triangle mesh 

The Regenerate option can be used to update the existing triangle mesh while interpreting. 
 
After an output triangle mesh is already created but new segments are interpreted for the same multi-Z 
interpretation, this existing output triangle mesh can be updated with new information. To apply the change, from the 
multi-Z interpretation Mini-toolbar for the multi-Z interpretation select Regenerate or use the Shift-V shortcut to 
update the existing triangle mesh.  
 

Figure 48: Multi-Z interpretation mini-toolbar - Regenerate triangle mesh 

 

Refresh triangle mesh 

 

The Refresh option  allows rapid update of an existing triangle mesh after the resolution has been changed.  
 

Before getting the final triangle mesh with high resolution, you can run Create triangle mesh with bigger coarsening 
factor and k increment. By setting low resolution for the output, you will reduce the time spent to create an output 
triangle mesh. After the QC of the output is done and you have gotten the expected result, set new (higher) resolution 
for the output, and by using the Refresh option, update the existing triangle mesh. It will take less time to run the 
process as it refreshes the resolution of the existing output only. 
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Figure 49: Settings for Multi-Z interpretation - Refresh triangle mesh option 

 

Geobody interpretation 

Geobody extraction performance 

Automated geobody extraction performance has been improved by parallelization. 
 
Improvements have been made to the automatic geobody extraction algorithm. The improvements consist of 
parallelizing the segmentation algorithm. The extraction is now also handling large volumes better than it was 
previously.  
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Geobody extraction from seismic intersections 

Geobodies can now be extracted directly from seismic intersections at full resolution of the seismic data without the 
use of a probe. 
 
For quick assessment of amplitude anomalies observed in the seismic data, it is now possible to extract geobodies 
directly from seismic intersections without the use of a probe. Using the ‘Seeded geobody extraction’ mode, a 
geobody will be extracted at full resolution of the seismic data and based on 100% opacity.  

Seismic Texture Cache 
Due to limitations in the graphic frameworks used by Petrel, previously, there was a memory limitation for the 
Seismic Texture Cache setting of 4GB. This limitation has now been removed for Petrel 2014. Note that to take 
advantage of this change, an updated driver from NVIDIA with a release number no older than 332.76 is needed. 
 
• Geobody interpretation - Geobody workflows are the most frequent feature using Seismic Texture Cache. This 

setting will decide how much data from the seismic used in your Geobody probe you will load into your graphic 
card memory. Setting this number to a high number (recommended no more than 75% of your available Graphic 
card memory) will then render as much as possible in LOD0 (Highest resolution) and give you the best display 
quality of your probes. However, allocating this much memory to the data itself, will affect your interactivity 
performance. Setting this to a low number might increase your interactivity working with Geobody probes. 

• Seismic data - Displaying regular seismic is also affected by the Seismic Texture Cache, but only when 
displaying seismic using “Volume rendering” techniques. For more information, see the section Volume 
Visualization in 3D in the Help Center. When using this feature, be aware of the same memory tradeoffs 
mentioned in the information above on Geobody interpretation. 

Retirement of SEG-Y Utility (behavioral change) 
The SEG-Y Utility module is retired. Functionalities to merge 2D navigation information into SEG-Y trace headers have 
been superseded by enhancements available in the SEG-Y 2D toolbox. Also, see Geophysics: General, 
"SEG-Y 2D toolbox (behavioral changes) - Access” on page 55 for more information. 

Retirement of Immersion mode (behavioral change) 
With the introduction of the new User Interface in 2014.1, the Immersion mode is retired. Future improvements on an 
immersive working environment with full navigation interactivity and real-time display will be channeled and focused 
on the new User Interface. 
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Geophysics: Seismic Well Tie 

2014.3 
Extended Statistical Wavelet extraction Method 
Following the same theory from the statistical method, but with no limitation on the selection range and being 
independent from the well, the extended extraction gives a selection range of inline, xline, and vertical (the limit will 
be the seismic selected). 
 
The seismic inputs for the extended extraction could be 3D volumes (realized, segy compressed, and virtual) and 2D 
lines. All of them are in time domain. 
 
In the region section, a X,Y reference trace selection tool helps to select a position in the horizontal plane (X,Y) in 
different ways: 

• Well head: The reference will be the closest CDP to the X,Y corresponding to the well head position of the 
well. 

• TD (Total depth): The reference will be the closest CDP to the X,Y corresponding to the total depth position 
of the well. 

• Well Top: The reference will be the closest CDP to the X,Y corresponding to the well top position in the 
horizontal plane. This option is very useful at the time to perform analysis within the reservoir. In the case 
where a marker is repeated (Well tops held in the stratigraphy folder should be organized in the correct 
geological order and with the correct hierarchy and the repetition is not a recommended practice), the 
shallowest one will be selected. 

• Custom depth/Time: The reference will be the closest CDP to the X,Y corresponding to the position of and 
specific depth along the well trajectory. The options in time will be possible just when the well has a time 
depth relationship assigned. 

 
Those options above will give you a reference of the specific CDP position (inline and xline) format, especially for 
more localized wavelet extractions. 
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Reflectivity coefficient sampling interval 
In Petrel 2014.3, the sample rate (SR) will be defined from the wavelet SR for new synthetic generation and 
integrated seismic well tie studies. The default SR for new studies will be 1 ms. Other SRs can be selected, 
depending from the interpreter criteria. Old studies will keep the original SR. 

Well Section Window’s temporary Time Depth Relationship 
for wavelet deterministic extraction 
In Petrel 2014.3, a temporary Time Depth Relationship (TDR) from an active Well Section Window (WSW) can be 
used to extract deterministic wavelets. In the older versions, the TDR has to be assigned to the well in order to 
perform the deterministic extraction.  

If a study WSW is active, the temporary TDR from that window will be considered for the deterministic wavelet 
extraction. Any change from the bulk shift or stretch and squeeze process in the study will be listen by the WTB and 
used for the extraction. The name of the TDR or temporary TDR used for the extraction will be reported at “TDR from” 
in the interface. 

  

 

2014.1 
Wavelet average: No normalization option 
Before Petrel 2014.1, the product from the wavelet average feature was a normalized wavelet with amplitude values 
between -1 and 1. In Petrel 2014.1, the default option is still the normalized option, but if the normalize option is 
deactivated, the amplitude will be the resulting average from the input wavelet amplitudes. 

Gardner’s patching: auto-complete reflection coefficient 
inputs 
In Petrel 2014.1, a new option to autocomplete missing sections of Density or Sonic logs using Gardner’s equation is 
available. This option fills the gaps where one of the input logs (Sonic or density) is missing. 
 



 

Petrel Platform What’s New Guide 2014 70 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

One of the logs has to exist to compute the other one: 

ρ = aZn
pb 

 

Where; 
 

a= The Constant unit (imperial/metric) will be shown next to the constant text box. For the “Exponent” parameter the 
default value is 0.25. The user can change values for these two fields and these values will be used as parameters 
for Gardner’s equation 
 

b= Exponent 
 
The default values will come as 0.23 for the “Constant” parameter, if the project is in Imperial system. If the project 
is in metric system it will convert the default imperial value to metric using the equation: 
a (in metric) = (a in imperial) * (1000 / (0.3048 ^ exponent)). 
 
Gardner’s equation usually works fine for sedimentary rocks with velocities above around 1500 m/s to around 6000 
m/s and densities from 2x103 Kg/m3 to around 2.8x103 Kg/m3 (for more information refer to Boore, D.M. 2007). 

Correlation track enhancement 
In Petrel 2013.x, the correlation track was limited by the input logs. The window for the correlation is defined from 
the top and base of the synthetics generated from those input logs. In some cases when the data from the checkshots 
is not available or synthetics (derivate from velocities or share from other boreholes), the correlation into the window 
may be not the ideal. In Petrel 2014.1, the correlation interval is defined by the default as top and base from the 
seismic volume selected for the study. 
 
This allows us to detect other good correlation points that were not detected if the correlation interval is defined by 
the Reflection Coefficient interval (input logs).  
 
The same phenomenon happens when a window is defined from the correlation tab at the synthetic generation. For 
Petrel 2013.x, the correlation for the synthetics and the seismic inside the windows were defined. The new way that 
it works for Petrel 2014.1, is that the synthetic is clipped by the windows defined at the correlation tab of the 
synthetics generation study; however, the whole seismic interval will be always be considered for the correlation. 

Retirement Synthetics (behavioral change) 
The synthetic tool, under Stratigraphy, is retired from Petrel 2014.1. It is replaced by Multiwell Sonic Calibration 
(Workflow editor) and Multiwell Synthetics Generation (Workflow editor). 
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Multiwell Sonic Calibration (Workflow editor): 

The process for Sonic Calibration is now present under the Geophysics process, the Workflow editor. This process 
can be applied to one well or a workflow can be configured to apply the process to different wells, using the loop 
function. 

 
 
  

A 

B 
C 
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Inputs: 

A: The well or a variable can be dropped as input from the Input pane. 

B: The Sonic calibration from the Global well logs folder can be added as input (the input log template has to be 
Sonic and can be from the global well logs). 

C: The checkshot folder can be dropped from the Input pane. 
 
If the external outputs are set up, the data will overwrite the dropped objects (Sonic log or TDR). 
 
In the Output tab, the name of the calibrated sonic, TDR, integrated sonic TcmTl, knee points and knee curve can be 
defined. Also, the resultant TDR can be set as active for the wells and the sample interval can be assigned for that 
TDR. All those outputs will be saved under the Global well logs folder. 
 
In the Time-depth tab, as is normally done in a seismic well tie study, the way the checkshot will be treated can be 
defined. 
 
In the Options tab, the knees interpolation can be defined. 
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Multiwell Synthetics Generation (Workflow editor) 

The process for Synthetics Generation is present now under Geophysics process, the Workflow editor. This process 
can be applied to one well or a workflow can be configured to apply the process to different wells using the loop 
function. 
 

 
 
  

A 

B 

C 



 

Petrel Platform What’s New Guide 2014 74 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Inputs: 

A: The well or a variable can be dropped as input from the Input pane. 

B: The Wavelet or a variable can be dropped from the Input pane. 

C: The input logs for the reflection coefficient computation must be dropped from the Global well logs folder. (Two RC 
interpolations are available: “From acoustic impedance” and “From sonic velocity and density”. 
 
If the external outputs are set up the data will overwrite the dropped objects (acoustic impedance and resampled 
acoustic impedance). 
 
From the Output tab, the user has the option to save or not to save the Reflectivity coefficients, Synthetic 
seismogram, Acoustic impedance and Resampled acoustic impedance. The option to save the logs is activated by 
default. All these results will be saved under the Global well logs folder. 
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Basic workflow for multiwell sonic calibration and synthetics generation 

In the attached workflow, the sonic calibration and the synthetics generation will be performed for all wells in the 
WSWT folder (Agata-H6; Diamond-14 and Copper-6). 
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Log Conditioning - Trend analysis and frequency filter 
license dependency 
In Petrel 2014.1, the trend analysis and frequency filter is under the Geoscience core or Combined core. 
 

Geophysics: Quantitative Interpretation 

2014.3 
Add or Remove vertex from a polygon selection in the 
Crossplot window 
As part of the continuous improvement of the Crossplot window, new functionalities have been introduced into the 
selection mechanisms. Via the Crossplot window toolbar or in the Crossplot window tab at the ribbon, it is now 
possible to add or remove a vertex (inflexion point) from an active polygon selection. 
 
This is a basic set of functionalities that enables the ability of refining the set of data to be analyzed in the 
Quantitative Interpretation Workflows.  
 

 
 

Create well depth range using Well tops 
The Well Top depth range tool helps you to define the depth interval for the Rock Physics calculation based on the 
depths of the Well Tops. With this feature, the Rock Physics calculations can be expanded for multiple wells at the 
same stratigraphic intervals. 
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2014.1 
The Quantitative Interpretation tools are aimed at helping the Geological and Geophysical interpretation and 
characterizing the reservoir. They will extract additional information from the input data (logs and seismic data) 
through different processes: 
• Rock Physics  
• AVO Modeling 
• AVO Reconnaissance 
• Seismic Inversion 
• Cross-plot Analysis 
 

 
 
Quantitative Interpretation builds the bridge between seismic and rock properties and helps to interpret the lithology 
and the pore fluids. It also helps to identify hydrocarbon anomalies by generating different AVO attributes and 
providing some powerful tool for cross-plot analysis. These techniques, for the seismic interpreter, will provide a 
quantitative approach to mitigate the risk by reducing the uncertainty. 
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Rock physics 
Despite good seismic quality and well control, the correct interpretation requires quantifying the connection between 
geology and seismic data. Qualitative seismic interpretation is limited to identifying geologic features from seismic 
reflection data. However, quantitative seismic interpretation techniques seek to extract extra information about the 
subsurface rocks and their pore fluids from the reflection amplitudes, i.e., rock physics models that can guide the 
interpretation. 
 
The Rock physic process enables the ability to establish the connection between the seismic data and the geology 
based on the input logs. The following are the different Rock Physic operations that are available: 
• Elastic parameters estimation by using elastic constants relations for isotropic media 
• Shear velocity estimation, an operation that allows generating S-wave velocity log from a P-wave velocity log, by 

using either the Arco Mudrock estimation or the Greenberg-Castagna estimation 
• Log blocking Backus, a method of blocking the properties of a stack of thin isotropic layers so they are similar to 

the average properties of a single thick layer to tile to seismic frequency 
• Fluid substitution, a process that uses Gassmann’s relations (1951) to model the effects of changing fluid 

properties on elastic logs; Gassmann’s relations are used to predict saturated rock properties from dry rock 
properties and vice versa 

AVO modeling 
The AVO modeling workflows have key elements, which take the interpreter to understand how the subsurface 
lithology and fluid content impact the elastic properties behavior, such as P-wave velocity, S-wave velocity, and 
Density, which directly affect the seismic response. 
 
This module computes AVA responses creating synthetic gathers that explain the rock physics properties in terms of 
seismic amplitudes, applying a variety of convolutional algorithms for AVA modeling: 
• Zoeppritz: Describes the reflection coefficient for plane elastic waves as a function reflection angle at a single 

interface    
• Aki & Richards: A well-known approximation to the Zoeppritz equations, which assumes weak layer contrasts 
• Shuey: Approximation of the Aki & Richards equations, which can describe the variation of amplitude at different 

angular ranges (near, mid and far angles near to the critical angle) 

AVO reconnaissance 
The AVO reconnaissance workflow helps to identify and classify AVO anomalies in an exploration context. It 
generates primary and secondary AVO attributes from Post and Pre-stack data. The Volume of Interest coupled with 
the new functionality to display the gathers on seismic lines in an interpretation window allows quality control, and 
using the cross plot tool allows a quick AVO analysis. 

  



 

Petrel Platform What’s New Guide 2014 79 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Crossplot window 
The new Crossplot window canvas is used to display data as points plotted against each other. This is used by: 
• Continuous well logs 
• Discrete well logs 
• Seismic logs 
• Post-stack seismic data 
• Pre-stack seismic data 
 
2D or 3D crossplots can be created to analyze the mentioned data, and it brings the big advantage of analyzing 
different types of data by adding different collections in the same canvas. 
 
The Crossplot window is completely useful when it participates in the Quantitative Interpretation workflows, 
allowing the generation of: 

• Useful Geophysical Crossplots which provide clues as presence of hydrocarbons: 
o P-wave impedance vs S-wave impedance 
o P-wave impedance vs Vp/Vs ratio 
o Lambda*Rho vs Mu*Rho 
o Acoustic impedance vs Poisson's ratio 
o Poisson’s ratio vs Young modulus 

• AVO or AVA crossplots, using the Z-level tool, which helps to understand the amplitude variations with offset or 
angle by reading the information contained in gathers displayed in the Well section window. 

• Intercept versus Gradient crossplots, to recognize the AVO responses for different types of gas sands according 
to the classification scheme suggested by Rutherford and Williams (1989). 

Wedge Model 
The wedge model tool creates synthetic seismic angle stacks from hybrid models consisting of a reservoir model 
embedded in an elastic property volume. Alternatively, the synthetics can be generated from 3D high-resolution 
inverted elastic properties. A synthetic wedge model can be really helpful in generating a synthetic AVO response for 
resolution and survey design studies. It helps in scenario testing for quantitative seismic interpretation and reservoir 
characterization. 

Seismic Conditioning 
Quantitative interpretation is highly sensitive and dependent on the quality of seismic data, which often require 
conditioning before seismic inversion to elude misleading reservoir property estimations. The seismic conditioning 
tool allows seismic resampling and seismic trace alignment, which provide optimum quality input for QI workflows. 
Seismic resampling allows seismic resampling of seismic cubes or 2D lines, both spatially and temporally. Seismic 
trace alignment is based on non-rigid matching (NRM) and optimally aligns angle stacks or time-lapse seismic cubes 
(4D inversion workflow).It also generates and saves displacements fields for analysis and interpretation.  
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Simultaneous Seismic Inversion 
Based on the proven ISIS suite of reservoir characterization technology used for long by Schlumberger for its 
Inversion Consulting Services, Simultaneous Seismic Inversion is an industry-leading model-based pre- and poststack 
deterministic inversion, which jointly inverts multiple inputs to compute elastic properties. It relies on simulated 
annealing, a global optimization mechanism to find the best subsurface model and it can effectively handle AVA 
seismic, converted waves (PP/PS AVA), time-lapse full-stack seismic, and time-lapse prestack seismic data in 
inversion workflows. The seismic inversion can be run by using fixed wavelet(s), or an attenuation model can be 
derived and applied to the wavelet(s) to allow for temporal changes over the time window of inversion.  

Inversion Property Builder 
The Inversion Property Builder allows interactive generation of the low frequency prior model of elastic properties, 
which in general cannot be obtained from the seismic data. Well logs are interpolated or extrapolated throughout the 
volume using the seismic horizons, with the well log data stretched and squeezed between the horizons, according to 
the layer thickness given by the horizons. An additional guide model may be used to add spatial information between 
wells and also depth trend control might be specified. The Inversion Property Builder also allows the blind well test, 
which is a very critical QC step of inversion property building. 

Inversion QC Plot 
The Seismic Inversion QC Plot tool provides a quick and intuitive access to quality control generated inversion 
outputs, property datasets, and synthetic seismic. These results must be evaluated against other data, such as well 
properties and prior models. 

Stochastic Seismic Inversion 
The Stochastic Seismic Inversion tool addresses the challenges of vertical resolution as pre- and poststack seismic 
data are inverted directly into high-resolution Petrel 3D geological models, so that inversion results are immediately 
available at the appropriate scale for integration into reservoir characterization and dynamic flow simulation 
workflows. Unlike deterministic seismic inversion, the stochastic method accounts for non-uniqueness of the 
inversion process by delivering multiple realizations consistent with the available well and seismic data. It helps 
provide better constrained reservoir properties and a better understanding of the uncertainties in the reservoir model. 
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Geology 
Geology: General 

2014.3 
Pillar gridding 
The option to set the number of cells by the Pillar gridding process, is now supported in the Fault contextual tab 
and Fault mini toolbar when a fault with a trend is selected. 

2014.2 
Smart folders for surfaces  
You can now create different instances of a hierarchical tree in the Favorites pane to give you quick access to 
individual or group of surfaces by using a few common sorting attributes.  
 
Surfaces are typically generated continuously in the input tree during the entire life of a Petrel project. 
The Input pane (on the left) shows a typical tree structure as the project is populated with an increasing number of 
surfaces. The Favorites pane (on the right) shows the same inventory of surfaces contained in the project, which are 
sorted in a user-preferred hierarchy. The tree structure is dynamic and responds to your selected preferred attributes 
in their sorting order.  

Figure 50: Favorites pane showing instance of the surfaces smart folders hierarchical tree 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Petrel Platform What’s New Guide 2014 82 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

How to create surfaces smart folders and group surfaces with selected attributes:  
• From the Home tab, in the View group, click Panes and select Favorites from the split button. The Favorites 

display in Petrel Explorer.  
• Right-click in the Favorites pane and select Insert surfaces smart folder from the context menu 
• Right-click Surfaces Smart Folders and select Select attributes 
• Click the attribute selector icon to select the criteria to group the surfaces 
 

Figure 51: Attributes selector on surfaces smart folders 

 
 
 
 
 
 
 
 
Expand the surfaces smart folder to visualize the hierarchical tree. 
 

Figure 52: Surfaces grouped by template 

 
 
 
 

 
 
 
• To group surfaces on more than one attribute, it is possible to select additional criteria by clicking on the 

attribute selector icon. 
• Attributes can be reordered using drag and drop functionality 
• Attributes can be removed by clicking the X icon in the attribute selector 
 

Attribute selector descriptions: 
• The attribute selector panel has eight attributes available. All these criteria can be combined. 
• Created by: As defined in the surface settings history of the Info tab. It looks in the history section and picks the 

user who created the surface to group and make smart folders of the surfaces 
• Modified by: As defined in the surface settings history of Info tab. It looks in the history section and picks the 

user who modified the surface to group and make smart folders of the surfaces. 
• Action: This method is used to create the surface in Petrel as defined in the Info tab under the action section of 

history (make/edit surface, Import CPS-3 grid, convert horizon to surface, residual from well correction, velocity 
model process, faults in fault model converted to surface, etc.) 

• Template: Defined in the Info tab, such as time / depth/ thickness/residual/velocity (Vo) /porosity, etc.  
• Type: Surface could be structured (use bitmap or grayscale contour image as input, faults in fault model 

converted to surface), regular (2D grids created by make/edit surface process or imported), triangulated (created 



 

Petrel Platform What’s New Guide 2014 83 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

from multi-z values interpretation). Type, as a surface attribute, is picked by looking at the ‘type’. It gets the 
information from the Info tab and the Statistics tab of the description section to group surfaces in to folders. 

• Surface type: Groups surface into smart folders, using the surface type in the Info tab of the surface, namely 
conformable, erosional, base, discontinuous, and intermediate. Other surface types include: thickness, property 
surface (surface created by velocity modeling process, Residual).  

• Has attributes: As defined in the action and description tabs of the parent surface history in the Info tab. This is 
used to group surfaces into folders containing those with and without attributes and use the criteria to group 
surfaces into folders. 

• Original CRS: It looks at the Original CRS information in the Info tab of the surface and uses it to group surfaces 
into smart folders. The original CRS name, e. g., UTM84-33N is used without the CRS description.  
Surfaces without defined original CRS will be grouped into an ‘undefined’ smart folder. 

 
Tips and limitations of Smart Folders are listed below: 

• In order to preserve different structures defined by the Smart folders criteria, it is possible to generate shortcuts 
folders in the Favorites pane by right-clicking a smart sub-folder and selecting “Create shortcuts”. 

• The Surfaces Smart Folders are sensitive to most updates made to a Surface object (e.g., via the Settings tab). 
To sort on updated surfaces that have been added, edited, or deleted on the Input tab, right-click Surfaces 
Smart Folders and select Load/refresh smart folders.  

• It is possible for an object to be listed more than once, for example, when sorting under the attribute ‘modified 
by’ when multiple users have edited the object.  

Limitations: 
• Surfaces Smart Folders and their converted favorites folder equivalent do not have a toggle check box to select 

all folder content items for visual display. To toggle on/off the display of all items within a single folder level, 
multi-select the folder content and press the spacebar. 

• Surfaces Smart Folders and their converted favorites folder equivalent are not recognized in the Workflow 
Editor. 

• Surfaces Smart Folders content objects and their converted short-cut favorites equivalent may not be recognized 
as input to certain processes. 

• Surface Smart Folders need to be refreshed when reopening a project by right-clicking Surfaces Smart Folders 
and selecting Load/refresh smart folders. 
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2014.1 
Map-based volume calculation – uncertainty 
When conducting Uncertainty and Optimization (U&O) analysis, this functionality allows quantification of volume 
uncertainty based on stochastic realization of the surfaces used to create the structure and properties in the 
volumetrics case. 

Figure 53: Map-based volume calculation process window 

 
 

The two tabs are activated by toggling the buttons on the Input tab. In the Std Dev. column, you can specify the 
uncertain inputs. Then specify the relevant settings on the Structural uncertainty tab. 
 
Follow the same procedure for property surfaces by using the Properties uncertainty tab. Set the uncertain 
property surfaces by specifying the Std Dev value and the relevant variogram settings. 

Stratigraphic charts window enhancements 
Many usability enhancements were made to the Stratigraphic charts window. Right-click the chart to see options 
for zooming and turning the cross line on and off. 
 
An auto coloring option has been added to the context menu of columns in the tree. When using this option, you will 
be able to apply coloring schemes using three different color table templates (Figure 54). 
  



 

Petrel Platform What’s New Guide 2014 85 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

 
Figure 54: New stratigraphic chart look in 2014.1 

 

 

Surface Inspector – 2D Volumetric 
For regular surfaces, the Surface Inspector now shows volumetric parameters for Porosity, Bo, GRV, HCPV and STOIIP. 
A list of units is available from the drop-down menu for each volume reading. Changing the unit will result in a 
conversion of the volume, which is also recorded on the message log. Use the Inputs and Results buttons to 
place information onto the clipboard.  
  



 

Petrel Platform What’s New Guide 2014 86 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Figure 55: 2D volumetric section on the surface inspector in 2014.1 

 
 

Surface operations – distance to object 
This new operation generates surface attributes based on the 2D distance of objects on a given surface. You can use 
a point set, a polyline, and a set of wells as objects. You can find this operation in the Convert 
points/polygons/surfaces folder (Figure 56). 
 

Figure 56: Distance to object surface operation 
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Enhanced contouring 
When displaying surfaces in a Map window, the default contouring method in the Settings dialog is now the 
Enhanced method. This uses the Contours operation for coloring instead of the other options available on the Solid 
tab. The Contours operation also works if the solid is different from the source. 
 
If the Enhanced method cannot be used, it will fall back to the Classic method and send an alert to the message 
log. 
 

Contour attribute coloring 

When displaying a surface attribute, you can control the solid color increment, independently of the increment for the 
contour lines. This is possible with both Classic and Enhanced contouring. 
 
When using the Classic method can you choose Smooth, Bold, or Contours for the Solid coloring operation. 
 

Algorithmic improvements to Enhanced contouring 

There is now better handling of the coloring along the faults, when the solid is different from the contour source, and 
solid contour coloring, as illustrated in the following figures. 
 

Figure 57: Contouring in Petrel 2013 (left) compared to 2014 (right) 
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Figure 58: Solid contour coloring in Petrel 2013 (top) and 2014 (bottom) 

   

Geology: Well Section Window 

2014.5 
Well Correlation Ghost Curve 
The new well correlation ghost curve allows you to create a single curve, multi-log single track, and multi-track ghost 
curves. You can display the well name, well log name, and index tracks with a ghost curve. You can also deactivate 
and reactive ghost markers, and add additional control points to a ghost curve. 
 

2014.3 
Mini Toolbar  
The mini toolbar is available for continuous and discrete logs, time series logs, the well header, point attributes, and 
index tracks for wells displayed in the Well section window. The mini toolbar contains tools and functions associated 
with the well log, well path, point attributes, and time series data.  
 
You can right-click a continuous or discrete time series log to display the mini toolbar and context menu. 
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Figure 59: Time series log mini toolbar and context menu 

 
 

The time series mini toolbar will be enabled after the time player has been activated in the 3D window.   
 
You can right-click a point attribute to display the mini toolbar and the context menu.  
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Figure 60: Point attribute mini toolbar and context menu 

 

User Interface 
• The X-section editing Tool Palette is now divided into two tool palettes: X-section editing and Well correlation.  
• The X-section editing Tool Palette is available for creating and editing cross sections in a 2D, 3D, or Map 

window. The X-section editing Tool Palette is accessible from the Stratigraphy tab, in the Cross-section group. 
 

Figure 61: X-section editing Tool Palette 

 
 

• The Well correlation Tool Palette contains the tools and functions for well correlation in the Well section 
window. This tool palette is available in the Well section tab, and can be accessed from the Stratigraphy tab by 
opening the Edit well tops Tool Palette in the Well tops and zones group.  
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Figure 62: Well correlation Tool Palette 

 

Cross Section 
The following enhancements have been added to enhance interactivity editing cross sections:  

• X-section add/edit well mode in 2D and Map windows: selecting a displayed well anywhere along the well 
path adds the well between existing well hinges if the selected well is orthogonal to the cross section. 
Pressing CTRL and selecting a well adds the well to the cross section after the closest well hinge to the 
selected well. 

• X-section delete well:  selecting a displayed well anywhere along the well path removes the selected well 
from the cross section. 

• X-section add well mode: pressing SHIFT and selecting the well adds the well to the beginning of the cross 
section rather than the end.  

• In any of the three modes mentioned above, when the cursor is moved over a displayed well path it will 
change to a cross hair. Otherwise, the cursor is a pointing hand.  

• It is also possible to perform a single undo of the last cross section editing operation by pressing CTRL+Z.  
• When in X-section add well mode, a pointer displays to help you track where the cursor is and where the 

next selected item will be added.  
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2014.2 
Mini Toolbar  
The mini toolbar is available for continuous and discrete logs, the well header, and index tracks for wells displayed in 
the Well section window. The mini toolbar contains tools and functions associated with the well log and well path.  
 
You can right-click a continuous log curve to display the shortcut menu and mini toolbar. 
 

Figure 63: Continuous log curve mini toolbar and shortcut menu 

 
 
You can right-click the vertical well header or index track to display the mini toolbar or shortcut menu. 
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Figure 64: Well header mini toolbar and shortcut menu 
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Polysection and Intersection Plane Cross Sections 
It is now possible to create a cross section by interactively drawing an area of interest covering specific wells in a 2D 
window with the new polysection tool . The area of interest coverage can be interactively adjusted from the 
Settings for x-section creation via polysection dialog box, and the wells that are within the area of interest will 
be used to create a new cross section. A new cross section can also be created from an existing intersection plane by 
defining a distance limit for wells in proximity to the plane.  
 

Figure 65: Settings for x-section creation via polysection dialog box 

 
 

Figure 66: An area of interest identifying wells to be included in the cross section 
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2014.1 
Deviated Display 
The well section deviated template has been expanded to include additional tracks for Points attribute, Simulation 
grid results, Simulation log, Summation track, and Time series logs. The tracks can be added in the Well section 
template settings dialog box or in the Input pane.  

Well tops can be created and edited interactively on the deviated display.   

You can apply a color fill by clicking Curve fill  on the Tool Palette or by using the shortcut menu. 

Figure 67: Deviated Tracks with Newly Supported Tracks 

 

Customized Headers  

The header is divided into a well header, a sub-header, and a log header. You can have different settings for vertical 
and deviated headers, or you can keep the same settings for both headers. The well header and sub-header are 
customizable and can be configured in the Cross sections settings dialog box for the global header or in an 
individual X-section settings dialog box for the local header. The well header consists of the well name, domain, 
symbol, and an image. The sub-header contains well attributes, user defined attributes, project settings, and user 
defined text. The log header is always displayed and cannot be edited. Customized headers can be copied and pasted 
between cross sections or shared via the Reference project tool. 

  



 

Petrel Platform What’s New Guide 2014 96 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Figure 68: Customized Well Headers 

 

Showing and Hiding Template Objects 
You can show or hide tracks, logs, and individual objects, which allows you to turn the objects on and off in the Input 
pane without losing their style settings and position in the Well section template. The check boxes of the objects can 
be selected or cleared in the Input pane or in the Well section template settings dialog box to show or hide the 
objects in the Well section window.  
 

Figure 69: Settings for Well Section Template with Check Boxes 

 

Local Template  

You can now generate a local template by adding a log from an individual well, the log can be added to a vertical or 
deviated track. A new template will be created and named with the x-section, original template, and well name that 
were used to create the template. The local template is stored in the Templates pane > Well section templates > 
Split templates folder. The local template can also be used as a global template.  
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Figure 70: Example of a Local Template Structure 

 

 

Global templates can be selected from the Select template list on the window toolbar. You can identify if a local 
template is used by a well in the Definition tab, in the X-section settings dialog box. The template name can also 
be displayed by enabling the customized well sub-header.  

Well Section Window Interaction with 2D, 3D, and Map 
windows 

Cursor tracking allows you to mirror your cursor location from the Well section window to other enabled windows 
when you hover your mouse over a vertical track using the Select/Pick mode. The cursor tracking can be enabled or 
disabled from the window toolbar when you are working with a 2D, 3D, or Map window. 

 
Figure 71: Cursor Tracker 

 

Cross Section Label 

When a cross section is displayed in a 2D, 3D, or Map window, the cross section name will be posted at the end of 
the cross section. You can configure the position, color, and font size for the cross section label in the X-section 
settings dialog box. 
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Figure 72: X-section Settings Dialog Box with Show Labels 

 
  

Figure 73: Example of an X-section with a Label 
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Zone Log Editing 
You can now overwrite invalid zones by using the Flood fill discrete log   icon. 
   

• Right-click the zone log, select the zone you want to apply, and then click the zone. The zone will be reassigned.  
• To undo the reassignment of the zone, the top-most well top needs to be deleted and re-picked.  
 

Figure 74: Reassigning a Zone Log 

 

Viewport  
The Well section viewport allows for higher resolution plotting, which allows for a better quality plot from the Plot 
window. The creation and manipulation of the Plot window and the Viewport remains the same. 
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Figure 75: Creating a New Well Section Viewport 

 

 
 

 

 

Figure 76: High Resolution Printing 
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Stratigraphy Tab 
The Stratigraphy tab contains all the relevant tools for the well section workflow from stratigraphic charts, log 
creation and manipulation, to creating well tops and surfaces.  The Stratigraphy tab is available only when you 
select the Seismic to Simulation or Geology and Geophysics perspective. 
 

Figure 77: Stratigraphy Tab 

 
 

Figure 78: Perspective Selection 

 

Tool Palette 

Click X-section editing   to open the Tool Palette from the Stratigraphy tab when you have a 2D, 3D, or Map 
window active.  

Click Edit well tops   to open the Tool Palette from the Stratigraphy tab when you have a Well section window 
active. When Edit well tops icon is activated, additional icons are available to create and edit markers. 

Figure 79: Edit Well Tops with additional tools 
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The Tool Palette can be resized, repositioned, and expanded to include other domain’s tool palettes.   

Figure 80: Tool Palette in a 2D Window 

 

Figure 81: Tool Palette in a Well Section Window 

 
 

Figure 82: Tool Palette in a 3D Window 

 

 

The window toolbar can also be added to the Tool Palette by clicking the Settings  icon on the Tool Palette.  

Well Section Tab 

The Well Section tab contains tools that allow you to configure the settings for cross sections, well section 
templates, and well section windows. The Well section tab is available only when you have an active Well section 
window.  

Figure 83: Well Section Tab 
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Geology: Structural Framework 

2014.1 
Depospace construction 
The objective of Depospace is the construction of a virtual and physically consistent depositional space controlled by 
the chronostratigraphic environment at the time of deposition of geological terrains as they are described in the 
geometry of the associated structural model (VBM). This computed depositional space can be used for property 
modeling (in case of depositional properties, such as: facies, porosity, permeability, etc.) targeting more accurate 
calculations, proportions, distributions, and further volumetrics. 
 
Depospace is the representation of a Structural Model in an “Unfaulted and Unfolded” state. It is equivalent to a 
Pseudo-3D-Chronostratigraphic view of the model (Pseudo as the vertical axis does not represent absolute age). The 
construction of the latter will also provide some transformation to bring any point from the “present day” 3D 
representation (Geospace) to its corresponding location in Depospace (and vice-versa). This will be used subsequently 
by other processes. In Petrel 2014, property population within Structural Grids can be done using the Depospace 
transforms (see Geology – Modeling section). The construction of the Depospace relies on a geo-mechanical engine 
that will ensure proper reconstruction to a flat-space. The usage of geo-mechanics is quite important, as it will honor 
some contact and mass preservation constraints, making sure the reconstructed model in its 3D – Pseudo-
Chronostratigraphic space has a consistent shape. Distances between points in a given stratigraphic layer will, for 
example, be coherent with how they were initially deposited: a property that is quite important for later use with data 
analysis and variogram construction. 
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Figure 84: The upper left part characterizes the 3D Structural Model in its present day geometry, whereas the bottom right 
corresponds to its Depospace representation (Modified from Geosciences Australia Datasets) 

 
Since no prior knowledge of “geo-mechanicals” concepts is needed in order to build the Depospace, user interactions 
are quite limited. A quick QC from the eye of a geologist will be sufficient to validate that the process concluded 
successfully. You simply have to specify the pieces of the model to be included within the Depospace calculation 
protocol. 

New tree for structural framework node (behavioral change) 
The new tree structure creates a split between the fault framework and the structural model. The fault framework 
can now be commonly used by several structural models. 
 
A new hierarchy has been introduced to help better structure the workflow, as well as enhance productivity. The 
steps for building the structural model are now, as follows: 
1. Define the “Structural Folder” and its domain (time or depth) 
2. Build the Fault Framework  
3. Define the VOI (Volume of Interest) for the Structural model (can be only a portion of the fault framework) 
4. Build the Structural Model via Horizon Modeling  
5. Finally, build the Depospace 

You will then be able to QC the faults initially built during the Framework generation process against the ones 
outputted from the horizon modeling stage, where they have been re-meshed as part of the volume building process. 

Retirement of Surface Based Algorithms for Structural 
Model building (behavioral change) 
Previous means of building Structural Models using “Fault Center Grid Dislocation (FGD)” and “Multi-Patch 
Interpolator (MPI)” are being retired and will no longer be exposed. 
 
  



 

Petrel Platform What’s New Guide 2014 105 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Volume Based Structural Models are the only ones that you can create from within Petrel going forward. Previously 
built Structural Models using the legacy algorithms will be upgraded and can still be used further within the grid 
construction workflow, but you will not be able to regenerate them in case, for example, new interpretation has been 
made. Conversion to a Volume Based model will then be needed in order to update it. 

Geology: Modeling 

2014.4 
Depospace enhancements 
Various enhancements have been implemented for stair-stepped grids with Depospace: 
• Additional options are now available for the target space definition when creating property in Property Calculator 

and in Operations on several properties when using both Geospace and Depospace properties. 
• The method “Absolute or relative depth” in Geometrical modeling dialog now correctly handles Geospace and 

Depospace. 
• Statistics for reporting Simbox cells are now correct.  
• Local model update for properties is now enabled. 
• Interactive facies editing is now enabled: in Depospace for [D] properties and in Geospace for non-[D] properties. 

Use of Free memory on Grid Properties 
The use of Free memory is now preserving the integrity of the Property filter. In previous Petrel versions, using 
Free memory (in the Workflow editor, the Uncertainty and Optimization or at the project level) would corrupt, 
momentarily, the Property filter and could produce unexpected results. 

Use of non-zero based discrete color table for Property 
modeling 
When the first code is strictly positive in a discrete color table, it now behaves as when using a zero code: it correctly 
enables the use of the Property filter and interactive facies modeling; it also correctly displays and supports the 
picked value for stair-stepped grids. Negative values are no longer allowed in the code field. 

Stair-stepped grid enhancements  
Various enhancements have been implemented for stair-stepped grids:  
• Custom property modeling algorithms were not correctly implemented in the shadow zone of reverse faults 

for stair-stepped grids. This is now fixed. No change is needed in the Ocean plugin code. Existing algorithms will 
now work correctly on stair-stepped grids. 

• In Simbox mode, the picked cell volume is now correctly reported in the Status bar for all stair-stepped 
grids. 

• The option to Flip property values in the I, J or K direction is now correctly disabled for all stair-stepped grids. 
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Output part of a 3D grid for a single subzone 
When using the Output tab of a 3D grid to extract a subzone of the grid, the properties and contacts settings are now 
correctly preserved for the subzone, as well as the name of the subzone. 

Surface default color when running Make/Edit Surface 
dialog 
When running the Make/Edit Surface dialog on an existing surface, the color shown on the Info tab of the surface 
is now assigned the specified color of the Main input object. 

Fluvial channel object modeling 
Since Petrel 2014.2, re-running a legacy property, using Fluvial channel objects in the Object modeling method 
(Facies modeling dialog), provides a different stochastic result with an identical seed due to a fix that modified the 
pseudo-randomness of the algorithm. 

LGR filter 
The LGR filter in Property calculator is now enabled. In Petrel 2014.3, the LGR filter was not properly applied in the 
Property calculator.  

Well index method in Geometrical modeling dialog 
The Well index template is now correctly assigned when using the Well index method with the option “Use 
visible wells only”. 

Property statistics operation in Workflow editor 
The Workflow editor operation Property statistics to output sheet now has a new “Weighting” toggle available in 
the command line to specify whether the statistics report should use a weighting: length-weighting for discrete 
property or volume-weighting for continuous property. When toggled off, no weighting is used. 

2014.2 
Use of Depospace in Facies and Petrophysical modeling 
The depositional space, or Depospace, represents the geological model at the time of deposition. This is the most 
accurate space to use for modeling the facies and properties that are syn-depositional (shape and position of objects, 
facies fractions or the properties variograms). This is the simbox that is used if the Use Depospace option has been 
selected during the Structural gridding. 
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By ticking the option ‘Use the depospace for property modeling’ in the structural gridding process, the resulting grid 
receives [IJK] and [D] tags in its name: 

• [IJK] indicates that the grid has been built using the structural gridding process 

• [D] indicates that it is using the depospace simbox as a simbox. (There is an internal depositional space mapping, 
or transform, that links the two spaces – Geospace and Depospace). 

Subsequently, any property computed with the Facies, Petrophysical, and Trend modeling dialogs will also be [D] 
tagged.  

Properties created using geometrical modeling, or the property calculator, will NOT get the [D] tag because they are 
not computed in the depospace simbox, but in the real grid (representing the Geospace, or present day space). 
However, properties made in Depospace can be updated using the Calculator and still maintain the correct [D] tag. 

The mapping between the geospace and the Depospace is not bijective. Single cells in geospace can be mapped to 
several cells of the depospace simbox. Therefore the numbers of cells in the Geospace and Depospace are not 
identical. These numbers are reported in the Statistics tab of the Properties folder.  

Grid properties smart folders 
You can create different instances of a hierarchical tree to get a quick and easy access to individual or groups of grid 
properties by using specified sorting attributes. 
 
The Models pane typically contains a tree structure as the project is populated with an increasing number of grid 
properties. Grid properties are continuously generated in the Models pane during the entire life of a project. The 
Favorites pane allows displaying the same inventory of grid properties contained in the project sorted in a user-
preferred hierarchy through the use of grid properties smart folders.  
 
This tree structure is dynamic and responds to your selected preference of attributes and their sorting order. 
In the example below, the same properties are now listed in both the Models pane and the Favorites pane. In the 
Favorites pane, the user listed the properties per grid, per last action performed, per property type and per template. 
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Figure 85: Favorites pane showing an instance of the Grid properties smart folders hierarchical tree. 
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Figure 86: Attributes selector on Grid properties smart folder 

 

2014.1 
Quality Assurance Maps 
Quality Assurance (QA) maps are attribute maps computed from 3D grid properties and the 3D grid.  
 
Various attribute maps are often used to help assess the quality of reservoir models, as well as the horizontal and 
vertical continuity of the reservoir. Examples of QA maps include Isochore (TVT), net thickness, net reservoir, pay 
proportion, permeability thickness, hydrocarbon thickness, average porosity, etc.  
 
The QA maps generated in Petrel are dynamic, which means that:  
 
• They can be automatically updated when their parent property model is changed.  
• A QA map displayed in an active window will be recalculated and updated immediately upon selection of single 

or combined zones.  
 
In order to Quality Control (QC) the modeled property against the input well data, you can also display the equivalent 
attribute values calculated from the upscaled cells and well logs used in upscaling the QA maps. At each well 
location, the following attribute values will be available for display:  
 
• The attribute map value extracted at the XY locations of the intersection of the input wells with the Top horizon 

of the shallowest selected zone currently displayed.  
• The equivalent attribute value computed on the upscaled cells along each input well.  
• The equivalent attribute value computed on the input well log data used in upscaling.  
 
Depending on whether the property is discrete (for example, facies) or continuous (for example, porosity) the attribute 
map can be one of two types: thickness or average.  
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Depending on the settings selected in the QA map dialog, QA maps will be one of the following:  
 
• For discrete properties-  

o Thickness/Proportion: Vertical thickness or proportion maps for the different facies/discrete codes of a 
discrete property (for example, net sand/reservoir maps or net pay thickness/proportion maps from a 
discrete reservoir/net flag property).  

 
Figure 87: Fine sands proportion map and Facies model. Proportions computed from well log data in overlay 

 
• For continuous properties-  

o Property thickness: A surface representing the sum of the property multiplied by the height at each point. 
With volume proportion properties (L3/L3), such as Net to Gross, this represents the effective thickness of 
the unit (for example, porosity/permeability thickness maps).  

o Average: A surface with the average value of the property at each XY location (for example, average 
porosity maps).  

o Volume height: A surface representing the integral of a volume property with respect to elevation divided by 
the cell bulk volume at each XY location. When performed on volume properties (HCPV, STOIIP, etc.) the 
resulting map represents the volume per unit area in the chosen zone at that point or, to put it another way, 
the fraction of the height of each column occupied by fluids (for example, Hydrocarbon thickness maps). 
HCPV volume height maps give a powerful visual rendering of the evolution of the height of the hydrocarbon 
column across the field as if the rock matrix had been removed.  

 
It is possible to perform automatic recomputation of QA maps and "on the fly" visualization/ computation.  
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All the property-derived QA maps will be updated when an updated property is RPT transferred or a property is re-run 
or modified in any way (such as, in the following processes: Upscale well logs, Facies modeling, Petrophysical 
modeling, Geometrical modeling, Trend modeling, Geometrical trend modeling, Property calculator, and Property 
operations).  
 
The Automatic recomputation command in the right-click context menu of the QA folder allows you to select or 
deselect the automatic recomputation of QA attribute maps:  
 
• If Automatic recomputation is deselected (default) and a grid property is changed, a [*] flag is added to all the 

children QA attribute maps. A QA map can then be recomputed either by pressing the Run button in the Attribute 
computation tab of the QA map settings, or by using the Update map command in the right-click context menu of 
the QA map.  

• If the automatic update is selected and a grid property is changed, all existing children QA maps are 
automatically recomputed.  

 
If a QA map is generated with the filter option selected, and any setting in the property filter is changed, only the 
maps generated with a filter will be flagged. If Automatic recomputation is selected and the property filter settings 
are changed, only the maps with a filter [ON] will be recalculated.  
 
The Zone computation folder allows you to compute and display attribute maps "on the fly" on selected zones:  
 
• By default, when a QA attribute map is displayed in an active window, all the zones in the Zones computation 

folder are selected and the QA map is displayed for the combination of ALL the zones and sub-zones existing in 
the grid.  

• The QA map displayed in an active window will be recalculated/updated on the fly for the combination of all the 
zones selected in the Zone computation folder.  

• Selecting a parent zone will automatically select all children zones.  
• A QA map can be simultaneously displayed for different zones selection on different visualization windows. 

Modeling Input Parameters for continuous properties 
The new Modeling Input Parameters (MIP) editor for petrophysical modeling allows you to view, edit, exchange, and 
report full sets or sub-sets of Petrophysical parameters between zones inside a flexible unified tabular interface.  
 
Similar to the Facies modeling MIP, the general user interface for the MIP for continuous properties is a standalone 
dialog divided into a zones tree and a parameters pane. The zones tree is a hierarchical representation of the 
structure of the property model. The parameters pane displays the modeling parameters of the selected (ticked on) 
nodes in the tree in a series of tables. The table structure caters to the specifics of PM: 
 
• Hierarchical representation of the structure of the property model in a zones tree 
• Parameters pane displaying the modeling parameters of the selected (ticked on) nodes in the tree in a series of 

tables  
• The parameters for all zones or zone/facies using the same type of algorithms are displayed in the same table 
• Copy to common clipboard and paste operations allow you to exchange parameters between nodes of the same 

MIP or of different MIPs 
• A report button allows you to create a spreadsheet output of the currently displayed parameters in Petrel's 

output sheet 
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The new MIP for petrophysical properties brings a significant usability enhancement for modelers.  
 

Figure 88: The Modeling Input parameters editor for continuous properties 

 
 

Creation of new properties with Geometrical modeling in a 
workflow 
Prior to Petrel 2014, properties had to be created outside the workflow and edited in the Workflow editor. It is now 
possible to create new properties with the Geometrical modeling dialog in a workflow. Any property created within a 
workflow is re-usable in other following workflow processes/operations. Using the “Output” variable, it is now 
possible to retrieve the newly created property after the process is run and use it in further processes/operations if 
needed. 
 
Enabling this capability for Geometrical modeling is a major improvement in usability and quality control of models 
run in the Workflow editor.  
 
  



 

Petrel Platform What’s New Guide 2014 113 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Figure 89: The Geometrical modeling dialog: Creating a new property is now enabled in the Workflow editor 

 
 

Facies modeling – Truncated Gaussian with trends 
The geometry tab of the Truncated Gaussian with trends algorithm in Facies modeling has been enhanced to improve 
its usability (learnability, efficiency of use, and acceptability) and extend its modeling capabilities for creating and 
editing the deterministic trend models. 
 
The new, intuitive interface offers several easy-to-use features: 
 
• New cross-section displaying a diagrammatical view of a cross-section of the trend model along the line 

intersecting the well in the azimuth direction 
• New facies table with estimated facies global fractions from the deterministic trend model. These are re-

calculated on the fly while editing the trend model.  
• Enhanced zooming capabilities in map view allows you to model aggradation angles lower than 1 degree  
• The modeling domain of interest is now displayed in the map view  
• Ability to rotate the azimuth line independently from the facies boundaries allows you to model oblique facies 

transitions 
• Display user-defined maps (surfaces, images) as background in map view as well as transparency capabilities  
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Figure 90: Enhanced Geometry tab of Truncated Gaussian with trends algorithm 
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Enhanced Vertical Proportion Curves functionality 
The usability of the Vertical Proportion Curve (VPC) manipulation and use of the Data analysis process has been 
significantly improved. 
 
The improved interface offers several easy-to-use features: 
 
• A new length weighting option is now available for upscaled data and well logs. This allows you to compute the 

histograms and the input data global fractions using the facies segments lengths as weights 
• Display of the global fractions in both facies lists: 

o a fraction for each facies computed from the input data 
o a fraction for each facies  computed from the VPC 

• Display of the facies fraction in a specific layer for both the estimated facies proportions and the vertical 
proportion curves. Values are updated on the fly as the cursor moves 

• Shift a VPC by typing a target global fraction: the whole VPC is shifted according to the specified target 
• Shift all points between two selected points in the VPC to edit them simultaneously 
• Select and edit simultaneously contiguous or isolated multiple points 
• Import/export selected VPC on selected facies code   
• Shortcuts such as, Ctrl+Z for undo and Ctrl+Y for Undo/Redo, for all operations performed since the most recent 

save 
• Automatically fit all VPC curves to histogram for all zones and all facies at once, and for all hierarchical facies 
• Synchronized zooming in/out histograms and VPC graph 
 
Additional improvements related to Data analysis: 
 
• In the Transformations tab, there is an automatic refresh button for the histogram, in addition to the currently 

existing manual refresh  
 

In combination with the Data analysis scenarios, the improvement of the usability of curves in the Data analysis 
process will drastically improve the main usability of Modeling. 
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Figure 91: Enhanced Proportions tab for Data analysis 

 
 

Scale Up well logs variable enablement in Workflow editor  
A “Use variable” toggle has been added to the Upscale well logs dialog in the Workflow editor. This allows you to 
use an object variable as global well log and therefore loop through a list of input logs in an uncertainty workflow 
while preserving the drop-down selection of the process. This is critical to enable petrophysical uncertainty in the 
Workflow editor or Uncertainty & Optimization process.  
 
Also, it is now possible to upscale multiple attributes of the same point set or the same attribute for multiple point 
sets.  
 
• The settings for the currently selected property type will be used for the object variable 
• For point attributes, you can now drop the attribute to be upscaled itself instead of the parent point set 
• The variable will represent the attribute and can be used to upscale the same attribute for multiple point sets in 

a folder loop or multiple attributes in the same point set by looping on the attributes folder 
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Figure 92: Workflow editor instance of the Upscale well logs dialog with variable enablement 

 
 

Make surface visible points filter 
The new “Use visible points only” toggle in the Make surface dialog allows you to generate maps with a user-defined 
sub-set of points. 
 
It is now possible to generate maps with a user-defined sub-set of points without having to create new data. A “Use 
visible points only” toggle has been added in the Make surface dialog for both the main input and the well 
adjustment. The toggle is only active when data from either point data or well tops is dropped as input or well 
adjustment control. Otherwise, the “Use visible points only” toggle is inactive or hidden. When ON, only the visible 
points (for the current input stratigraphic pick or pointset) in the currently active window will be used to create the 
surface.  

 
Points may be filtered through 1D generic filters on the pointset attributes, the built-in filters (well filter, interpreter, 
etc.), or the additional filters that can be created on any string, discrete, or Boolean filter in a pointset. 
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Figure 93: New ‘Use visible points only’ toggle in the Make/edit surface dialog 

 
 

Statistics to output sheet command 
A new Property statistics to output sheet command has been added to the Workflow editor. This makes it 
possible to extract filtered statistics inside the Workflow editor, which allows you to enable feedback loops on 
property modeling (e.g. discard realizations if result fraction is lower than a threshold). 
 
The new command is located in the Model extraction folder of the Operations. It has the same options as in the 
standard statistics command but it also includes: 
 
• A “For zone:” box (object variable enabled) where users can drop a zone from the model Zone filter 
• A “Use filter” tick box replicating the behavior of the “Show statistics for the filtered cells only” button in the 

property settings 
 
The new command processes the content of the Statistics tab when the input property is continuous and of the Disc. 
Stats tab when the input property is discrete. 
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Figure 94: New Property statistics to output sheet command in the Workflow editor 

 
 

Geology: Fractures 

2014.1 
Estimate fracture density 
The fracture density process aims at improving and simplifying the first phases of the fracture modeling workflow. In 
general, it does the following:  
 
• Makes it easier to properly compute P32 fracture density along wells. 
• Properly accounts mechanical zonation while computing the density logs (i.e. mechanical boundaries should 

correspond to discontinuities in the density log). 
• Estimates uncertainties of computed density and discards values which are too uncertain. 
• Properly distinguishes between “zero fracture density” and “no measured data” cases along the wells. 

The main motivations behind this process are layering preservation, interpreted interval definition, and uncertainty 
calculation (P10, P90), in that order.  
 
The principle of fracture density calculation stays unchanged compared to the Insert global intensity log usually used. 
Additionally, the calculation can be performed independently for the “mechanical zones” specified. 
 
Options that will remain from the current “compute global fracture intensity log” are: 
• Window length 
• Sampling distance 
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Note that the new process will only allow computing P32 fracture densities (corresponds to option “Correct for 
borehole deviation” turned on). 
 
There are options to: 
 
• Discard (i.e., replace by UNDEF values) portions of logs for which the uncertainty (P85-P15) is greater than a given 

proportion p (default: 60%) of the calculated P50 value. See Uncertainty calculation for more information. 
• Stop the log calculation at given upper and lower boundaries  
• Split the log calculation in between several “mechanical zones”  

Accounting for “Interpreted interval” 

• Allows (optionally) specifying the interpreted interval(s) using a well log L of any kind so that the “interpreted 
interval” (i.e., portion that has been imaged and interpreted) corresponds to portions of that log L for which values 
are “defined” (i.e., different from UNDEF). 

• Within the “interpreted interval”, the fracture density values will be computed as described above, outside the 
“interpreted interval” output intensity values (and associated logs) will be set to “UNDEF”. 

 

 
 

In orange, log used for defining “interpreted interval”. 
 
 

Separation by “mechanical zone” 
It is possible to split the well trajectory in several zones prior to the calculation of density logs. Each zone is computed 
independently from the other zones located above/below. 
 
At zone boundaries, the log should be C0 discontinuous (see the following figure). 
 
Zone boundaries will be specified by the following: 
 

Crossing grid horizons. A mechanical boundary will be inferred from the crossing of the well and of a grid 
horizon.  
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Effect of mechanical boundaries (in dashed lines) on computed fracture density log. Left (blue): intensity log 
implementation which cannot account for mechanical boundaries. Right (red): curve discontinuous across mechanical 
boundaries, produced by the process. 

Uncertainty calculation 
The P32 intensity traditionally computed from interpreted fractures is actually the expected value of a probability 
distribution, for which characteristics can be recovered from the distribution of fracture samples along the well. Quite 
intuitively, when the density estimate is based on a small number of samples (i.e. number of fractures within a “window 
length”), the uncertainty on this estimate is higher. 
These values will be computed at each MD of the output intensity log. It is now possible to produce  
• A “main” P32 fracture density log (i.e. expected value of the P32) 
• A “P90 percentile” of P32 density log 
• A “P10 percentile” of P32 density log 
• A standard-deviation of P32 log 
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Rose diagram on Stereonet Window 
Fracture data analysis and visualization as rose diagrams are currently linked to the Well section window (WSW) 
because of the nature of the fracture data file (Point well data). The stereonet window is not linked to a WSW and 
combines the rose diagram and stereonet in a same Fracture data analysis and visualization tool for non WSW. 
 
When you want to make a rose diagram in a Well section window, on the strike of fractures, you have to select dip 
azimuth and Dip angle, which are attributes taken from the point well data. But there is no way to differentiate in the 
newly created rose diagram, which fan belongs to which fracture type of the fracture set. This is now possible in the 
stereonet as you directly take the attribute in the tree. Using filtering for the fracture type, you can display rose 
diagrams by fracture type. The fan of the rose diagram can be colored by attributes and you can apply the Terzaghi 
correction (Correct for borehole deviation). 
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Rose diagram data filtered by fracture type 

 
 
 
 

 
 

Rose diagram data versus Computed fractures 
 

  

 

 

Observed Computed 
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Tectonic stress window 
The results of the stress inversion are given numerically by the settings window of the Tectonic event item, on the 
statistic pane, but also visually with the tectonic stress window. A cross gives the position of the best Fit in the 
graph. By default, contour lines of the Fit values are visible.  
 
The black cross gives the position of the best Fit. 
 
 

 
 

Iso values contour lines and position of the Best Fit (Cross) 
 

By default, the tectonic stress window is open with the contour lines set to uncertainty interval on the Best Fit to 
[1,2,5,10,20 %]. The user has the choice between 3 intervals, either for uncertainty or for global fit on the window. 
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Choice between uncertainty and global iso values of the Fit, with 3 several intervals 

Scalability improvements of tectonic inversion 
The performance of the forward modeling geomechanical solver (Ibem3D, Iterative Boundary Elements Method) used 
to compute paleo-tectonic stress field has been improved and in the current version of Natural Fracture Prediction 
(NFP), the total maximum number of triangles per model is increased from 6000 to approximately 25,000. This implies 
that a single fault with complex geometry (irregular tipline and curved shape) would not need to be oversimplified in 
the re-meshing process. 
 
The improvements to the geomechanical solver now make it possible for you to handle models with hundreds of 
faults without any significant over-simplification of their geometry. The maximum number of triangles that can be 
used for the re-meshing phase of the fault framework has increased from 6000 to 25,000. 
 
Additionally, optimization of the computations performed during the “Generate fracture driver” process allows the 
use of 3D grids with higher cell counts. 

Discrete Fracture Network (DFN) 
DFN upscaling has been improved to avoid memory swapping and crashes on big models. Sigma upscaling 
calculation has been improved. The properties are now saved in a Folder. 

Uncertainty 

Global iso values of Fit 
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Geology: Wells 

2014.2 
Saved searches enhancement  
An enhancement has been made within the wells saved search dialog box. Two additional icons are available when, 
within the Search criteria pane, the user selects the filter type: User specified well list. 
 

The two new icons enable you to copy and paste well names. The copy icon is used to copy all or selected well-
names from the list of wells shown on the User specified well list. These copied wells can be subsequently pasted 
into other software, such as Notepad, Word, Excel, etc. The second icon is a paste functionality, which is used to 
paste well-names copied from elsewhere (i.e., not from within Petrel). The paste occurs directly into the saved search 
dialog box, and onto the User specified well list. 
 

The well names which are copied from outside Petrel software must match alphabets/strings of the wells contained 
within the Petrel project. The file must be in a single vertical format.  
 

Figure 95: Well names arranged in single vertical order 

 
 

Figure 96: Copy and paste icons in red border of user well list dialog 

 
 
A message log guides the user by indicating if the wells were found in the project. Well names are listed which have 
been rejected, because the well name was not recognized as an existing well within the project. Also listed are 
names of wells which already exist within the User specified well list. Those wells which meet the criteria, and do 
not already exit on the User specified well list, are added to the filer list. 
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Color by saved searches: 

To color a well path by a saved search, right-click the saved searches folder in the tree and select insert/update a 
well attribute. 
 

Figure 97: Create/update a well attribute from saved searches folder 

 
 

In the pop up dialog, a ‘yes’ assigns color to only active saved search and a ‘no’ uses all saved searches. Wells not 
within the search criteria is assigned a ‘Not in criteria’ code. 
 
This operation creates a discrete attribute for saved searches in the well attributes folder. To alter the colors 
assigned to each saved search, from the well attributes folder, right-click on ‘Attribute from ‘Saved Searches’’ to 
open the settings and amend the colors. 
 

Figure 98: Saved searches attribute settings for color selection 

 
 

In the well manager, the wells are updated with the discrete color code assigned to each saved search containing the 
well.  
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The well path can be colored by this attribute to show the different saved searches, in 2D, 3D, Map, and Intersection 
windows. This is achieved within the parent well folder settings style tab. In the path tab, select show color ‘As 
attribute’ and select the Attribute from Saved Searches to visualize the path in the assigned colors. 
 
Note: Only one saved search attribute can exist in the well attributes folder. It gets overwritten when the attribute is 
updated. 

Smart folders for wells 
You can now create different instances of a hierarchical tree to give users quick access to individual or group of wells 
by using a few common sorting attributes.  
 
Wells Smart Folders in the Favorites pane show the same inventory of wells in the project, which is sorted in a user-
preferred hierarchy. The tree structure is dynamic and responds to your selected preferred attributes and their sorting 
order.  
 
How to create Wells Smart Folders and group wells in the Favorites pane with selected attributes: 
• From the Home tab, in the View group, click Panes and select Favorites from the split button. The Favorites 

pane displays in Petrel Explorer.  
• Right-click in the Favorites pane and select Insert wells smart folder from the context menu 
• Right-click Wells Smart Folders and select Select attributes 
• Click the attribute selector icon to select the criteria to group the wells 
 

Figure 99: Attributes selector on wells smart folders 

 
 
 

• Expand the wells smart folders to see the result. 
 
The wells are listed by the selected attributes (e.g., well symbol, maximum inclination, and last edited) 
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Figure 100: Favorites pane showing instance of well smart folders hierarchical tree. 

 
 

• To group wells on more than one attribute, it is possible to select additional criteria by clicking on the attribute 
selector icon. 

• Attributes can be reordered using drag and drop 
• Attributes can be removed by clicking the X icon in the attribute selector 
• Short cuts can be created from right on smart folder to preserve the hierarchy in the Favorites pane 
 

• To sort Wells Smart Folders with data added, edited or deleted in the Input pane, requires the user to select 
load/refresh smart folder from the right-click menu. 

 
Attribute selector descriptions: 
Attribute Selector Sorting 
The attribute selector panel has both default attributes and user attributes available.  
All these criteria can be combined. 

 
Symbol:  The ‘symbol’, as defined in the well settings and well manager can be used to group wells into folders in 
the Favorites pane.  
It looks at the well symbol to group and make smart folders for Wells  
The symbol folder shows all wells with a symbol ‘Oil’, ‘Gas’, ‘proposed’, abandoned well etc. 
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Spud date: The ‘spud date’ for each well, as contained in the well manager, can be used to group wells into folders 
in the Favorites pane. 
The spud date format should match the well settings default date. (MMM/dd/yyyy). The date format can vary 
depending on the region. 
 
Last edited date: The ‘last edited date’, as defined in the well manager can be used to group wells into folders 
based on the modified date in the well history tab. 
The date format should match the well settings default date (MMM/dd/yyyy) for consistency. The date format can 
vary depending on the region. 
 
Operator: The ‘Operator’, as defined in the well manager can be used to group wells into folders based on the string 
‘operator’. 
 
Well datum: The ‘Well datum name’ as defined in the well settings page and in the well head position section (e.g., 
KB, GL, R, etc.) and available in the well manager can be used to groups wells into folders. 
The well datum name is used to group wells into smart folder using the string defined in the well settings and well 
manager. 
 
User defined discrete attribute: A ‘user defined discrete attribute’ ‘as defined in the well attribute tree and 
available in the well manager can be used to group wells into fields in the well manager. 
 
User defined string attribute: A ‘user defined string attribute’ as defined in the well attribute tree and available in the 
well manager can also be used to group wells into folders in the well manager. 
  
Max inclination: ‘Maximum inclination can be used as the attribute to group wells into vertical, deviated and 
horizontal based on the max dip angle of the well path. The well could be classified as vertical with max dip angle 
range of (0 – 5 degrees), deviated of max dip range of (5 – 80 degrees) and horizontal of max dip angle range of (Over 
80 degrees).  
 
TDR log:  ‘TDR log’ criteria groups wells into smart folders based on the type of data used to calculate the active 
time log on the well. 

Limitations: 
• Wells Smart Folders and their converted favorites folder equivalent do not have a toggle check-box to select all 

folder content items for visual display. To toggle on/off the display of all items within a single folder level, multi-
select the folder content and press the spacebar.  

• Wells Smart Folders and their converted favorites folder equivalent are not recognized in the Workflow Editor.  

• Wells Smart Folders content objects and their converted short-cut favorites equivalents may not be recognized as 
input to certain processes.  

• Wells Smart folders need to be refreshed when reopening a project by -click the Wells Smart Folders and select 
Load/refresh smart folders. This was done to improve the start up time for projects with large data. 

• New user discrete and string attributes appear with default names in the Smart Folders attribute selector until the 
project is saved and re-opened (User: Discrete 1 or User: String 1) 
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2014.1 
Multiple trajectories in a well 

Surveys and plans folder 
Now you can create multiple trajectories in a new model well by inserting a surveys and plans folder.  
Insert new surveys and plans and set them to definitive and active in the well. The definitive survey takes precedence 
over the active plan in the well. Use Inspector to reflect the general status of the point picked on the different 
trajectories namely: MD, INCL and AZIM, XYZ and Explicit (survey from old model well trace on upgrade to new 
model well). The input data and interpolated points are displayed in the new trajectory spreadsheet. The multiple 
trajectories in the new well model participate in RPT and Petrel Studio workflows.   
 
This implementation supports different domain workflows, such as drilling, geosteering, real-time, and reservoir 
engineering. You can create a surveys and plans folder multiple ways:  

• in the Well head importer, select the Create “surveys and plans” folder for each well option  
• in the Create new well dialog, select the Create surveys and plans folder option  
• for the Wells folder that contains legacy wells, right-click and select Upgrade to new model well 
 

Figure 101: Creating Surveys and plans folder using the Well head importer 
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Figure 102: Creating the Surveys and plans folder using the Create new well dialog 

 

 
The survey type can be in MD, Inclination, Azimuth, X,Y,Z or Explicit. The explicit trajectory is the trace converted on 
upgrade from old model to new multi-trajectory model well.  
 
Surveys and trajectories can be created multiple ways: 
• by inserting a new survey from the Surveys and plans folder 
• by using the new survey import format, well path/deviation for surveys (ASCII)(*.*)  
• by upgrading from the old model to the new model (right-click the Wells folder and select Upgrade to new 

well model) 
 
A survey is not overwritten, but can be appended to the Surveys and plans folder. 

Inspector for surveys and trajectories 

When working with surveys and trajectories the generic Inspector window adapts to reflect the general status of a 
point picked on the survey. The info gadget allows you to edit survey and well names, color (but not well symbol), 
well head position, and well datum reference/value. The commonly used well style settings can be modified using 
the slide bar, for example to adjust the symbol, label, and path. The trajectory gadget allows you to access the 
trajectory spreadsheet, trajectory length, and lateral offset (distance of point picked from the well head).  
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Figure 103: Inspector display showing different gadget settings 

 

Trajectory spreadsheet 

The survey/trajectory input data and calculated results are displayed in the new trajectory spreadsheet. Launch the 
spreadsheet using one of the following methods: 
• from the Inspector, on the Trajectory tab, click the Spreadsheet icon 
• in the Input pane, right-click a survey and click Spreadsheet 
• in the display window, right-click a trajectory, and in the mini toolbar, click Trajectory spreadsheet 
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Figure 104: Trajectory spreadsheet showing input (white columns) and computed (gray columns). 

 
 
In the spreadsheet: 
• Read-only columns are gray, editable input data columns are white. 
• Use the tool buttons to ad, insert, and delete rows, copy and paste, and reset and clear filters. 
• In the angle column, an inclination or azimuth angle greater than 360 will be recalculated by subtracting 360 

from the value. For example, if you enter 500 by mistake, 360 will be subtracted from 500, and the cell value will 
be 140 degrees. 

• For MD, inclination, and azimuth, the Grid north and True north options switch the azimuth column header, but 
values are not recalculated. The True north option is only activated if the project is spatially aware. 

For other spreadsheet calculation settings, see the online Help topic, “Well trajectory spreadsheet.” 

Multi-trajectory import and export 

When importing the new model well and survey: 
• A new multi-trajectory well can only revert to the legacy model by using the RPT workflow. 
• A new model well participates in RPT and Petrel Studio data sync across projects. (See the online Help topics for 

RPT and surveys and plans.) 
• There is no option to import an old model well trace on a new well model. 
• Log import and deviation loaders from the Well folder create an old model well. 
• Survey import in the new well model requires you to select the survey format (MD, inclination, azimuth, or XYZ 

from the input data setting), but cannot use both during multiple files import. Other survey data types XYTVD and 
DX, DY, TVD are not available. (See the Survey import settings in the online Help). 
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• Set survey as ‘definitive’ if the ‘surveys and plans’ folder in the well is empty. 
• Append new survey, even if the surveys and plans folder is not empty and no survey is definitive or plan is active.  
 
When exporting surveys, you can use the new export format implemented for multiple surveys, and on the well the 
old export format is still available. From the well, you can export in well path/deviation (ASCII) and it will export 
both the input and interpolated points. From the survey, you can export in well path/deviation for surveys (ASCII) 
and it exports only the input points. 

Upgrading the well model 

The upgrade command is available from the old well context menu. This creates an explicit survey (read-only) from 
the old well trace in the surveys and plans folder. The explicit survey is set as definitive and promoted to the well.  
 
If MD, INCL, AZIM, or XYZ or any other survey format type (for example DX, DY, TVD or XYTVD) was the original 
input data, it is converted to explicit trajectory. A warning message appears before you click OK and commit the 
changes. 
 
If a well has a surveys and plans folder in a 2012.2 Petrel project, it is treated as a new well model when the project 
is opened in Petrel 2014. 
 
In the Input pane, the definitive survey is marked with the  icon. Changing the definitive survey will automatically 
move MD loaded data (well logs and tops). For details, see the online Help topic, “Definitive surveys and active 
plans.” The definitive survey and active plan are updated in the new model well settings. 
 

Figure 105: Showing definitive and active plan in the well settings 

 
Note: A definitive survey is read-only in the tree and cannot be deleted. Proposed wells do not participate in the 
upgrade to a new model well operation. 

Predefined log attributes 
Petrel 2013 introduced user-defined log attributes. Petrel 2014 delivers pre-defined standard attributes to help you 
properly manage log curves in large well projects. The user-defined attributes (Boolean, continuous, discrete, 
date/time, string) are still available. 
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The following predefined log attribute names appear in italics in the Input pane, and their names, colors, and 
templates cannot be edited or deleted: 

• Log alias – Short name used to identify a log curve 
• Log source – Name of company or organization that provides log data or processing for logs 
• Log type – Log data type as it appears in RECALL (edited, analysis, composite, raw, etc.) 
• Log version – Discrete number to identify number of times the same log is loaded 
• Run Date – Date the log was recorded (same as time step attribute) 
• Tool type – Logging tool used to acquire the log 
• Sample Rate – Log sample interval steps 
 

Figure 106: Well log attributes in the Input pane 

 
 
Log attributes can be displayed in the Log attributes spreadsheet, where their values can be modified. 
 
In the tree, the time step attribute is merged with the run date attribute. On upgrade, the time step attribute in prior 
Petrel releases is merged with the run date attribute in the log attribute spreadsheet. 
 
On the LAS importer, the time step attribute used to create the time series log is replaced with Run date. See the log 
attributes LAS importer for details. The log attributes are not auto selected. You must check the attributes to be 
loaded in the log attributes tab of the LAS importer.  
 
You can launch the Log attributes spreadsheet from multiple locations: 

• On Home tab, in the Manage data group, click the Managers split button and click Log attributes.  

• On the Stratigraphy tab, in the Well group, click the Well data managers split button.  

• In the Input pane, right-click the main Wells folder, the Global well logs folder, or the Log attributes folder, then 
click Log attributes. 
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Figure 107: Log attributes spreadsheet with row edit tracking indicators 

 
 
Spreadsheet tools allow you to copy, paste, reset, and clear filters on the spreadsheet. The Log attributes 
spreadsheet allows you to copy data from outside Petrel Explorer panes into the white, editable cells, although you 
cannot use copy and paste to add rows to the spreadsheet. Data in gray cells is fixed (read-only). There is one column 
per log attribute and one row per global well log. 
 
Log attributes and log curves can be synced across projects using RPT and Petrel Studio workflows. 

Well reference datum 
Well datum reference previously referred to as KB/offset is changed to the well datum value in the well attributes 
folder. This implementation supports different well datum name and value on well heads import format.  
 
Well heads import format is modified to include three additional columns: well datum name, well datum value, and 
well datum description, as shown in Figure 108. The well datum name can be KB, GL, RT, DF or user defined. The well 
datum template is changed from KB to well datum. Well datum value appears in the tree under Well attributes folder. 
 

Figure 108: Well head import settings showing the well datum name, value and description 

 
 
In the well manager, the well datum name and value columns are displayed as part of the default attribute. The well 
datum value can be edited, but the well datum name is read-only. See the online Help for more details. 
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Figure 109: Well manager showing the well datum name and value 

 

Last edited attribute 
In the Well manager, a new Last edited attribute appears on the Show button pull-down list. The Last edited 
spreadsheet column allows you to display and sort by the time stamp (the last time the well was edited in the Well 
manager). This Last edited attribute is not visible in the well attributes folder.  
 
The time stamp date format corresponds to Petrel project default date in the well settings. The time stamp is read-
only and cannot be edited. 
 
Use the Show button to hide or display the last edited column. Double-click the Last edited column header to sort in 
ascending or descending order. 
 

Figure 110: Last edited column in the well manager 

 

Locked well tops 
Locked well tops are grayed out (not editable) in the Well top spreadsheet. If the Well top spreadsheet is open when 
the lock operation is performed from the top of the context menu, the Well top spreadsheet is updated interactively. 
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Figure 111: Locked well tops for Top Tarbert and Top Etive are not editable in the Well top spreadsheet 

 
 

Well tops thickness calculation 
A well’s Settings dialog now has an option for well tops thickness calculation. This allows well tops with undefined 
dip and azimuth values to have dip and azimuth treated as zero when the option is selected. When this checkbox is 
cleared, undefined dip and azimuth values are ignored in the thickness calculation. 
 

Figure 112: Thickness calculation option in the well Settings dialog 
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Geology: Structural & Fault Analysis 

2014.2 
SFA operations on VBM faults 
In 2014.1, SFA operations were not available for use on faults generated by VBM. With the 2014.2 release, the full 
suite of SFA becomes available. 

2014.1 
Well juxtaposition analysis 
The new 1D juxtaposition analysis process allows ‘juxtaposition’ or ‘triangle’ diagrams to be generated directly from 
well data. This is one of the classic methods for de-risking faulted traps in exploration settings. 
 
The well juxtaposition analysis process allows rapid 1D seal analysis of a faulted reservoir, without pre-creating a 3D 
grid. The process can be used to generate multiple realizations to understand the predicted seal behavior of a fault, 
with the synthetic grids and faults generated, allowing access to Petrel property calculator and filters, and RDR’s 
existing seal analysis tools. 
 

Figure 113: Accessing the well juxtaposition analysis tools 

                    
 
The 1D juxtaposition analysis tools allow for: 
• The rapid risking of faults in exploration settings. 
• Multiple uncertainty realizations that can be generated quickly to assess the likely seal behavior of a fault. 
• Generated synthetic grids and faults that allow access to Petrel property calculators/filters and all the wide array 

of existing seal analysis tools (e.g., reservoir windows, SGR’s, column heights). 
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Figure 114: Exploration well with associated juxtaposition diagram highlighting potential key  
fault juxtaposition windows that are likely to leak and seal 

 

Horizon clean-up process 
The horizon clean-up process allows you to quickly clean data. This enables more rapid and accurate mapping and the 
creation of more robust geomodels. 
 
The horizon clean-up tool is a major new process in Petrel. The tool allows you to intelligently and rapidly clean up 
horizon interpretation data. 

Figure 115: Accessing the horizon clean-up process tools 

 
 
You can perform general cleaning of the horizon or specifically clean around faults with a range of different 
algorithms. 

Figure 116: General cleaning of a seismic horizon prior to any fault picking/modeling 
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This ability to efficiently clean-up data allows for more rapid and robust geomodels to be built using the pillar 
gridding/corner point gridding tools and the structural framework tools. The tool should aid geophysicists, geologists, 
and geomodelers to produce better interpretations and models more rapidly. 
 

Figure 117: Automatically selected areas to delete around faults (left) and the resulting high quality geomodel  
constrained by the good quality horizon data (right) 
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Reservoir Engineering 
Reservoir Engineering: General 

2014.3 
Petrel 2014.3 introduces support for INTERSECT 2014.1 through supporting dual porosity and unstructured local grid 
refinements (the INTERSECT Grid Edits workflow); the ability to use the INTERSECT MR license when running 
simulation cases; and the addition of options to import networks into Petrel and use these networks in a strategy 
created using the Field management process to run reservoir-network coupled cases. 

You can import ECLIPSE Network Simulator (ENS) network data, generate network coupled INTERSECT cases and 
visualize the network results in the new network result visualization window. You can also import coupled ENS-
INTERSECT simulation cases running outside of Petrel and visualize the network results. 

ENS is designed to be used by a reservoir engineer to evaluate pressure losses in both production and injection 
networks; an ENS model can be thought of as a proxy for a more sophisticated network model, but one which may 
better suited to full field simulations.  

Grid Property Edits 
• Support for dual porosity and unstructured local grid refinements (LGRs) with INTERSECT 2014.1.  
• Properties exported from Petrel can be edited within INTERSECT using IXF. In this case, transmissibility and pore 

volume are recalculated from the Petrel pillar grid geometry imported using the GSG file. 
• The ECLIPSE Migrator now converts edits in the GRID and EDIT section to equivalent edits in IXF rather than 

applying them within the Migrator and writing the edited properties into the GSG file. This means it is now 
possible to modify the edits within IXF without running the Migrator again. 

ECLIPSE Network Simulator 
The ECLIPSE Network Simulator (ENS) can be used to evaluate pressure losses in both production and injection 
networks. ENS functions in two modes: 

• A standalone mode in which the network can be modeled and tested with various boundary conditions and 
constraints,  

• A coupled mode in which the network can be balanced with the INTERSECT reservoir simulator. 

The ENS data file can be imported into Petrel to visualize the network topology, modify network settings and 
generate reservoir-network coupled simulation cases. The modified ENS network settings can be exported for a 
standalone ENS run. 

Settings dialog (ENS network object) 

You can view and alter various properties besides the main network structure in the Settings dialog for an ENS 
object. 



 

Petrel Platform What’s New Guide 2014 144 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

To open the Settings dialog for an ENS object, either double-click on the ENS object in the ECLIPSE networks 
folder in the Input pane, or right-click the ENS object, and then click  Settings. 

In addition to the standard Petrel tabs for Info and Statistics, the Settings dialog contains a Style tab (defining 
Node and Branch colors and Layout) and a Settings tab. 

The Settings tab comprises the following sub-tabs: 

Pipes tab 

The Pipes tab displays information for the ENS pipes. Each pipe consists of a name, a start node and an end node. 
Each pipe can be associated with a VFP table and if so with an artificial lift quantity (ALQ). 

You can filter the table of pipes by the Branch name, the Start node name and the End node name. Click  to 
clear any filter text. 

To modify the associated VFP table, either click  Launch search dialog and choose the required Flow performance 
table, or select a VFP table in the Input pane and insert  into the selected row in the pipes table. To disassociate a 
pipe from a VFP table, click the currently selected VFP table and press the Delete key on your keyboard. 

Boundary conditions tab 

The Boundary conditions tab provides information on the network boundary nodes and their conditions. You can 
filter boundary conditions by the Node name. Click  to clear any filter text. 

The coupling between the boundary nodes and the project flows determined at import time can be modified. Boundary 
conditions can be one of three types "Productivity index", "Constant Rate" and "Inflow performance relationship". By 
selecting the appropriate boundary condition type, the relevant table cells are enabled and irrelevant ones are 
disabled so that you may only make relevant changes. The Terminal node pressure, which is the fixed pressure of 
the terminal sink node in the production network, may also be changed. 

Node constraints tab 

The Node constraints tab is used to view and edit the constraints set on the network nodes. You can filter node 
constraints by the Node name. Click  to clear any filter text. 

To add a node constraint to the table, click  Add new node constraint. Click  Launch search dialog to select 
the required node and enter the constraint values. A constraint will only export if Active is selected. To remove a 
constraint, select the row and click  Remove selected node constraint. 

Gas & water removal tab 

The Gas & water removal tab is used to set the gas and water removal rates and fractions on the network nodes. It 
is only displayed for production networks. You can filter gas or water removal by the Node name. Click  to clear 
any filter text. 

To add a row to the table, click  Add new gas and water removal definition. Click  Launch search dialog 
to select the required node, and enter the removal values. Removals will only export if Gas removal active and/or 
Water removal active are selected. To remove a removal, select the row and click  Remove selected gas and 
water removal. 
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Network tab 

The Network tab displays an overview of the network in a tree form. Network nodes can be expanded and collapsed 
by clicking on a node name. The Title can be modified, if required. 

Network results visualization 
Use the Network results visualization process to select the network results that you want to display. 

Once a coupled simulation is complete, the network results can be superimposed on the network topology in a 
Charting window, as bubbles or pie charts. Use the Time player together with network results visualization to 
identify trends, anomalies, or potential problems during the simulation period. 

Import an ENS model 

Import an ENS model into Petrel to visualize the network and change its properties. To import an ENS model: 

 On the Home tab, in the Manage data group, click  Import file. 

 From the Files of type list, select 'ECLIPSE Network Simulator (*.DATA)' and select the file that you want to 
import. 

The Petrel importer validates the data in the file and tries to match any boundary nodes with existing Tubing or 
Annular flows in the currently opened project. The Matching confidence column in the Import ECLIPSE 
Network Simulator model dialog is green if there is a perfect match in names, or yellow if there is a partial or 
failed match. 

For a partial/failed match, click  to open the Search for Tubing or Annular Flow dialog. Select the matching 
well and click OK. 

 Click OK to finalize the import. 

If multiple files are imported, the Import ECLIPSE Network Simulator model dialog appears for each network. 

The importer finalizes the import by reading in any referenced VFP tables. A VFP (Hydraulic tables) folder and 
an ECLIPSE networks folder containing the ENS object are created in the Input pane. 

Note: Failing to import a VFP table results in a failed ENS import. 

View an ENS network 

After importing an ENS data set, view the network structure from the Settings dialog.  

 In the ECLIPSE networks folder in the Input pane, right-click the ENS object, and then click  Settings. 

 In the Settings dialog, click the Settings tab and then click the Network tab. 

This tab displays an overview of the network in a tree form. Network nodes can be expanded and collapsed by 
clicking on a node name. 

To change the network name, type the new name into the Title text box and click Apply. 

  



 

Petrel Platform What’s New Guide 2014 146 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Associate a network pipe with a VFP table 

A network pipe can be associated with a VFP table and artificial lift quantity (ALQ) from the Settings dialog. 

 In the ECLIPSE networks folder in the Input pane, right-click the ENS object, and then click  Settings. 

 In the Settings dialog, click the Settings tab and then click the Pipes tab. 

The Pipes tab displays information for the ENS pipes. Each pipe consists of a name, a start node and an end node. 

You can filter the table of pipes by typing the text that you want to search for into the Branch name, Start node 
or the End node text boxes. Click  to clear any filter text. 

 Select a row in the pipes table and click  Launch search dialog. Choose the required flow performance table 
and click OK. 

Alternatively, select a VFP table in the Input pane and insert  into the row in the pipes table. 

 If required, set the artificial lift quantity (ALQ) for the pipe. 

 To disassociate a pipe from a VFP table, click the currently selected VFP table and press the Delete key on your 
keyboard. 

 Click Apply. 

Change network boundary conditions 

The coupling between the boundary nodes and the project flows is determined at import time but can be modified 
from the Settings dialog. 

 In the ECLIPSE networks folder in the Input pane, right-click the ENS object, and then click  Settings. 

 In the Settings dialog, click the Settings tab and then click the Boundary conditions tab. 

This tab displays the network boundary nodes and their conditions. 

You can filter boundary conditions by typing the text that you want to search for into the Node text box. Click  
to clear any filter text. 

 Make the required changes to the boundary conditions. The Terminal node pressure, which is the fixed 
pressure of the terminal node in the network, may also be changed. 

 Boundary conditions can be one of two types: Productivity index or Constant Rate. By selecting the appropriate 
boundary condition type, the relevant table cells are enabled and irrelevant ones are disabled so that you may only 
make relevant changes. 

Note: 

• In a standalone ENS run, Petrel does not support an Inflow Performance Relationship (IPR) type boundary 
condition. 

• In a coupled simulation case, when boundary nodes are coupled with wells, the coupler (INTERSECT Field 
Management) sets an IPR from the reservoir wells as the boundary condition on the coupled nodes in the 
network. 

 To change the coupled well or choke node, click  Launch search dialog and select the required ENS node. 

 Click Apply. 
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Define constraints on network nodes 

Define network flow and pressure operational limits for an ENS network from the Settings dialog.  

 In the ECLIPSE networks folder in the Input pane, right-click the ENS object, and then click  Settings. 

 In the Settings dialog, click the Settings tab and then click the Node constraints tab. 

This tab displays the constraints set on the network nodes. 

You can filter existing node constraints by typing the text that you want to search for into the Node text box. Click 
 to clear any filter text. 

 Click  Add new node constraint to add a new row to the table. 

a. Click  Launch search dialog and select the required node for the new constraint. 

b. Enter constraint values into the appropriate fields. 

c. Select Active to activate the node constraint.  

A constraint will only export if Active is selected. 

 To remove a node constraint, select a row and click  Remove selected node constraint. 

 Click Apply. 

Define gas or water removal from a network node 

Gas or water removal from a network node can be defined from the Settings dialog. 

 In the ECLIPSE networks folder in the Input pane, right-click the ENS object, and then click  Settings. 

 In the Settings dialog, click the Settings tab and then click the Gas & water removal tab. 

This tab displays the gas and water removal rates and fractions on the network nodes. 

You can filter existing gas or water removal by typing the text that you want to search for into the Node text box. 
Click  to clear any filter text. 

 Click  Add new gas and water removal definition to add a new row to the table. 

a. Click  Launch search dialog and select the required node for the new removal. 

b. Enter the removal values into the appropriate fields. 

c. Select Gas removal active and/or Water removal active to activate the removal.  

Removals will only export if Gas removal active and/or Water removal active are selected. 

 To remove a removal, select a row and click  Remove selected gas and water removal. 

 Click Apply. 

Export an ENS model 

ENS models can be exported from Petrel and saved as a .DATA file.  

 In the Input pane, select the ENS model that you want to export.  

 On the Home tab, in the Manage data group, click  Export file.  
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 Type a file name in the Export as dialog and click Save.  

 Select the File unit system and click OK.  

The model and any dependent data (VFP tables and so on) are exported to the selected location. Petrel displayed 
any export messages in the Message log. 

Create a study to view network results 

The network result study is created using the Network results visualization process. You can share a study 
between projects using the Reference project tool. 

 On the Simulation tab, in the Summary results group, click  Network results to open the Network 
results visualization dialog and a Charting window to display the selected results. 

 Click Create new and enter a name for the study. 

 Select the sources, identifiers and properties that you want to view. When making selections, use the search 
boxes at the top of the Sources, Identifiers and Properties panes to locate the required sources, identifiers or 
properties. Click  to clear search text. 

 Click  to select all sources, identifiers or properties or click  to clear all selections. 

You can also categorize identifiers and properties to make selection easier. To do this, click  next to Identifiers 
or Properties, click Categorize, and then click the required category. 

 Choose the Layout method. 

 Choose the Chart type.  

Properties can be displayed as nested bubbles on a Bubble chart, with the area indicating the quantity, or as Pie 
charts, with the segment size indicating the quantity. 

 To hide labels on the chart, clear Show labels. 

 Click Apply.  

The study is saved in the Network result folder in the Results pane and the selected results are displayed in the 
Charting window. 

 To change the layout of the results, select a different Layout method and click Re-layout to update the 
Charting window. 

View network results in a study 

The network results in a study can be displayed in a Charting window. Use the Time player to identify the trend or 
anomalies in the network results. 

 Open a Charting window. 

 Select a study from the Network result folder in the Results pane.  

The results from the study display in the Charting window. 

 To edit the study or change the layout method or chart type, click  Network results visualization on the 
Charting window tool palette to open the Network results visualization dialog. 

 To check how the results change with time, on the Home tab, in the View group, click Players and then click  
Time player. 
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Common workflows for network coupling cases 
These examples illustrate how the network coupling cases are supported in Petrel. 

The first example describes how to create a reservoir-network coupled case. It covers importing networks, adding the 
network with network balance actions in a Field management strategy, and defining the simulation case using the 
created Field management strategy. 

The second example demonstrates various processes to display network results in bubble map and line plot formats. 

Generate a reservoir-network coupled case 

As pre-processor, Petrel imports ENS network data and displays network topology. 

After import, you can make the necessary modification to the network settings. The imported networks are then used 
in the Field management process to create a field development strategy for inclusion in a coupled simulation case. 

Import and visualize ENS network data 

Visualize imported ENS network data in a Charting window.  

 In the Input pane, right-click and then click  Import file. 

 In the Import file dialog, choose ECLIPSE Network Simulator (*.DATA) from the Files of type list, select the 
required file and click Open. 

Petrel matches the surface node with existing Tubing or Annular flows using their names. If the match is perfect, 
the Matching confidence is green; any partial or failed match is yellow. 

For a partial/failed match, click to open the Search for Tubing or Annular Flow dialog. 

In the Input pane, the imported networks are listed under the ECLIPSE Networks folder. Branches and 
associated VFP table are listed in a sub-folder in the VFP (Hydraulic tables) folder. 

 Open a Charting window. 

 In the Input pane, double-click on the network to open its Settings dialog. 

 On the Style tab of the Settings dialog: 

d. The color of node and branch can be modified. 

e. The layout of display can also be changed. To do this, select the method from the Method to use list and 
click Re-layout. 

 On the Settings tab of the Settings dialog: 

f. On the Pipes sub-tab, the VFP table and ALQ can be modified. 

g. On the Boundary conditions sub-tab, the terminal node pressure and boundary conditions can be changed. 
The value has to be provided for the later simulation run. 

h. On the Node constraints sub-tab, the pressure and rate constraints are set. 

i. On the Gas & water removal sub-tab (only for a production network), the gas and/or water removal rate or 
fraction can be set or modified. 

j. The Network sub-tab shows the tree structure of network. 
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 In the Input pane, right-click on the network and click  Export object. 

The ENS data and network associated VFP tables are exported. The exported ENS model can be run standalone in 
ENS. 

Create and run a coupled simulation case 

Use imported networks to create a field development strategy for use in a coupled simulation case.  

 On the Well Engineering tab, in the Field development group, click  Field management. 

 In the Input pane, click the network in the ECLIPSE Networks folder. 

 In the Field management dialog, click  Import selected network from input tree to add the networks 
into the strategy. 

 In the New Network balance action dialog, enter the name for the network balance action and its associated 
strategy and click OK. 

In the Field management dialog: 

a. The selected networks are added under the Networks folder. 

b. The new action is listed in a Network Balance Actions sub-folder in the Actions folder. 

c. The new strategy and included action are listed under the Strategies folder. 

 Click OK to close the Field management dialog. 

 Open the Define simulation case dialog and create a new INTERSECT simulation case. 

 On the Strategies tab: 

a. Select Use field management strategies. 

b. Click  in the strategies table to open the Search for Field management strategy dialog. 

c. Select the field management strategy (with networks) and click OK. 

 On the Results tab, click the Summary vectors sub-tab. 

a. Select all vectors related to networks. 

b. Click to add the vectors to Selections. 

 Save the simulation case. 

 Click Run to export and run the coupled simulation case. 

View network results 

Petrel can display network results from a Petrel-generated simulation case or any ENS network coupled cases 
running outside of Petrel. 
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Display network results as a line plot 

View network results as a line plot using Results charting and analysis.  

 On the Simulation tab, in the Summary results group, click  Results charting. 

 In the Result charting and analysis dialog, toggle on appropriate network summary vectors. 

 Click OK to close Result charting and analysis. 

 To display more plots, right-click on the Charting window and select Split layout. 

Display network results as bubble maps 

View network results as bubble maps in a Charting window. To display network results as bubble maps: 

 On the Simulation tab, in the Summary results group, click  Network results. 

 In the Network results visualization dialog: 

a. Enter a name for the new plot. 

b. Toggle on appropriate network results. 

 On the Home tab, in the View group, click Players and then click  Time player. 

 Play with time and observe the bubble size changes with time at network nodes. The area of each bubble 
represents the value of the result for that node. If multiple result properties have been selected, then stacked 
bubbles are displayed, one bubble for each property. 

 Alternatively, select Pie Chart from the Chart type list. Results are grouped into compatible properties and 
displayed as pie segments. Compatible properties share the same unit measurement, for example oil flow rate 
and water flow rate. Other selected properties are displayed as stacked regular bubbles. 

 To modify the arrangement of the network nodes, select a display option from the Layout method to use list in the 
Network results visualization dialog, and click Re-layout. 

The node names shown for each bubble can be hidden by clearing the Show Labels check box. 

 Click OK to close the Network results visualization dialog. 

To re-open the Network results visualization process dialog, click  Network results visualization on the 
Charting window tool palette. 

 In  Pick/select mode, select nodes in the Charting window. 

 Right-click on selected nodes and click: 

• Show chart, to display a 'stacked' plot at selected nodes in a Charting window. 

• Show chart split by identifier, to display 'thumbnail' plots at selected nodes in a Charting window. 

• Show stacked chart to terminal, to display a 'stacked' plot from the selected node all the way to terminal 
in a Charting window. 

• Show stacked chart to well boundaries, to display a 'stacked' plot from the selected node all the way to 
well boundaries on that branch in a Charting window. 

 To change the layout, right-click on the chart and select a Split by or Split layout option. 

 To change the properties display, click  Results charting and analysis and make appropriate modifications. 
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Field Management 
Petrel 2014.3 includes new tools within the Field management process to help you define a strategy more easily 
including: 

• Network balancing to help you create and edit network balancing actions.  

• Linking options to help you set up the correct links between actions, instructions, strategies and balancing 
actions.  

Network balance 

This dialog assists in the creation and editing of network balancing actions. 

To open the Network balance dialog, right-click the Networks node in the FM Strategy tree, and then click 
Network balance. 

 
The components of the dialog are as follows:  

Balancing action 

The name of the balance action being created or edited; click this to display a list of the available balance actions. 

New Balancing Action button 

Use this to create a new network balance action. If you already have a network balance action open, you are 
prompted to save any changes made to it before creating a new one of the specified type. 

Network well 

This displays the network well for which the values in the other columns apply. 

Reservoir well 

This column sets up the coupling between the reservoir well and the network well boundaries. This column and the 
network well column are used to set the boundary node map property on the network balance action. 
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Coupling location 

This column sets up the coupling location between the specified network well and reservoir well. This column 
and the network well column are used to set the coupling location map and default coupling location 
properties on the network balance action. 

Coupling constraint 

This column sets up the coupling constraint on the specified network well. This column and the network well 
column are used to set the well constraint map and default well constraint properties on the network balance 
action. 

Pressure drop 

This column sets up an artificial pressure drop on the specified network well and reservoir well. This column and 
the reservoir well column are used to set the pressure drop map property on the network balance action. 

Flow performance table 

This column provides an easy way for the flow performance table on the given reservoir well to be specified at the 
same time. When coupling at tubing head, this is required to be set to a valid flow performance table. 

Linking options 

In a valid Field management strategy, there are a number of links between created nodes that need to be set up 
correctly. 

Actions need to be contained in Instructions to run, and in turn these instructions need to be listed in the 
Strategy node to be executed during the INTERSECT run. If group constraints and/or coupled networks are to be 
used, then the corresponding balance action(s) also need to be linked to the Strategy node. To assist in the 
correct formation of these links, whenever an action or instruction is created in the Field management process 
a linking dialog is displayed containing all the linking options appropriate for the type of node that is being 
created. 

Instruction linking 

Instructions are created and linked to actions and strategies using the New Instruction dialog. 

The Instruction to action(s) link allows you to choose options for linking to actions. 

• No linking. 

• Create a new action of the specified type and name along with the instruction and link to its actions 
property. 

• Link to any of the existing actions in the strategy. 

The Instruction to Strategy link allows you to choose options for linking the strategy node. 

• No linking. 

• Create a new strategy node with the instruction and add to its "instructions" property. 

• Select an existing strategy for the instruction. 
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Action linking 

Any action other than a balancing action is created and linked to instructions and strategies in the New Configure 
well action dialog. 

The Configure well action to instruction link allows you to choose options for linking to instructions. 

• No linking. 

• Create a new instruction with the specified name along with the action and link to its actions 
property. 

• Create a link to an existing instruction in the strategy. 

The Instruction to Strategy link allows you to choose options for linking the instruction to the strategy node if the 
option to create a new instruction has been selected. 

• No linking. 

• Create a new strategy node with the specified name along with the instruction. The instruction is 
added to its "instructions" property. 

• Create a link to an existing strategy for the instruction. 

Balance action linking 

Balancing actions are created and linked to actions and strategies using the New LP balance action dialog. 

The Balance action to strategy link allows you to choose options for linking to the strategy node. 

• No linking. 

• Create a new strategy node of the specified name along with the instruction and add to its balancing 
action property. 

• Link to an existing strategy using one of the following options:  

o Directly linked. The new balance action is set on the selected strategy's balancing action property, 
replacing any currently-linked action. 

o Using an action sequence. The new balance action and any existing linked balance actions are 
wrapped in an action sequence, which is set on the selected strategies balancing action property. 

o A combined network balance action. The new balance action and any existing linked balance 
actions are linked into a new combined network balance action, which is set on the selected 
strategies balancing action property. 

2014.2 
Hydraulic fractures in the Local grid process (behavioral 
change) 
If cells identified for refinement were non-contiguous (for example, if the region contained pinch outs) a local grid 
refinement around a given hydraulic fracture was not created. This check has been relaxed to allow refinements in 
regions containing non-contiguous cells to be made. 
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Hydraulic fracture transmissibility multipliers in history mode 
(behavioral change) 
If a hydraulic fracture was specified with a start date earlier than the export date of a well, then it would not be 
exported at the first export date as expected. The export date of the well is, by default, calculated as the later of the 
date at which it can first flow and the start date of observed data. From Petrel 2014.2, hydraulic fractures specified 
earlier than this export date will be exported at first export date as expected. 

2014.1 
The Reservoir Engineering tab in the new Petrel 2014 user interface takes you left to right from data import to a 
reservoir model ready for reserves calculation and simulation initialization. It includes the Make surface and Make 
polygon utilities, which from the 2014 platform are all available on the Reservoir Engineering core license. You’ll 
find many familiar dialogs and tools on this tab, and also new tools such as the one-click QC plots for fluids and 
saturation functions. 
 
You can build a simple simulation grid with properties from scratch, or refine or upscale the geological grid and 
properties, then import or create the fluids, rock physics functions and aquifers. The one-click plots enable you 
to QC the input data as it is imported, and CTRL-F makes it easy to find the data you’ve created. Once your reservoir 
model is built then you calculate reserves using the static volume calculation or by moving onto the Simulation 
tab and using a simulator to initialize your reservoir. 
 
The dual scale modelling workflow introduced in 2013.3 uses the Global refinement dialog to create the matching 
refined grid for property population from the initial simulation resolution grid. 

QC workflow enhancements 

Fluid model plots 

Single-click fluid model plots, available from the Fluids group on the Reservoir Engineering tab, are designed to 
streamline the quality control process.  
The following fluid model plots are available:  
• Black oil - oil phase  

For a Black oil fluid model, a plot with four function viewports is created displaying oil formation volume 
factor, oil viscosity, solution gas-oil ratio and fluid contacts.  

• Black oil - gas phase  

For a Black oil fluid model, a plot with four function viewports is created displaying gas formation volume 
factor, gas viscosity, saturation pressure ratio and fluid contacts.  

• Compositional  

For a Compositional fluid model, a plot with two function viewports is created displaying phase envelope and 
fingerprint plot (fraction versus molar mass).  

Display fluid model plots 

Use fluid model plots to display quickly the data for the active fluid model in multiple viewports.  
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To display a fluid model plot:  

1. In the Fluids folder in the Input pane, select a fluid model.  
2. On the Reservoir Engineering tab, in the Fluids group, click Fluid plots, and then click the plot you want.  

A Function window opens, displaying the selected plot.  

Note: If there is no active fluid function, the first function listed in the Fluids folder is displayed. If a Function 
window is already active, the plot will overwrite the data currently shown in the window.  

Rock physics plots 

Single-click rock physics plots, available from the Rock physics group on the Reservoir Engineering tab, are 
designed to streamline the quality control process.  
The following rock physics plots are available:  

• Saturation function  

For a saturation function, the plot displays relative permeabilities and capillary pressures (both for 3-phase 
situations).  

• Rock compaction  

For a rock compaction function, the plot displays pore volume multiplier and transmissibility multiplier versus 
rock pressure.  

Display rock physics plots 

Use rock physics plots to display quickly the data for the active saturation function or rock compaction object.  
To display a rock physics plot:  

1. In the Rock physics function folder in the Input pane, select a rock compaction or saturation function.  
2. On the Reservoir Engineering tab, in the Rock physics group, click Saturation plots, and then click the plot 

you want.  

A Function window opens displaying the selected plot.  

Note: If there is no active function, the first function listed in the Rock physics functions folder is displayed. If a 
Function window is already active, the plot will overwrite the data currently shown in the window.  

Dual scale workflow 
This is an alternative to the traditional method for preparing a simulation grid. 
 
Dual-scale reservoir modeling stimulates collaboration between sub-surface experts, notably Reservoir Engineers and 
Geologists, and across the domains in the general Petrel workflow. The process starts with the collaborative 
production of a simulation-friendly coarse-scale grid, which provides a physical model of geological structures 
including faults and surfaces. This grid is then refined, without changing the geometry of the structures, and 
populated with properties. The properties are then upscaled to the original coarse grid ready for use in simulation. 
The different scales in the coarse and fine models provide the resolution required by the domain experts, but with a 
common view of physical features.  
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There are a number of technical benefits inherent in the dual-scale workflow:  

• There is rigorous alignment between the fine and coarse grids, determined by the mapping function.  

• There is no need for geometrical comparisons between the two grids as the geometries of the grid 
structures are not changed by refinement and upgridding.  

• The bulk rock mismatch between the coarse and fine models is minimized by the mapping.  

• Each fine cell contributes to no more than one coarse cell, minimizing sampling errors and maximizing 
property resolution.  

• There is a well-defined mapping from the cells in the fine grid to the cells in the coarse grid, which is 
required for transmissibility-based upscaling.  

One of the features of the workflow is that all structures such as faults and horizons are at the same resolution in 
both the coarse and fine grids, that is the refinement and upscaling do not change any of these structures. When you 
analyze the volumes at the two different grid scales, you may find that the differences in them are due to the original 
grid being too coarse, with insufficient structural detail for the reservoir features. In this case, you need to refine 
parts of the original grid to provide a more appropriate level of detail for the reservoir structures and start the 
workflow again.  

Note: The following grids are currently supported by the dual-scale reservoir modeling process: structured pillar 
grids, vertical, straight, listric, curved and multi-linear pillars, pillar faults, stair-step faults.  
 

Figure 118: Dual scale workflow 

 
 
The differences in approach between dual-scale reservoir modeling and the traditional method for preparing a 
simulation grid are:  
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Dual-scale reservoir modeling Traditional simulation grid building 

Create/import a coarse-scale grid (1).  

Create a simulation-friendly, coarse grid with sufficient detail 
to show features such as faults and horizons. 

 

Create a fine-scale grid (2).  

Use the refinement process to produce a fine-scale grid. The 
process does not alter any structures and creates mapping 
parameters that define the relationships between fine and 
coarse cells. 

Create a fine-scale grid.  

Use the fine-scale grid to define the physical and structural 
features of the geological model. 

Populate properties in the fine grid (3).  

Populate the fine-scale grid properties including rock types, 
porosity, permeability and fluid saturations. 

Populate properties.  

Populate properties in the grid using the same processes as 
dual-scale reservoir modeling 

 Create the coarse-scale simulation grid. 

Upscale properties to the coarse grid (4).  

Use the mapping parameters in the mapped upscaling 
process to average properties to the original coarse grid. 

Upgrid and upscale from the fine to the coarse grid.  

Use the upgridding process to coarsen the grid geometry and 
to recalculate the physical descriptions of structures in the 
model.  

Use the upscaling process to average and recalculate 
property values for the coarser cell sizes of the coarse-scale 
simulation grid. 

Quality check (QC) the grids.  

Compare the bulk volumes, net bulk volumes, pore volumes 
and fluid volumes of the fine and coarse grids. 

QC the grids.  

Perform the same QC as for dual-scale reservoir modeling. 

 
The mapping function is used during refinement and upscaling to maintain the relationship between the coarse and 
fine cells. During refinement, the mapping function creates a relationship between each coarse cell and the fine cells 
created from it. During upscaling/upgridding, which are combined in dual-scale reservoir modeling, the mapping 
ensures that each refined cell is mapped back to the original coarse cell that produced it.  

Grid refinement 

Use the Grid refinement process to refine an existing grid.  
 
The input to the Grid refinement process is a simulation-friendly 'coarse' grid which is refined without changing the 
structure.  

Note: The following grids are currently supported by the dual-scale reservoir modeling process: structured pillar 
grids, vertical, straight, listric, curved and multi-linear pillars, pillar faults, stair-step faults.  
 
To refine a grid:  
1. On the Reservoir Engineering tab, in the Regridding group, click Global refinement to open the Grid refinement 

dialog.  

2. In the Models pane select the coarse-scale grid and insert  as the Input grid.  
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Note that a name is automatically allocated to the new refined grid based on the Input grid. This name can be 
changed later in the Settings dialog of the new refined grid, if required.  

3. Specify the I, J and K refinements.  
4. If you want to apply different K refinements for each zone (and subzone) in the grid, select the Use per zone 

refinement check box and enter the required refinement for each zone (and subzone) in the zone refinement 
table. This table is automatically populated when an input grid is selected.  

5. To use the same K refinement for all zones, enter the value in the K refinement box and click .  
6. Click OK.  

The grid is refined and appears on the Models pane. The grid name is appended with 'Refinement of' for easier 
identification.  

Note: If you right-click the refined grid in the Models pane, and then click Settings, a record of the refinement is 
shown on the Info, History tab.  

Mapping properties  

In addition to a refined grid, the Grid refinement process creates three properties in a Refinement properties 
folder in the Properties folder for the refined grid on the Models pane. These properties, I mapping, J mapping 
and K mapping, supply a mapping from cells in the refined grid to their corresponding cell in the input grid. The I 
mapping property, for example, will have values from 1 to the maximum I index in the input grid.  
 
The I, J and K indices are interpreted using the current Petrel cell origin settings on the input grid found on the 
Export to simulator and visualization sub-tab of the Mapping tab in the Settings dialog for the grid. The 
mapping properties are used in the Scale up properties process to upscale properties from the refined grid to the 
input grid by selecting the Mapping with properties sampling method.  
 

Refinement statistics  

The Grid refinement process also creates a bulk volume multiplier property in the Refinement properties 
folder. The value of this property represents the relative difference in total volume of a coarse cell and its 
corresponding refined cells. For example, if the value equals 1.0, there is a perfect match. If the value equals 0.5, the 
combined volume of the fine cells is twice the volume of the original coarse cell. Note that the value is constant 
across all fine cells belonging to the same coarse cell.  

Well Engineering  
The Well engineering tab guides the user through Well and completions design and Well deliverability 
calculation, leading to building your Field development strategy either in Development Strategies for ECLIPSE or in 
Field Management for INTERSECT. 2014.1 introduce several significant usability and productivity enhancements to 
the Field Management dialog. 
 
The new interface presents the existing range of options within Petrel for well path design and for completion design 
in a logical left to right order. For example, within the Well path group, the interface offers left to right the simplest 
vertical well using New well, then the use of predefined drilling-friendly templates, then to automated design option 
suited to optimization algorithms, and finally a fully interactive manual option. The new enhanced explanatory 
tooltips to help the user to choose the best option for their task for well path and completion design. 
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The well deliverability group guides the user through the steps to define and use single well simulation using the 
PIPESIM engine leading to a Nodal analysis.  

Completions import and export enhancements  
Several enhancements have been made to the import and export of completions, particularly for the sliding sleeve 
completions introduced in 2013.1 release. 

Sliding sleeve  

Two new rules apply if you choose to build a functional well completion when importing a device control data file :  
• The well is cased to Total Depth (TD).  

• A perforation is placed between each packed interval.  

Event file export 

When exporting an event file you can now export completion depths and attributes in either Metric or Field unit 
systems. By default, the unit system most closely matching the Project system is selected. A UNITS keyword in the 
file maintains knowledge of which unit system was selected.  

Import completion device control data for sliding sleeves and AFCVs 

If you choose to build well completions from the SlidingSleeve section of the file, Petrel will create a completion 
around the sliding sleeve/AFCV. This will consist of a casing to the well's total depth (TD), tubing extending to the 
most upstream depth from the 'SlidingSleeve' data, packers at the given 'SlidingSleeve' depths, the required 
completion device (Sliding Sleeve or AFCV) at the 'SlidingSleeve' downstream depth and perforations between each 
pair of packers. This will use default equipment. Upstream and downstream are defined in terms of the flow path of a 
producing well. Note that the Build well completion from Sliding Sleeve data option will delete any existing 
completions before creating the completions.  

Field management dialog 
Petrel 2014.1 introduces several significant usability and productivity enhancements to the Field Management 
dialog designed to reduce the setup time for users. The well constraints table gives users clear overview and quick 
access to all wells and their constraint values in a single filterable dialog. The syntax and validation required for 
expressions in Field Management has been simplified to reduce mouse clicks .A dialog has been introduced to link 
actions, instructions and strategies. This dialog guides the users to create or link the three objects in one go, and 
hence it boosts users’ confidence in understanding the INTERSECT FM logic framework.  

Well constraints table 

Management of well constraints is simplified with the introduction of a Well constraints table. 

Manage well constraints in a Field management strategy 

The following workflow example illustrates how to create, edit or delete constraints for groups of wells in a Field 
management strategy.  
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Constraints can be applied to individual wells in a Field management strategy by selecting the well and setting the 
appropriate properties. If you have grouped wells within your strategy, you can view, create, edit or delete 
constraints for wells within a group using the Well constraints option.  

To manage well constraints:  
1. Open the Field management dialog.  
2. Either create a new strategy or select an existing strategy from the Edit existing list.  
3. If you are creating a new strategy, add and group your wells.  
4. Right-click the Wells node in the FM Strategy list, and then click Well constraints. 

The Well constraints dialog appears listing existing groups, their contained wells and any well constraints 
that have been defined.  

Note: The wells for a group can be displayed or hidden by clicking the triangular 'expand/collapse' icon in the 
Groups column. Wells can also be filtered from view using the well or type filters at the top of the Well and 
Type columns respectively. Filters interpret trailing whitespace as a wildcard (*).  

5. To add a constraint, click Properties and select the required constraint property.  
A new empty column for the selected property is added to the table; no constraints are created.  

6. Click inside the cell in the table corresponding to the constraint that you want to define or change and type the 
required value.  
Inappropriate constraint properties for a well type are displayed in gray and cannot be edited. An invalid value 
for a constraint is indicated by a red border around the cell.  

 

 
 
7. To delete a constraint, clear the value in the appropriate table cell.  
8. To change a well type, select the table cell corresponding to the well in the Type column. Click and select the 

new type from the list.  
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9. When all constraints are defined, click Apply and then OK to close the Well constraints dialog.  

10. Click Apply to save your strategy.  

Actions, instructions and strategies 
Enhancements have been introduced to make it easier to create actions and instructions and link them to new or 
existing instructions, actions or strategies. 

Create an action and link to an instruction 

When you create new actions, you can link them to new or existing instructions.  
1. In the FM Strategy pane, right-click Actions, click New, and then click and action type.  
2. In the New 'action' dialog box, optionally change the Name of the action.  
3. To link the action to a new instruction, click Create new instruction and optionally change the Name of the 

new instruction.  
4. To link the action to an existing instruction, click Link existing instruction and select the instruction from the 

list.  
5. Click OK.  

If you select an instruction in the FM Strategy pane, the linked actions are displayed in the Properties pane. If you 
chose to create a new instruction to link to the action, you should configure the instruction's trigger and success 
properties, if applicable.  

Create and link an instruction to an action or strategy 

When you create new instructions, you can link them to new or existing actions and/or strategies.  
1. In the FM Strategy pane, right-click Instructions, click New, and then click Instruction.  
2. In the New Instruction dialog box, optionally change the Name of the instruction.  
3. To link the instruction to a new action:  

a. Click Create new Action.  
b. Select the action Type.  
c. Optionally, change the action Name.  

4. To link the instruction to an existing action, click Link existing Action(s) and select the actions that you want 
to link.  



 

Petrel Platform What’s New Guide 2014 163 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

5. To link the instruction to a new strategy, click Create new Strategy and optionally change the Name of the 
new strategy.  

6. To link the instruction to an existing strategy, click Link existing Strategies and select the strategies that you 
want to link.  

7. Click OK.  
If you select an instruction in the FM Strategy pane, the linked actions are displayed in the Properties pane. 
Select a strategy in the FM Strategy pane to display the linked instructions in the Properties pane.  

Simulation 
The Simulation tab provides the tools for single and multiple simulation case workflows. You can import or create, 
manage and analyze dynamic reservoir models. You can move on to do history matching, analyze sensitivities 
and uncertainties across multiple cases. Finally you can derive new cases from existing ones when converting an 
imported case, or creating RESTART cases and sector models. 
A number of new productivity enhancements have been delivered in 2014.1 that are applicable to all simulators from 
making it easier to find tools such as the multi-value probe, and removing the need to select the simulator type when 
importing a simulation deck into Petrel, to one-click access to line plots and 3D results displays, and the new custom 
splitting functionality in results charting and analysis.  
 
The simulation case context tab presents all the operations and tools relevant to an individual simulation in one easy 
to see tab, which will generally act on the selected case – whose name is also displayed on the left hand of the tab. 
Note though that the dialogs for Petrel processes, such as Results Charting or Define simulation case, continue to 
open on the active simulation case  
 
Significant new uncertainty and optimization functionality is introduced with 2014.1; this is the first step on the multi-
year roadmap to bring the best of the MEPO uncertainty and optimization technology onto the Petrel platform.  
 
The import of INTERSECT cases and results, and the user control over the output of INTERSECT cases created within 
Petrel have both been enhanced in Petrel 2014.1. NB These enhancements require the use of INTERSECT 2013.2. 

Simulation analysis 

Productivity enhancements 

Single-click plots performance reports have been introduced to enhance productivity when analyzing simulation 
results. 

Field plots 

Use Field plots to create different field performance charts for the active case and display these in a Charting 
window.  
 
Field plot are stored in the Performance studies folder under Results charting and analyses on the Results pane. You 
can adjust field plots to suit the needs of the project using the Result charting and analysis process.  

The following field plots are available:  
• Production rates  
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Oil, gas and water production rates along with pressure at the field level.  
• Production cumulatives  

Oil, gas and water production cumulatives at the field level.  
• Injection rates  

Oil, gas and water injection rates at the field level.  
• Injection cumulatives  

Oil, gas and water injection cumulatives at the field level.  
 
To display a field plot:  
1. In the Cases pane, select a case.  
2. On the Simulation Case Tools tab, in the Quick view group, click Field plots, and then click the plot that you 

want.  

A Charting window opens displaying the selected field performance chart.  

3. To adjust the chart, on the Charting window tool palette, click  to open the Results charting and 
analysis process.  

Dynamic well filters 

Fundamental to simulation and production workflows is identifying wells of interest from amongst all the wells in 
your field, and then analyzing them, for example for identifying work-over candidates or the reasons for a poor history 
match. The well saved search feature in Petrel has been extended as a great way to define a filter for a group of 
wells based on their dynamic production or simulation data. With 2014, these well saved searches can now be based 
on dynamic observed or simulation production data at a given date, or a range of time. So you can for example, define 
a saved search to filter all the wells that have high oil production but also high water cut at the end of the history. 
Another example is that you can quickly group all the wells into groups based on different well types (producers, 
injectors, injectors converted from producers, etc.). If you’re using assisted history matching in Petrel, all those 
mismatch summary vectors can be used here to quickly filter out the badly history matched wells. 

Extended saved searches 

Extended saved searches expand the existing saved searches functionality to group wells in the Input pane based on 
various criteria.  

Dynamic saved searches 
 
A dynamic saved search is a type of extended saved search that uses input data to filter wells in the Input pane. 
Input data, in the case of the dynamic saved searches, are results from a number of different types of sources. These 
include development strategies, observed data and simulation cases. The filtering is done with the selection of a 
source, a property from that source, start and end dates, the value to compare against, the desired operator and 
finally the frequency with which the comparison needs to meet the criteria. The units are given for reference only and 
cannot be changed when creating a dynamic saved search. 
 
Dynamic saved searches are listed under the Saved searches folder in the Wells folder on the Input pane. To 
apply a dynamic saved search, select the check box next to its name – '[Search ON]' is displayed next to Wells to 
indicate that a search is currently applied. To move wells filtered by a dynamic saved search to a new folder in the 
Wells folder, right-click the dynamic saved search, and then click Move wells to folder based on saved search.  
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Note: Dynamic saved searches depend on calculated input data and when these data change any search that 
includes this data in one or more of its comparisons will potentially be affected. When this happens, any dynamic 
saved search that is potentially affected is marked with an exclamation mark in the Input tree. Toggling the search 
off and on will cause it to recalculate its filtered wells. 

Create a dynamic saved search 

Use a dynamic saved search to filter and group wells based on input data from development strategies, observed 
data and simulation cases.  
 
To create a dynamic saved search:  
1. In the Input pane, expand the Wells folder.  
2. Right-click the Saved searches folder, click Create extended saved search, and then click Dynamic saved 

search: basic property.  
3. On the Search criteria tab of the Settings dialog, define the filter criteria for the search.  

To do this, add, modify, reorder and remove comparison rows that, in combination, form the filter criteria of the 
search.  

a. Click Append comparison  to add a new row to the table.  

b. Select the Source for the data.  

This is the selection of the input data source that will define the available properties for comparison.  

c. Select the Property.  

Depending on the selected source, this will be the property by which the comparison will be carried out.  

d. Select the Start and End dates over which the comparison is to be made.  

These are the dates that define the time period in which the comparison will be relevant. The values 
available depend on the selection of source and property. It is possible to search on only one time step by 
setting the start and end date to the same date.  

e. Select the comparison Operator and Value.  

Available operators are 'more than', 'more than or equal', 'equal', 'less than' and 'less than or equal'. The 
value that you enter will be compared using the selected operator with the input data selected.  

f. Select the Frequency of occurrence over the selected time range.  

'All times' will cause the property value comparison to be executed for all times in the selected period. A 
well will be included in the search if its input data satisfies the comparison options for all dates in the 
period. 'Once' will include a well in the search if its input data satisfies the comparison options for at least 
one time in the selected period.  

g. Add new rows to the table, as required. You can either Append  a new row, or Insert above  or 
Insert below  existing comparison rows. Change the order of rows using the Move up  and Move 
down buttons.  

Comparisons are combined in order according to the chosen Combine option. 'And' will combine the 
resultant wells of the current comparison (one or more rows) with the resultant wells of the following 
comparison (row) as an intersection. 'Or' will combine rows as a union.  

4. Click Apply or OK.  
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To modify an existing search, double-click the search to open the Settings dialog. Click the Info tab to change the 
name of the search and its display color; to change the criteria used by the search, click the Search criteria tab.  

Customized charting 

The results charting and analysis for production and simulation data has two key enhancements that enable our users 
to now create and of course share and re-use through the Reference project tool just about any set of split charts 
they can imagine. The first of these is the custom property grouping. By using it, you have the flexibility to generate 
plots for any combination of properties, based on reporting or analysis purpose. The custom groups can be set up 
interactively from the right mouse context menu on a chart, and are saved with the settings for the chart. Hence 
regularly used custom groupings can be reused in the current project for new simulation studies, and can be shared 
to other projects through Reference project tools and reused in other projects.  
 
The second major enhancement is the multi-level splitting that enables for example a mix of field and wells level 
charts to be created in one split. By using it, you can quickly generate all the plots for selected wells, selected 
properties, and multiple cases in an expected combination. Custom property grouping can be used here as well. 

Customize chart splitting 

You can create new ways of splitting charts.  
 
To define customized splits for your charts, click the Customize splitting button  at the bottom of the Results 
charting and analysis dialog to open the Custom splitting dialog.  

Note: You can also open the Custom splitting dialog:  

• By right-clicking a chart and selecting Customize splitting.  

• From the Style group on the Window Charting tab.  

• From the Settings dialog for the Splits and groups subject on the Results pane.  

There are two ways to customize splitting, represented by the two tabs on the Custom splitting dialog:  

• Custom property grouping, which allows you to group properties into groups that will appear on separate 
charts.  

• Multi-level splitting, which allows you to define multiple levels of splitting, and introduce exceptions to each 
level that will be distributed over multiple charts.  

Custom property grouping 
 
To define which properties should appear on which charts, drag and drop properties from the Properties to group 
tree on the left of the Custom property grouping tab to the Custom grouping tree on the right. Properties can also 
be dragged between groups in the Custom grouping tree, or into new groups. Each group represents one possible 
chart in the resulting split.  
 
When you have defined a suitable property grouping, click OK to apply your changes and close the dialog. To apply 
the custom split, either select from the Split by list on the Results charting and analysis dialog, or right-click a 
chart, point to Split by and select the custom split.  
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Multi-level splitting 
Here you can define to split by more than one property of the selected data. For instance, you could split by 'Source' 
then by 'Primary identifier'. This would result in all series for each well and for each source being placed in a single 
plot.  
You can also define exceptions. For example, if you want to compare the results from multiple simulation cases to 
one observed data set, you could split by 'Source', but add an exception for Source type, 'Observed'. This would result 
in the observed data being plotted alongside the data for each selected case.  
 
To add a multi-level split, open the Custom splitting dialog and click the Multi-level splitting tab. Click Add level 
and select the required property from the drop-down list. A level is only considered valid if it has an assigned 
property. Add additional levels, as required. To define an exception, click Manage exceptions to open the Edit 
splitting component and select exceptions dialog. Select the exceptions and click OK.  
 
Once you have defined a suitable multi-level split, click OK to apply your changes and close the dialog. To apply the 
custom split, either select from the Split by list on the Results charting and analysis dialog, or right-click a chart, 
point to Split by and select the custom split.  

Sharing customized splits 
Customized splits can be shared between multiple projects by copying the Splits and groups subject on the Results 
pane via the Reference project tool.  

Use custom property grouping to create a chart with customized splitting 

How to use custom property grouping to split charts.  

1. On the Simulation tab, in the Summary results group, click Results charting.  
2. If required, create a new study or chart.  

3. Click  to open the Custom splitting dialog.  
4. On the Custom property grouping tab, create a property grouping called 'well performance'.  
5. In the Custom grouping panel, create three groups containing the following properties, and then click OK.  
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The groups appear in the order shown starting with Group 01 on the left-hand side of your graph, Group 02 on 
the right-hand side, and so on. Note that the appearance also depends on the selected split layout, which by 
default is 2 X 2. To change the layout, right-click the chart, point to Split layout, and then click the required 
layout.  

6. Select the split that you just created from the Split by list.  

 
Now any data selections you make will be split into separate charts according to your custom grouping.  
Note: All properties that were not explicitly placed into a custom group will be grouped together into an 
additional chart.  

Once you have reviewed the content, you can extract information for reporting and sharing purposes.  

Use multi-level splitting to create a chart with customized splitting 

How to use multi-level splitting to create a chart to compare a base case with a number of other comparison cases.  
 
This example assumes you have a project with a base case and multiple comparison cases.  
1. On the Simulation tab, in the Summary results group, click Results charting.  
2. If required, create a new study or chart.  

3. Click  to open the Custom splitting dialog.  
4. Click the Multi-level splitting tab.  
5. Type a name for the new split in the box next to Create new.  
 

 
 

6. Click Add level and select 'Case' from the Split by list.  
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7. Click Manage exceptions to open the Edit splitting component and select exceptions dialog. Click 

Case and then select your 'base case'. Click OK.  
You should now have something similar to the following:  

 

 
 
8. Click OK to close the Custom splitting dialog.  
9. Select your new split from the Split by list in the Results charting and analysis dialog.  

10. Select Field OPR from the base case and a number of comparison cases. You should see a chart similar to the 
following in which each plot contains the base case and one comparison case:  
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Once you have reviewed the content, you can extract information for reporting and sharing purposes.  

Interactive filtering and saved searches 

When a simulation case viewed in the Results charting and analysis dialog contains large numbers of items in its 
selection panes, you can filter the lists to help locate items of interest more rapidly.  
• Interactive searches 

You can filter items using the following interactive search methods: contained text, wildcards and initials. The 
filters support the use of '*' and '?' wildcards, where '*' represents any number of characters and '?' 
represents a single character.   
Note: Apply all filters before selecting the items to output as graphs. Once you have created a graph, applying 
further filters only affects the visibility of items in the dialog, not in the resultant graphs.  

• Saved searches 

If the project contains well saved searches (defined in the Saved searches folder in the Input pane), they 
will appear in a Saved search list below the interactive filter for the Primary identifiers tree.  Selecting a 
saved search filters the visibility of wells in the tree to include only those wells that match the chosen search. 
Selecting "None" resets the visibility of all the wells.  

Pre-set multi-level split options 

Three pre-set multi-level split options are included in the context menu within the Charting window: 

• Field-well comparison 
One chart for each selected well as the primary identifier. All selected series having the same well as the 
primary identifier will appear on the same chart. To aid comparison between the field and a well, the field 
data for each selected property (if selected) is also plotted on each chart.  

• HM Multi-case comparison 
One chart for each selected primary identifier (for example, well) with each selected property (such as "oil 
production cumulative"). All series having the same primary identifier and the same property will appear on the 
same chart.  
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• HM observed data 
One chart for each selected source with each selected primary identifier (for example, field or well) and with 
each selected property (such as "oil production cumulative"). All series having the same source, the same 
primary identifier and the same property will appear on the same chart. To aid comparison between the 
simulated data and the observed data, the observed data (if selected) for each selected primary identifier with 
each property is also plotted on each chart. 

Saturation functions and fluid model must now be added to 
Numerical Aquifers (behavioral change) 
In previous releases of Petrel, it was possible to clear the Fluid model and Saturation function fields in the 
Properties tab of the Make Aquifer process. Doing this meant that the aquifer used the fluid model and saturation 
function of the cell in the model to which the aquifer was connected. 
 
With this release of Petrel, it is no longer possible to create a Numerical aquifer without providing a fluid model and 
saturation function for the aquifer. 
 
Although possible, it is not recommended to reproduce previous behavior by extracting the fluid model and 
saturation function from the ECLIPSE dataset. This approach it is likely to be inaccurate – the fluid model and 
saturation function in the grid cell are likely very different from the desired aquifer fluid model and saturation 
function. 
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Reservoir Engineering: Uncertainty and 
Optimization 

2014.1 
Multiple case analysis  

Single-click tornado plots 

Use single-click tornado plots to compare quickly the relative importance of the uncertain variables to field 
cumulative production or objective function.  
 
Single-click tornado plots are designed to streamline the quality control process. The plot is built for all cases in the 
selected case folder. A new Tornado plot window is created if no existing window is currently active.  
 
The following tornado plot options are available:  

• Production – used to compare the relative importance of the uncertain variables to field cumulative production. 

• Objective function – used to compare the relative importance of the uncertain variables to objective function. 

• Production - cumulative view – used to compare the relative importance of the uncertain variables to field 
cumulative production for all timesteps at once. 

To display a single-click tornado plot:  

1. In the Cases pane, select a case folder.  

2. On the Simulation tab, in the Multiple case analysis group, click  Tornado plot, and then click the plot 
that you want.  

A Tornado plot window opens, displaying the selected tornado plot.  

Correlation analysis 

Correlation analysis, which is typically is used to understand dependency between uncertainty variables and the 
project objective – or to reveal conflicts appearing due to a history matching set-up – like the water cut match 
steadily becoming poorer as the pressure match in the same well improves. This identifies that the model may not be 
matched with the current use of uncertainty variables and guides the user to reconsider the setup. 
 
The Uncertainties vs. Responses analysis displays the impact of parameters; this is similar analysis that a tornado 
plot provides, but is more flexible as any simulation database can be analyzed. 
 
The Responses vs Responses analysis displays potentially conflicting objectives; strong red colors in this view would 
indicate problems requiring inspection 
Data types supported by correlation analysis are the same as those in cluster analysis: case variables, objective 
function partials and RFT mismatches.  
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To open the Correlation analysis dialog, on the Simulation tab, in the Multiple case analysis group, click  
Analysis and then click  Correlation analysis.  
 
The Correlation analysis dialog is divided into two main sections:  

• The upper part of the dialog provides tools for selecting data to be used in analysis.  

• The area at the bottom of the dialog shows the correlation analysis result. Results are presented either as a 
table or in a list. Cells are automatically colored according to the correlation coefficient values.  

It is recommended that you select the cases first to filter the list of variables accordingly. If you do this, you avoid 
building up a combination of variables which are not available in the shown cases. Data attributes can be added to 
and removed from the Rows and Columns lists on the right side using the  buttons between the data attributes 
list and the Rows and Columns panes. Data grouping and filtering is also supported.  
 
To run the analysis, two different methods can be defined, the 'Pearson' or the 'Spearman' algorithm. The Pearson 
method is a linear correlation while the Spearman correlation is used when the data has many outliers. The second 
correlation is more stable since it first ranks the values and then correlates those ranks. The Calculate button will 
run the analysis process.  

Cluster analysis 

The cluster analysis technique is useful to find models that are fundamentally different. Cluster analysis makes it 
easier for users to find for instance the models that are of most interest after a history matching study. The analysis 
may reveal which models of good quality that are fundamentally different with respect to use of uncertainty variables 
and which models of equal overall match quality that are most different when it comes to matching of different data 
sets – like some matching pressures best and another are better on GOR and WCT.  
For prediction purposes the models that have similar match quality, but fundamental differences are the most 
interesting to evaluate. Simply because they have the largest likelihood of producing substantially different forecasts 
to account for in the decision making process. 
 
To open the Cluster analysis dialog, on the Simulation tab, in the Multiple case analysis group, click  
Cluster analysis.  
 
The Cluster analysis dialog is divided into two main sections:  

• The upper part of the dialog provides tools for selecting data to be used in analysis.  

• The area at the bottom of the dialog shows the cluster analysis result, where all simulation cases are designated 
to a cluster and cluster representatives are marked.  

For cluster analysis it is recommended that you select simulation cases first (in the Select cases pane) since this 
will have an impact on the parameter selection. The Select data pane only contains parameters which are available 
in all selected cases. If no cases are selected in the Select cases pane (by default), all available attributes will be 
shown in the selection list.  
 
There are three different data types available for the cluster analysis:  

• Case variables - typically uncertainty/control parameters and global values of objective functions.  

• Partial mismatches calculated by the Define objective function process (stored in the results tree as history 
match quantities).  
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•  Partial mismatches calculated by the Define RFT mismatch process (stored separately in the project).  

To make data selection easier, it is possible to create custom groups of these data types.  
 
Data attributes that will be used by cluster analysis are shown in the Selected pane. To add parameters to the 
cluster analysis, select them in the Select data list and insert  into the Selected pane.  
 
When the data selection is complete, the number of clusters need to be specified before the analysis method can be 
run using the Calculate button. It is recommended to start with 3 or 4 clusters and increase or decrease the number 
of clusters, if needed.  
 
The result is presented in a table format at the bottom of the Cluster analysis dialog. The cluster number is shown 
for each selected case as well a check box marking the representative of the individual clusters.  

Group and filter data for cluster or correlation analysis 

Instead of using individual data values, the data attributes for cluster or correlation analysis can be grouped together. 
Typical examples of groupings are a sum of all mismatches for a particular quantity, for a particular well or for a 
particular date.  
 
Data attributes can also be filtered to reduce the number of presented attributes. Both the grouping and the filtering 
are achieved using data selections which are available in cluster and correlation analysis.  
 
To create groupings and selections:  
1. In the Correlation analysis or Cluster analysis dialog, click to open the Data identifier selection dialog.  

All available parameters are shown on the left side of the dialog.  
2. Enter a name for the data selection in the box next to Create new.  
3. To add data to the selection, select an item in the mismatches list and insert into the Selected pane.  
4. To create a group, highlight the items to be grouped in the original list, right-click and choose the required 

grouping option.  
a. Create group will create one single parameter equal to sum of all those currently selected.  
b. Create groups by boreholes, Create groups by properties or Create groups by dates will create one group per 

borehole, per property or per date from the currently selected items.  

Groups appear in the list on the right and can be renamed there, as required.  
5. Click OK to save the selections or groups and close the Data identifier selection dialog  
6. To use a specific data selection in one of analysis methods, select the group or selection from the list in the 

Select data pane.  
When a data selection is used, only the items defined in the group are available for analysis.  

 
Data selections are stored in the project unless you delete the selections. Groups are not created anywhere in the 
project and are just declared in the data selection object. They are taken into account by respective analysis methods. 
Data selections do not modify any information associated with simulation cases.  
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History matching and production optimization 
RFT data may now be included in the history matching mismatch calculations. This is a new process that may be 
included in the existing objective function calculations. Note that the RFT mismatch dialog requires its observed 
MDT/RFT logs as Petrel time stamped point well data 

Create an RFT mismatch 

An RFT mismatch object contains definition of parameters and input data to be used in a workflow for calculating 
numeric mismatches between observed and simulated RFT.  
 
To create an RFT mismatch object:  
1. On the Reservoir Engineering tab, in the History match and optimization group, click Define RFT 

mismatch.  

2. Insert  a simulation case into Base case.  
The base case should have RFT logs associated with it. These logs are created by simulator and can be found in 
the Simulation Logs folder under Global well logs in the Input pane.  

3. Insert  an RFT input dataset into Observed RFT.  
The process accepts only one observed RFT input. Therefore, all related RFT data - different attributes (pressure, 
saturations) for all time steps and all wells which you want to use in calculation, should be imported to the same 
data object.  

Once base case and RFT input data are defined, the Data mapping tab is automatically populated with 
appropriate observed and simulated attributes. On this tab, you should decide which attributes should be used in 
calculation and ensure that they are matched correctly.  

4. If you want to override an automatic mapping, insert  the correct simulation log into the appropriate fields in 
the Data mapping tab.  

5. Clear the Use check box next to an attribute if you want to exclude it from mismatch calculations.  
6. Click the Dates and weights tab.  

Each row on the Dates and weights tab represents a property for a specific well in a specific time step from 
the observed object. A simulated date can be set so that the desired RFT report can be matched with the proper 
observed data.  

7. Insert  a Boolean Global well log into Filter.  

If used, the Boolean log will exclude particular points from calculations at the depths corresponding to the points 
to be excluded.  

8. Insert  a General Global well log into Weight.  

This is a continuous log and is used as a multiplier to individual mismatch points. It can be used to define the 
impact individual points will have on the total mismatch value  

9. Define the settings for each line in the Dates and weights table.  
a. To exclude a line from calculations, clear the Enabled check box.  
b. Ensure the Simulated Date is correct. To override the auto-mapped value, select the required date from the 

list.  
c. Adjust the Measurement error.  

This sets a standard deviation for the calculation of the partial RFT mismatch between the simulated and observed 
data.  
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d. Set the Weight.  
This allows you to set a multiplier for the partial mismatch prior to the summation in the global RFT mismatch.  

e. Select the Apply filter and/or Apply weight check boxes to apply the specified filter / weight to individual 
lines in the table.  

The Base Value shows a preview of the partial mismatch values computed using the base case data.  
10. Click OK.  

Calculate RFT mismatches in a workflow 

Describes how to add a mismatch calculation of RFT data to an optimization process and how to use the RFT 
mismatch value in an objective function.  
Before continuing, ensure that you define an RFT mismatch function outside the Uncertainty and optimization 
process using the Define RFT mismatch process. 
 
To include an RFT mismatch in a workflow:  
1. Open the Uncertainty and optimization process and select an existing uncertainty workflow.  
2. On the Base case tab, click Edit workflow.  

3. From the list of Processes, select Define RFT mismatch and insert  it before the Define objective 
function process.  

Define RFT mismatch has to be executed once simulation has finished, so make sure it is called after Wait for 
case results.  

4. Edit the Define RFT mismatch process.  
a. Select an existing RFT mismatch function.  
b. Define a numeric variable where the results of the calculation will be stored.  
c. After the process is finished, the workflow can access the RFT mismatch value using this variable.  
d. Use an Output case (global) workflow variable to reference the case.  

5. Edit the Define objective function process to use include the variable defined in the Define RFT mismatch 
process.  

To combine RFT mismatch with mismatch based on observed data such as production rates or history matching 
optimization, select "Add item" in the Composite function panel in the Define objective function process 
and enter the name of the numeric mismatch variable. It is also possible to apply scale factor to harmonize the 
impact of RFT on the total mismatch. If there is no observed production data available, it is still possible to 
perform optimization on RFT mismatch. To do this, you should use a Production optimization (not History 
matching) Objective function and select the User defined term option. 

Note: It is also possible to evaluate an RFT mismatch on existing cases in the Workflow editor. Mismatch 
values can be reported to the Message log, Output spreadsheet, attached to the case as case variable, and so 
on. 

6. Click Apply.  
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Genetic Algorithm Optimizer 
The Genetic Algorithm included has stronger global search capabilities that the existing Evolution Strategy supported 
and is more applicable for forward-optimization problems. The new GA is capable of handling both discrete and 
continuous parameters, so-called mixed-integer capabilities, which is important for most Petrel Uncertainty and 
optimization workflows.  

Mixed-integer Proxy Optimizer 

The Mixed-integer Proxy Optimizer operates fairly similarly as the Neural Optimizer that has been in Petrel for some 
time. It is, however, based on a better performant proxy modeling technique and has true mixed-integer capabilities. 
This new optimizer combines full simulation runs and optimization on automatically built proxies. It starts with a set 
of runs and builds a proxy which is then sequentially tested and improved. This method has the potential to 
significantly improve optimization efficiency.  

Reservoir Engineering: INTERSECT simulation 

2014.1 
INTERSECT case export 

Our INTERSECT user feedback has guided the usability and functional enhancements to the Define simulation case 
dialog for INTERSECT cases, which now enables you to flexibly control exactly what 3D and summary results are 
output from your simulation runs, both speeding up export, reducing the amount of unwanted output on disk and 
hence speeding up results import.  
 
We anticipate introducing a similar interface for ECLIPSE simulation in a future release. 
INTERSECT export in Petrel has two different modes.  
 
In the first mode, an E300 keyword deck is exported first, with additional files, and the SLB Migration tool is run in 
the background to convert this keyword deck to an IXF INTERSECT input deck. This is how Petrel has traditionally 
supported the INTERSECT simulator.  
 
In Petrel 2014.1, a second mode has been added. In this mode *.IXF and grid data files are written directly from 
Petrel. This export mode is faster and produces a cleaner input model for the INTERSECT simulator than the 
traditional method.  
 
The type of export is chosen dynamically based on features of the case. Currently the following types of cases will 
default to using the older traditional form of export:  

• Targeting INTERSECT 2013.1 or lower  

• Using development strategies  

• Dual porosity  

• Dual permeability  

• Containing unstructured local grid refinements  
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• Containing adsorption functions 

Flexible reporting from INTERSECT cases 
The Results tab for INTERSECT simulation cases now comprises a series of sub-tabs that allow you to more easily 
select the outputs for an INTERSECT case. 

Report frequency 

The new Report frequency tab allows you have a generic control on all the simulation reports, on whether you need 
a specific report (like INTERSECT restart) or not, and what frequency you need. Most of the report types can have a 
different frequency from each other. Typically, you would like a high frequency for summary result, lower frequency 
for recurrent 3D report for 3D visualization, and restart report for only the last step.  
 
For INTERSECT cases, greater flexibility is given to allow you to control the output and frequency of the reports 
generated by the simulator.  
 
From the Report frequency tab you can select which reports, statistics and logs to generate from the simulation. 
You can choose to generate INIT and recurring 3D grid property reports, 3D property statistics to the print file, 
summary and simulation logs. For cases using Field Management strategies you can also control the frequency of the 
simulator generate restart files.  
 

 

Summary vectors 

With this new Summary vectors selection tab, all the summary vectors you selected will be listed in the selection 
tree, which makes the selection much more transparent than before and there is a complete coverage on the 
summary properties available for INTERSECT cases. You get the flexibility to select or delete any summary you need 
for field, group, well, region, aquifer, while before the summary vectors supported and the control given you to 
change it was limited in Petrel. A default summary vector can automatically be set up for the INTERSECT simulation 
case, and you can see exactly which vectors are included in this default selection. 
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Select summary vectors for an INTERSECT case 

Use identifier and property selections to define the result data that is output when an INTERSECT simulation case is 
run.  
 
The time-based results that you select here will appear in the Dynamic results data folder on the Results pane. 
You can also use the property selection procedures described here to select the output properties on the Initial 3D 
grid properties, Recurrent 3D grid properties and PRT 3D grid properties tabs.  
 
To select summary vectors:  
1. Open the Define simulation case process and create a new INTERSECT case or choose an existing case to 

edit.  
2. Click the Results tab.  
3. To create a list of summary vectors, select the Identifiers and Properties and then generate Selections.  

4. (Optional) Click  to clear the current selections and generate a number of default selections from your 
simulation case, then use steps below to modify the selections.  

5. In the Identifier pane on the Summary Vectors tab, select the required identifiers. Click  to select all 
identifiers or click  to clear all selections.  

Different identifiers appear in the Identifiers pane based on other simulation case input. For example, All Well 
segment and All Device appear if a well segmentation set is defined on the Strategies tab.  
Note: When you select identifiers, incompatible property options are disabled in the Properties pane.  

6. In the Properties pane, select the required properties.  
You can categorize properties to make selection easier. To do this, click the Properties drop-down button, click 
Categorize, and then click the required category. 

 

 
 

Tip: Use the search box to locate the required properties. For example, type OPC to locate all properties 
containing 'opc', such as oil production cumulative.  

7. Click to populate the Selections pane with the chosen identifier and properties.  
The time-based results that you select here appear in the Dynamic results data folder in the Results pane 
when the simulation case is run.  

Note: Selections can also be categorized. To do this, click the Selections drop-down button, point to 
Categorize and select the required category.  

8. Click Apply to save your selections.  
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Supported identifiers 

The following identifiers are supported: All Aquifer (*), All Device (*), All Group (*), All Heater (*), All Region (*), All 
Well (*), All Well segment (*), Field, Aquifer, Group, Region and Well.  
 
Note: The All (*) identifiers provide a convenient way to select all identifiers of a particular type. This is not 
equivalent to selecting all of the same type of identifier; the identifiers corresponding to the chosen type are 
disabled. For example, if the 'All Wells (*)' identifier is selected, 'Well' is grayed out in the Identifiers pane and a 
wildcard '*', rather than well names is exported in the simulation case. This improves efficiency when exporting a 
large number of summary vectors from an INTERSECT case.  

Initial 3D grid properties, recurrent 3D grid properties, and PRT 3D grid properties  

The separate recurrent 3D and PRT 3D properties tabs enable you to select exactly those 3D properties that you are 
interested in reporting. For a large model being able to deselect the non-essential ones saves much disk space and 
simulation time.  
Use property selections on these tabs to specify initial and recurrent grid properties and to define which grid 
properties you want to appear in the print file output. Make your selections from the Properties pane and click  to 
populate the Selections pane. A search box is available to locate the required properties and both properties and 
selections can be categorized.  

Simulation logs 

Simulation logs are generated by the simulator when you select one or more of the Well RFT, Well PLT, Well 
segment and Burden temperature options on the Simulation logs tab. Recording the burden temperature output 
from numerical heat loss models in the under/overburden areas, is only valid for thermal cases.  

Partial export of data from an INTERSECT case 
Exporting simulation cases for large models can be very time-consuming, but you often make specific modifications to 
certain parts of the model that do not require the entire model to be re-exported. To speed up simulation case export, 
you may choose to suppress re-export of specific elements in the simulation case (for example, grid, 3D properties, 
observed data, Field Management strategies, well definitions or other IXF files) that have not changed in the Petrel 
model since the previous export. Turning off items means that they are not recalculated or exported; instead, the files 
from the previous export remain unchanged.  

This option should be used with extreme care – if you disable parts of the export, you may create inconsistent data 
sets. 
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Note: This option is not available for all types of INTERSECT export, only those using Field Management strategies 
can allow partial export as these do not require the Migrator to run on an exported ECLIPSE keyword deck.  
 
Partial export is disabled and all the check boxes are all selected by default, meaning that the full data set will be 
exported. Enabling partial export and clearing any a check box will prevent the identified part of the model from being 
exported.  

Imported case workflows 
The support for imported case workflows, that is those where the initial creation (or migration) of the INTERSECT 
case has been performed outside of the Petrel environment, has been greatly enhanced. The support requires the 
latest INTERSECT 2013.2 format files, the “grid edit” format GSG files for the grid geometry. 
 
With these, the INTERSECT input and results files can be imported directly into Petrel 2014.1 as an imported 
INTERSECT case, including in 2014.1 the 3D grid geometry and3D results. This removes the need for the user to 
generate an EGRID file during the migration step when preparing the INTERSECT simulation case. 
 
The imported INTERSECT cases can be copied and edited, and the edited copies run directly from Petrel. The 
imported case can be used within the Uncertainty and optimization process, where the user can variabilize the 
parameters within the IXF files for use within sensitivity or optimization. 
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Exploration Geology 
Exploration Geology: Petroleum Systems 

2014.1 
Calibration using petroleum systems lithology editor 

Petroleum systems modeling 

Calibrate the parameters for the mechanical compaction, permeability, and seal properties by modifying the lithology 
settings in the Lithology editor of the Settings box of an individual lithology and then comparing the results of a 1D 
simulation with the measured data. 
 
 
 

Figure 119: Compare the results of simulated and measured porosity and pore pressure data after  
calibration using a Petroleum systems 1D simulation 
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Increased usability of 3D petroleum systems model 
simulation results 

Petroleum systems modeling 

You can now access petroleum systems simulation results directly on the Results pane of Petrel – this significantly 
reduces the amount of mouse movement and clicking. 
 
When you connect your Petrel project to a PetroMod project, you have all 3D model data available on the Results 
pane. Without having to pre-select certain properties, you can simply load all properties calculated during simulation. 
The speed of data access and of switching between the results at different periods has been greatly improved. Your 
general Reservoir core, Geoscience core or Combined core licenses are sufficient to access PetroMod simulation 
results in Petrel, you do not need a specific Exploration Geology license. 
 

Figure 120: Access to the results of a Petroleum systems 3D simulation on the Results pane 
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Fault data for Petroleum Systems 
You can now collect fault data from structural models and interpretations and transfer this information to a petroleum 
systems simulation. 
 
The fault data can contain geometry and property information like shale gauge ratio or fault capillary pressure derived 
from structural fault analysis workflows in Petrel. In the workflow this data is combined with geologic age 
information. Fault data can now be added to a petroleum systems model and transferred to PetroMod together with a 
simple grid. 
 

Figure 121: Fault history process 

 

Lithology editor 

Petroleum systems modeling 

Manage and create custom lithologies directly in Petrel and use them for petroleum systems modeling. 
 
All Petrel lithologies can be accessed on the Templates pane in Petrel. More than 150 default lithologies are 
available. Open once the Facies table process to add the lithologies to the Templates pane. 
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Figure 122: Standard lithologies on the Templates pane 

 
 
Lithologies created in Petrel can be merged with a PetroMod project. User-defined lithologies can be generated by 
copying default lithologies, mixing lithologies from existing or defining them from scratch based on your data. 
Compaction-related properties of the lithologies can now be modified for user-defined lithologies in a lithology editor 
and a lithology manager.  
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Figure 123: Modify an existing lithology in the Lithology editor 

 
 
This editor can be accessed via the Settings box of each individual lithology. Modifying the compaction behavior can 
be used to calibrate the pressure calculation of petroleum systems models in Petroleum Systems 1D and 3D. 
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Figure 124: Access the settings of all lithologies of a group in the Lithology manager 

 

Invasion percolation migration results 
You now have access in Petrel to invasion percolation migration results from PetroMod. 
 
Invasion percolation is a fast migration simulation method which uses capillary entry pressure to distribute fluids in a 
petroleum systems simulation. This method is predominantly used for structurally complex models and models 
including faults. 
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Figure 125: Invasion percolation results in Petrel 

 

Geotime window improvements 
The Geotime window was improved in performance and visualization capabilities. 
 
You have now improved zooming capabilities, e.g. synchronized zooming over several charts, zooming and panning in 
horizontal and vertical direction. 
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Drilling 
Drilling: General 

2014.1 
Relief well path template 
You can now quickly create a relief well plan with the Relief well path template. 
 
A relief well is a directional well, designed to intersect and communicate with a blowout well in order to kill the 
uncontrolled flow or conduct abandonment operation. 
 
Relief well planning may be required for any well operations that will enter the pressure envelope of a well that is 
capable of natural flow.  
 
The relief well path template allows you to design a well plan intersecting another target well. 
 
To access the relief well path template, do one of the following: 

• In Ribbon mode, on the Well design tab, in the Well path group, click Well templates.  
• In Classic mode, double-click Well path design (new) in the Processes pane.  

 
The Well templates or Well path design (new) dialog box will appear. In this dialog box, you can design the relief 
well plan on the Relief well path tab.  
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On the relief well path template, you can select or input the following: 

• Options to create a new well path plan or replace the existing well path plan. 
• Options to create a new well or attach the new plan to an existing well. 
• Target well to be intersected: you can select it in the Input pane or 3D window and add it to the Target well 

field on the Relief well path tab.  
• Preferred distance and allowable range between the target well and the relief well. 
• Preferred azimuth and allowable range from the target well to the relief well. 
• Reference datum of the relief well. 
• Depth of the intersection point in the target well.  

In most circumstances the preferred interception point should be at the top of the reservoir where the blowout 
well penetrates the flowing reservoir. For all relief wells, it is essential that there is ferrous material (casing or 
drill string) at the point of interception as this is required for the ranging tools to function. Generally, the first 
approach point should have casing or drill pipe extending for at least 300m above the intersection point. In 
Petrel, the MD of the intersection point must be at least 600m. 
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• Ranging technology which will be used during drill the relief well.  
The ranging instruments are used to search and detect the target blowout well while drilling. It can determine 
the position of a nearby well relative to the position of the well being drilled. There are two types of instruments 
available as options: Active and Passive. You can also select the Custom option and input a range for the 
ranging tool. 
 

After input of all the design data, click Make run. The relief well will be created in the Input pane. You can edit the 
relief well with Well path designer or Inspector. 
 
In the following cases, Petrel might fail to compute out a relief well trajectory with your input. 
• The MD of the intersection point is less than 600m. 
• The inclination of the target well between the intersection point and ranging point is more than 60 deg. 
• The DLS of the target well between the intersection point and ranging point is too high. It is recommended to 

select an intersection point in the smooth section. For example, the average DLS between the intersection point 
and ranging point is less than 1deg/30m. 

• The relief well location is too far away from the target well. 
 
When Petrel cannot generate the relief well, a warning message will appear. This message will suggest that you edit 
the intersection point or the distance range between the target well and the relief well. 

Trajectory uncertainty 
You can now define the survey program and calculate the Ellipsoid of uncertainty (EOU) for a plan or survey. 
 
Whenever a well is surveyed, measurement errors from a variety of sources introduce some degree of uncertainty 
about the actual position of the borehole. 
 
The Trajectory uncertainty function allows you to define the survey program for a plan or a survey, and then the 
EOU will be calculated and created for this trajectory. 
 
Well head position uncertainty 
Before calculating the well uncertainty or analyzing well anti-collision, now you can set the well head position 
uncertainty in the well settings. If this information is not set, default values will be used that may affect the accuracy 
of the well positioning calculation. 
 
Double-click the well in the Input pane. The Settings dialog box for this well appears. 
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Go to the Settings tab. Input the following for well head position uncertainty:  

• Sea bed/ground level from MSL: The vertical offset to the sea bed or ground level from the mean sea level 
(MSL) at the well head location. Positive value indicates sea bed or ground level is above the MSL. The EOU 
calculation will start from the sea bed/ground level.  

• Radius of uncertainty: The well head position uncertainty expressed by radius at specified confidence level. 
This uncertainty includes the structure uncertainty of the offshore platform location and the slot uncertainty 
(usually the slot radius). 

• Standard deviation: The confidence level of the radius uncertainty. This value indicates how much variation or 
dispersion from the average exists. A low standard deviation indicates that the data points tend to be very close 
to the mean; a high standard deviation indicates that the data points are spread out over a large range of values. 

 
EOU 
Ellipsoids of uncertainty (EOUs) were originally proposed by Wolff and deWardt to describe the uncertainty in a 
wellbore position arising from asymmetric systematic errors (SPE 9223).  
 
The EOUs of Wolff and deWardt were ellipsoids projected onto the horizontal plane, plotted on positional maps (Top 
view maps) to depict the relative positional uncertainties between wells. The vertical section could represent the 
projection of the ellipsoid on the vertical plane.  
 
The Industry Steering Committee for Wellbore Survey Accuracy (ISCWSA) has built a survey instrument error model 
for solid-state magnetic instruments (e.g., MWD, W&DEW, & EMS). The model is based on a paper published by H. 
Williamson “Accuracy Prediction for Directional MWD” (SPE 56702). The model vastly extends the work started with 
the systematic error model and incorporates the experience of the many participating parties.  
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The extensible ISCWSA error modeling has configurable error terms and weighting functions.  
In Petrel, ISCWSA model is used to account for the survey tool errors. To calculate the EOU, you must select the 
correct tool code which has been assigned the predefined parameters for the survey tool based on the information 
from the tool manufacturer.  
 
After calculating the EOU, you can display the uncertainty in an ellipsoid or a volume around a well that is built by 
connecting all the EOUs together.  
 
Survey program 
The survey program is used to calculate the Ellipsoid of uncertainty (EOU) and Volume of uncertainty (VOU) of the well 
trajectory. The survey program for a survey or a plan is the sequence of the survey tools used to measure the well 
path trajectory for each survey section. For plan, select the survey tools to be run. As drilling proceeds, surveys are 
taken of the new hole section and sections of well may be re-surveyed using more accurate survey tools.  
 

 
 

In the survey program, you can input the date for plan or survey. In the Survey program table, you can define the 
depth range and survey tool for each survey section. 
 
1. Date: Petrel will select the geomagnetic model based on the input date. The geomagnetic models are built with 

data from worldwide observatories, satellite missions, and surveys from land, sea, and air. Because the data is 
constantly changing, the magnetic models are updated periodically, for example once per year. 

• For survey, input the date of the survey or drilling. If there are a few survey dates while drilling, use the last 
date.  

• For plan, input the design date.  
• The earliest date you can input is Jan 1, 1900, and the latest date is Dec 31, 2014.  

 
2. StartMD: The top depth of the survey section. 
 
3. StopMD: The bottom depth of the survey section. 
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4. ToolCode: Select the survey instrument used to measure this survey section from the list. Each tool code has 
been assigned the predefined error model based on the information from the tool manufacturer. The following 
predefined survey tool codes are available: 

• MWD: The standard ISCWSA error code for Measurement While Drilling (MWD) tools without any 
correction technologies. 
MWD is a widely used magnetic survey instrument in the industry. It is run inside a nonmagnetic drill collar 
as part of the BHA during drilling operations. It measures the inclination and azimuth (Magnetic North 
reference) at the specific measurement depth of the well. The measurements are taken in downhole and 
transmitted to the surface as mud pressure pulses for real-time survey measurements. These pressures may 
be positive, negative or continuous sine waves.  

The MWD tools which measure formation parameters (for example, gamma ray, resistivity, porosity, and so 
on) are referred to as Logging While Drilling (LWD) tools. 

• MWD+SAG: The tool error code for MWD tools with SAG correction. 
In surveying, SAG (typically capitalized) refers to the mechanical misalignment between the survey package 
and the borehole axis in the vertical plane due to gravity and borehole curvature. The magnitude of SAG 
depends on BHA type, stiffness, geometry, stabilizer position, sensor spacing, hole size, mud weight and 
other factors. 

SAG correction can improve the inclination accuracy in measurement, and directly related to TVD error. On 
average, non-calculated SAG can create up to 80% of TVD errors. 

• MWD+SAG+MSC+IFR: The standard Schlumberger MWD tool error code for MWD tools with SAG, MSC, 
and IFR corrections. 
Multi-station correction (MSC) is a technique for dealing with drilling magnetic interference to MWD. 
Drillstring magnetism is a cause of errors in magnetometer readings in MWD. MSC can improve the azimuth 
accuracy in measurement.  

In-Field Referencing (IFR) is a technique for reduction in the uncertainty associated with the estimates of 
geomagnetic field values, like magnetic declination, dip angle and total strength, which generally come from 
geomagnetic model. IFR performs a magnetic survey closer to the earth, which can be done using a ship in 
the sea or an airplane, flying or sailing inside a small grid area. This survey allows a local magnetic map of 
the crustal field to be built, which can improve knowledge about magnetism for a particular area and 
indirectly improve the azimuth accuracy of MWD.   
This is the state of the art MWD tool error code in the industry that represents the most accurate measure 
of MWD. 

• MWDGyro: The preliminary tool error code for the Gyroscope MWD tool.  
 

Note: It can be used in inclination up to 70 degrees and low latitude. If the Gyroscope MWD is used out of 
application restrictions, large measurement error might be generated. 

Gyroscope MWD is a gyroscope survey tool running as part of the BHA during drilling operations, which 
measures the inclination and azimuth (True North reference) at the specific measurement depth of the well. 
Gyroscope uses the geographic North Pole as the azimuth reference and is not interfered by the magnetic 
objects around it. Therefore, it has a higher accuracy than magnetic MWD, but more expensive.   

The application environment of the gyroscope survey instrument varies from model to model. Mostly it is 
used in low latitudes and low inclination.  

Further information of a specific model is recommended to obtain from the gyro vendors.  



 

Petrel Platform What’s New Guide 2014 195 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

• Continuous Gyro: The preliminary tool error code for Continuous NorthSeeking Gyroscope tool. 
Continuous NorthSeeking Gyroscope (CNSG) is a widely used survey tool in the industry, which measures 
the inclination and azimuth (True North reference) at the specific measurement depth of the well. It is a 
high-accuracy northseeking gyroscope, which is run with wireline cable in a cased hole. CNGS can always 
be used to recheck the MWD measurement and cased borehole re-entry.  

Further information of a specific model is recommended to obtain from the gyro vendors. 
 

5. Apply/OK: After clicking this button, a survey program and an EOU will be created under the selected plan 
or survey in the Input pane. 

Note:  
• In the Survey program table, if there is depth overlap between the sections in the sequence table,  

o For survey, the later tool error code will be used for EOU calculation. 
o For plan, the earlier tool error code will be used for EOU calculation. 

• If the TVD of the well does not start from 0, you cannot directly create survey program and EOU for it 
in Petrel. For example, you cannot create survey program and EOU for a sidetrack wellbore.  

The workaround is to manually combine the survey data of the parent well and the sidetrack well into one 
well and create the survey data which starts from 0.   

• If the start point of the plan trajectory is NOT at the same XYZ location as the well head, you 
cannot create survey program and EOU for it in Petrel. 

The workaround is to create a new well using the start point of the trajectory as the well head location, and 
then copy the plan to the new well. 
         

Creating survey program and EOU 
You can define the survey program for a plan or a survey. After a survey program is created, the EOU for the plan or 
survey will also be created. 
 
1. Select a plan or survey in the Input pane.  
2. Open the Survey program dialog box. To do it, do one of the following 

• If you are using the Petrel ribbon mode, on the Well design tab, in the Well positioning group, click 
Trajectory uncertainty.  

• If you are using the Petrel classic mode, click Borehole uncertainty on the toolbar.  
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3. In the Date field, input the date for the survey or the date for the plan.  
4. In the Survey program table, define the depth range and survey tool for each survey section. 
5. Click Apply or OK.  

A survey program and an EOU are created under the selected plan or survey in the Input pane. 

 

Showing EOU and VOU 
You can now show the Ellipsoid of uncertainty (EOU) and Volume of uncertainty (VOU) for the selected surveys, plans, 
and wells in 3D windows. 
 
After the survey programs are created for the plans or surveys, the EOU and VOU can be displayed in 3D windows.  
EOU uses the ellipsoid volume to indicate the magnitude of the wellbore position uncertainty at a particular depth. 
VOU shows the volume around a well that is built by connecting all the EOUs together. 
 
To display EOU: 

1. Activate the 3D window. 
2. In the Input pane, click the EOU object, or the plan, survey or well with EOU object. You can also select multiple 

objects together.  
Note: When a well is selected, the EOU of the definitive survey or active plan will be displayed.  
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3. Do one of the following: 

• If you are using the Petrel ribbon mode, in the Well position group, toggle on the Show EOU  button.  

• If you are using the Petrel classic mode, toggle on the Show EOU  button on the toolbar. 

The EOU is displayed in the 3D window. 
 

 
 

To hide the EOU display, toggle off the Show EOU button.  
 

To display VOU: 

1. Activate the 3D window. 
2. In the Input pane, click the EOU object, or the plan, survey or well with EOU object. You can also select multiple 

objects together.  
Note: When a well is selected, the VOU of the definitive survey or active plan will be displayed.  

3. Do one of the following: 

• If you are using the Petrel ribbon mode, in the Well position group, toggle on the Show VOU  button.  

• If you are using the Petrel classic mode, toggle on the Show VOU  button on the toolbar. 
 

  



 

Petrel Platform What’s New Guide 2014 198 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

The VOU is displayed in the 3D window. 
 

 
 
To hide the VOU display, toggle off the Show VOU button.  

 
Limitations and issues 
There are some limitations and known issues related to display of EOU and VOU. 
• VOU and EOU can be displayed together. However, when they are displayed together, there is a known issue of 

visualization. To correctly visualize them together, you need to toggle on the Orthogonal camera mode on the 
3D window toolbar. 

 
• Displaying a lot of EOU or VOU might cause performance issues. To avoid performance issues, you can hide the 

EOU or VOU display by toggling off the Show EOU or Show VOU button. 
• If MWD Gyrotool error code is used for the well over 70 degree inclination, large measurement error might be 

generated. 
• Sometimes you might see misalignment between the well trajectory center and the center of EOU or VOU. 

In rare cases, the edge of the VOU might not be tangent to the edge of the EOU for the same well. 
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Drilling: Well Design 

2014.3 
Geological target 

Making geological targets 

The dialog box for making the geological targets has been enhanced. Now you can use the Lock and Unlock buttons 
to define how to shift the target point and geometry center. 
 
You can make a new geological target by defining the target point value or from a source object in the Make/edit 
geological target dialog box.  
 
On the Well Design tab, in the Target group, click Make geological target. The Make/edit geological target 
dialog box opens.  
 
In the Make/edit geological target dialog box, you can select to create a new or edit an existing target.  
 
With the Lock and Unlock buttons, you can shift the target point or geometry center.  

• To shift the target point offset from the geometry center, lock the Geometry center field and input the DX, 
DY, and DZ values in the Target offset from geometry center field. The target point will be shifted 
accordingly.  

• To shift the geometry center, lock the Target center field and input the DX, DY, and DZ values in the Target 
offset from geometry center field. The geometry center will be shifted accordingly.  

• To shift the target point and the geometry center together, lock the Target offset from geometry center field 
and edit the X, Y and Z values in either the Target center field or Geometry center field. Both the target point 
and the geometry will be shifted accordingly.  

For the Irregular target, now you can input the Thickness above and Thickness below at each offset point. You 
can also input the Arc radius between the two connected points. 
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Digitizing geological targets 
The Digitize target tool is available on the Tool palette of Well design. You can use the Digitize target tool to 
create geological targets in the 3D window.  
1. On the Well design tab, in the Target group, click Digitize target. The Tool palette for Well design 

appears.  
2. Activate the create target tool on the Tool palette and select the target type from the drop-down list.  

Depending on the target type, the target variables appear in the extended pane.  
 

 
 

3. Define the target variables in the extended pane.  
To create target at the grid center, select the Grid center check box.  

4. Click the interest target point on an object in the 3D window. A geological target is created at that interested 
point and shown in the 3D window.  
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Well templates 
The Well templates interface has been enhanced. Now three calculation methods are provided for calculating the 
well plan: From well head, From target, and From well head to target. The Make run button has been removed. 
Now you can click Apply or OK to create the well plan.  

1. In the Well area of the Well template, click Create new or Edit existing. 
In the Plan area, click Create new or Edit existing.  

• If you select to create a plan, a new well plan will be added to the well after you click Apply or OK.  
• If you select to edit an existing plan, select the existing plan to be replaced from the drop-down list. 

After you click Apply or OK, the selected plan will be replaced with the plan that is calculated using 
the template attributes.  

 
2. Select a calculation method:  

• From well head: This is to create a well plan that has specified well head location.  
• From target: This is to create a well plan that has specified target location.  
• From well head to target: This is to create a well plan that has specified well head and target 

location.  
The calculation method will constrain your input. The From target calculation method is not available for the 
Edit existing well option to prevent unintentional changes to the existing well head location.  
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3. Select the sub tab of the predefined well template.  
On the sub template tab, input the required well data.  
• Well head: When Create new well option and From well head or From well head to target calculation 

method are selected, you can type in the well head location data manually or drop the predefined point 
set or target with the blue arrow as the well head (X,Y) and reference level for the well plan.  

• Target: You can type in the target location data manually or use the blue arrow to drop in the selected 
target or point set.  

• Attributes such as DeltaMD, INCL and AZIM.  
4. Click Apply or OK to create the well plan.  
A new well plan is generated, based on the template displayed in this dialog box.  

Target inspector 
You can now use the Inspector to quickly view the geological target data or edit some of its style settings in the 2D or 
3D window. 
 
Open the Inspector and click a geological target in the 2D or 3D window. The target data appears in the Inspector 
window. 
• The General tab lists the X, Y, Z coordinates of the selected target center. 
• On the Quality attributes tab , you can view the target modification information such as Business projects, 

Data status, Confidence factor and Comments.  
• On the Info tab, you can view the shape geometry data of the target. To edit the target, click the edit button on 

the Info tab.  
• On the Style tab, you can change the target style settings, such as Color, Size and Label. The style settings on 

the Inspector Style tab is synchronized with the settings in the Target settings dialog box.  
• On the Association tab, you can view which well or wells the target is associated with.  

Link to well head 
In the Well path designer, the Link to well head option is provided for the first row. When this option is selected, 
the start point of the well plan is set to the same as the well head location. 
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Drilling: Real Time 

2014.4 
Real-time connect 
In previous releases, the Real-time connect could only accept data in the WITSML 1.3.1.1 format. In Petrel 2014.4, 
the Real-time connect can now accept WITSML in the 1.3.1.1 and 1.4.1.1 formats. 

2014.3 
Streaming real-time survey (behavioral change) 
The streamed real-time survey data is now created as a Survey object under the Plans and surveys folder. 

Drilling: Well Positioning 

2014.3 
Anti-collision analysis 
In Petrel 2014.3, you can now perform an Anti-collision analysis for a planned subject well against the existing 
definitive surveys and the active well plans of the offset wells. 
 
To protect safety of people at the rig site and the environment, every well design and execution must avoid collision 
with neighboring wells, especially when adjacent wells are producing. Therefore, Anti-collision analysis is important 
during the well design process. 
 
In Petrel, you can run Anti-collision project scan to analyze all the offset wells in the Petrel project; or you can use 
the Anti-collision windows scan to analyze all the wells displayed in the active 3D, 2D, Intersection or Map 
window. 
 
Each offset well is analyzed based on the surface location, the subsurface distance between the subject well and the 
offset well, and the trajectory uncertainty. 
 
After using Anti-collision analysis, you can view the risky offset wells and their least distance line to the subject well 
in the 3D window. You can also view the collision risk level of the offset well in the Anti-collision spreadsheet and 
generate the Anti-collision reports and plots for analyzing collision risks.  
 
If you modify your subject plan or any of the offset wells, the previous analysis will become invalid. You need to 
perform the Anti-collision analysis again. 
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Anti-collision settings 

You can view the settings, including the rules used for Petrel Anti-collision analysis.   
 
On the Well Positioning tab, in the Anti-collision group, click the settings button.  
 

 
 
The Anti-collision settings dialog box appears. 

 
 
The following settings and rules are used for the Anti-collision proximity scan.  

• A/C rule name: The Anti-collision rule name. 
• Comment: The current Anti-collision rule is based on Schlumberger DM Anti-collision standard. 
• Error model: The survey instrument error model is built by Industry Steering Committee for Wellbore Survey 

Accuracy (ISCWSA). 
• Confidence level: All EOU computations are computed at 95% confidence level in three dimensions. 
• Scan method: The scan method used for proximity scan. The 3D least distance method calculates the 

nearest distance to each offset well by stepping down the subject trajectory at a depth interval. 
• Scan interval: The depth interval for the proximity calculation scan.  
• Hole size orientation: The same default hole size is used for the full hole. 
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• Hole size use: When calculating the OSF ratio with the Reduce separation method, the denominator of the 

equation is equal to the center-to center distance subtracting the hole radii. 
• Default hole size: A default hole size (762 mm, 30 inch) is used for all wells during the A/C calculation. 
• Include depth above mud line: The trajectory uncertainty above the mud line is included in the Anti-

collision calculation.   
• Skip global errors: The global errors such as magnetic declination are not included in the EOU 

computation. 
• OSF rules: The oriented separation factor (OSF) rule is used to analyze the collision risk level. The OSF is 

defined as the ratio of the center to center separation between wells and the ellipsoid of uncertainty 
separation, taking into account a fixed probability of collision. 

 
OSF = (CTC-Ro-Rs)/(Eo+Es) 
Where 
Eo: the ellipsoid radius offset well 
Es: the ellipsoid radius subject well 
CTC: the center-to center distance 
Ro: the hole radius of offset well 
Rs: the hole radius of subject well  

 
• Surface rules: At or near surface, the OSF values are unrealistically high, so a minimum allowable 

separation (MAS) rule is applied to the collision risk level. For the Surface rule: MAS = (Ro + Rs) + 0.8(CTC at 
Wellhead – (Ro + Rs)).  

Note: In the current Petrel implementation, these rules are shown in the setting for reference only. 
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Anti-collision project scan 

You can now run the Anti-collision project scan to analyze the collision risk for all the offset wells in the Petrel 
project. 
 
Do one of the following to run the Anti-collision project scan: 

• Right-click the subject well plan in the Input pane and click Anti-collision project scan. 
• In the Ribbon mode, click the subject well plan in the Input pane and click the Anti-collision project scan 

button in the Anti-collision group on the Well Positioning tab.  
• In the classic mode, click the subject well plan in the Input pane and click the Anti-collision project scan 

button on the toolbar.  
 

The Anti-collision result for project scan is created under the selected subject well plan in the Input pane. The result 
name is AC results by project scan. 
 
Alternatively, you can also click or right-click a well and run Anti-collision project scan. By this way, the Anti-
collision result is created under the well trace trajectory (either the definitive survey or active plan) in the Input pane.   

Anti-collision window scan 

You can now run the Anti-collision window scan to analyze the collision risk for all the offset wells in the active 
3D, 2D, Map, or Intersection window. 
1. Activate a 3D, 2D, Map or Intersection window. 
2. Display the offset wells to be analyzed in the active window. 
3. Do one of the following: 

• Right-click the subject well plan in the Input pane and click Anti-collision window scan. 
• In the Ribbon mode, click the subject well plan in the Input pane and click the Anti-collision window 

scan button in the Anti-collision group on the Well Positioning tab.  
• In the Classic mode, click the subject well plan in the Input pane and click the Anti-collision window 

scan button on the toolbar.  
 

The Anti-collision result for window scan is created or updated under the selected subject well plan in the Input 
pane. The result name is AC results by window scan. 
 
Alternatively, you can also click or right-click a well and run Anti-collision window scan. By this way, the Anti-
collision result is created under the well trace trajectory (either the definitive survey or active plan) in the Input pane. 

Showing Anti-collision result 

After running the Anti-collision project scan or Anti-collision window scan, you can show the risky offset 
wells and their least distance line to the subject well in the 2D or 3D window. 
1. Activate a 2D or 3D window. 
2. Click the subject well plan in the Input pane and toggle on the Show Anti-collision result button in the Anti-

collision group on the Well Positioning tab.  
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The Anti-collision result is shown in the window. 
 

 
 
• For the project scan result, the risky offset wells identified by the Anti-collision project scan are shown 

in the window.  
• For the window scan result, the offset wells used during the Anti-collision window scan are shown in 

the window.  
• The least distances between the subject well and each risky offset well are visualized as lines in the 

window. 
3. To hide the Anti-collision result, toggle off the Show Anti-collision result button.  

Anti-collision spreadsheet 

After running the Anti-collision project scan or Anti-collision window scan, you can view the detailed Anti-
collision calculation results for each risky well in a spreadsheet. 
 
1. To open the Anti-collision spreadsheet, do one of the following: 

• Right-click the Anti-collision result in the Input pane and click Anti-collision spreadsheet. 
• In the Ribbon mode, click the Anti-collision result in the Input pane and click the Anti-collision 

spreadsheet button in the Anti-collision group on the Well Positioning tab.  
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The Anti-collision spreadsheet window opens.  
 

 
 
By default, all the Critical Anti-collision results are displayed in the spreadsheet. The Critical risk levels 
are classified as Major, Minor and Alert.  

2. Click the Critical or Detail view option. 
• In the Critical view, only the critical stations with collision risks are displayed in the spreadsheet. The 

Critical risk levels are classified as Major, Minor and Alert.  
• In the Detail view, the Anti-collision data for the selected offset well are listed in the spreadsheet per 

every 3-meter interval of the subject well MD. 
The critical stations are highlighted with colors.  

3. In the Offset wells area, the offset wells calculated by the proximity scan are listed. Click each offset well. 
The critical or detail data for the selected well are listed in the spreadsheet. 

4. To view a critical station clearly in the 3D window, in the Critical view, click the Zoom to button of that 
critical station row. The critical station is zoomed in the 3D window. 

Anti-collision report 

After running the Anti-collision project scan or Anti-collision window scan, you can generate the Anti-collision 
report in PDF format. 
1. Do one of the following: 

• Right-click the Anti-collision result in the Input pane and click Anti-collision report. 
• Click the Anti-collision result in the Input pane and click the Anti-collision report button in the Anti-

collision group on the Well Positioning tab.  
The New report dialog box appears.  

2. Select a report template in the Template selection area. The Report settings area displays the contents of 
the template. A non-editable default template is provided with the installation. You can use this default template 
to generate the Anti-collision report, or you can create a new Anti-collision report template. 
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3. Select the Generate report check box to create the PDF report.  
If this check box is not selected, report generation will only create a report object under the Report Folder in 
the Input pane. You can create the PDF report with the report object later. To do it, right-click the report object in 
Petrel Input pane and click Create report.  

4. Click OK. The Save as dialog box appears. 
5. In the Save as dialog box, give the file name and click Save. The PDF Anti-collision report is generated. 

No-go zone analysis 
You can now visualize the No-go zones around the offset wells for a subject well plan. The No-go zone visualization 
is very helpful for improving the anti-collision analysis efficiency. The Petrel 3D No-go zone not only indicates the 
anti-collision failure information, but more importantly, displays the 3D space where the well plan can go. 
 
In Petrel, you can run No-go zone project scan to analyze all the offset wells in the Petrel project and visualize the 
No-go zone around the offset wells nearby the subject plan.  
 
You can also use the No-go zone windows scan to show No-go zones around all the offset wells which are 
displayed in the active 3D window. 
 
When calculating the No-go zone for each offset well, Petrel steps down each EOU station of the offset well 
trajectory. At each EOU station of the offset well, Petrel computes the perpendicular cross-section, and computes the 
minimum allowable separation distance for each direction. This forms the No-go zone on this cross section. The 
three-dimensional No-go space is constructed by connecting all of the No-go cross sections on each offset well, from 
wellhead to TD.  
 

No-go zone project scan 

You can now run No-go zone project scan for a well plan against all the offset wells in the Petrel project. 
 
To run the No-go zone project scan for a well plan against all the offset wells in the Petrel project, do one of the 
following: 

• Right-click the subject well plan in the Input pane and click No-go zone project scan. 
• Click the subject well plan in the Input pane and click the No-go zone project scan button in the No-go 

zone group on the Well Positioning tab.  
 
The No-go zone result for project scan is created under the selected subject well plan in the Input pane. The result 
name is No-go zone by project scan. 

No-go zone window scan 

You can now run No-go zone window scan for a well plan against all the offset wells in the active 3D or 2D 
window. 
1. Activate a 3D or 2D window. 
2. Display the offset wells to be analyzed in the active window. 
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3. Do one of the following: 
• Right-click the subject well plan in the Input pane and click No-go zone window scan. 
• Click the subject well plan in the Input pane and click the No-go zone window scan button in the 

No-go zone group on the Well Positioning tab.  
The No-go zone result for window scan is created or updated under the selected subject well plan in the Input 
pane. The result name is No-go zone by window scan.  

Showing No-go zone 

After running the No-go zone project scan or No-go zone window scan, you can show or hide the No-go zone 
result in the 3D or 2D window. 
1. Activate a 3D or 2D window. 
2. To show the No-go zone, do one of the following: 

• Click the subject well plan or the No-go zone object in the Input pane and toggle on the Show No-go 
zone button in the No-go zone group on the Well Positioning tab.  

• Toggle on the No-go zone in the Input pane.  
The No-go zones are displayed around the offset wells in the 3D or 2D window. 

 
 

3. To hide the No-go zone, toggle off the Show No-go zone button or toggle off the No-go zone object in the 
Input pane. 

Refreshing No-go zone 

After running the No-go zone project scan or No-go zone window scan, if any underlying data has been 
changed since the computation was performed, the No-go zone refresh button will become available to remind you 
to refresh the No-go zone result in the window.  
 
Click the subject well plan or the No-go zone result in the Input pane. The No-go zone refresh button becomes 
available. 
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The No-go zone result is recomputed and updated in the window.   
 
Alternatively, you can re-run the No-go zone project scan or No-go zone window scan for the subject well. 
 
In the following condition, the No-go zone refresh button will become available to remind you to refresh the No-go 
zone result: 

• The trajectory of the subject well or any offset well has been changed. 
• The Survey program and EOU of the subject well or any offset well has been changed. 
• Any offset well is removed. 

Note: If any new offset well has been added in the Petrel project, the No-go zone refresh button will not be 
available for refreshing. You can re-run the No-go zone project scan to include the new offset wells. 

Viewing No-go zone slice 

You can now view the intersection slices of No-go zone from different directions in a 3D or 2D window. 
 
The No-go zone can be displayed in a 3D window or 2D window. However when there are many wells in the window, 
it might be difficult for the users to see the location of the No-go zone to the subject well. The No-go zone 
intersection slice can be viewed using the General Intersection plane function. 
 
To view the No-go zone slice on the Intersection plane: 
1. Toggle on the No-go zone result in the Input pane to display it in a 3D or 2D window. 
2. On the Home tab, in the Insert group, click Object > Insert random line.  

A General intersection is created under the Input pane. 
3. Toggle on the General intersection to display it in the window. 
4. To display the intersection in horizontal, on the Intersection tab, in the Alignment group, click the Align 

Horizontally.   
5. Click the Snap to point button and click the subject well at a specified depth in the 3D window. The intersection 

plane will be snapped to specified depth. 
6. Click the Visualize on intersection button. The check boxes of the items which can be displayed on the 

General intersection plane become blue color.  
7. Toggle on the No-go zone result. The No-go zone intersection slice is highlighted on the General intersection 

plane. 
8. Click Intersection player in the Position group to review the No-go zone on the General intersection plane. 

The Players window appears. 
9. In the Players-Intersection player window, adjust the increment and play forward or backward the 

intersection plane to observe the distance between the subject well plan and No-go zone intersection slice. 
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If the well plan is crossing the No-go zone intersection line, run the Anti-collision scan for further checking. 
 
Note: The No-go zone only gives you a view of collision hit, but the actual collision risk level must be confirmed 
using the Anti-collision scan. 

Trajectory uncertainty 

EOU spreadsheet 

After an EOU is created, you can view the detailed EOU results at each station in the EOU spreadsheet.  
To open the EOU spreadsheet, do one of the following:  

• Right-click the EOU result in the Input pane and click EOU spreadsheet.  
• Click the EOU result in the Input pane and click the EOU spreadsheet button in the Trajectory 

uncertainty group on the Well Positioning tab.  
The EOU spreadsheet window opens.  
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The EOU spreadsheet lists the detail EOU data at each measured depth, including the length and direction of the semi 
axes of the ellipsoid, the center of the ellipsoid and its bias to the trajectory station point.  
 

 
• Semi-major axis is the longest axis for the ellipsoid.  
• Vertical uncertainty is the half length of the maximal vertical projection.  
• Centers of X, Y, and Z are the coordinates of the ellipsoid center.  
• Biases of X, Y, and Z are the offset distances from the trajectory station to the ellipsoid center in the X, Y, Z 

directions.  
If the EOU result is for a well plan, you can select show the EOU spreadsheet calculated by As drilled logic or While 
drilling logic.  
 
You can copy or export the EOU spreadsheet data. 

Geomagnetic model for Survey program 

The default geomagnetic model for survey program is IGRF-11. Now you can select other geomagnetic models which 
can be downloaded from the Ocean store and installed as Petrel plug-ins. In the Trajectory uncertainty settings, 
you can change the default geomagnetic model and view its valid period. 

OWSG tool code for Survey program 

A new OWSG tool code group is available in the Survey program. This tool group includes additional tool codes from 
the Operator's Wellbore Survey Group (OWSG).  
 
When this option is selected, the Survey tool code selection dialog box appears. You can select the Geomagnetic 
model type, Tool type and Rig status to filter the OWSG tool codes. 
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Driller’s target 
You can now create and visualize a driller's target for a well trajectory and its associated geological target. 
 
A driller's target is derived from a geological target considering the uncertainty of the well plan or survey. Although 
the well trajectory is planned to intersect the 3D space of the geological target, due to the presence of inaccuracies 
of survey tools, it is still possible that the actual trajectory might miss the geological target. To analyze this, you can 
create and visualize the driller's target for a well plan and its geological target.  
Driller's target is defined as a target within which the survey will not miss considering the uncertainty of the survey. 
Therefore, the driller's target is smaller than the geological target.  

 
 

If the geological target is too small or the trajectory uncertainty is too big, the driller's target will become very small, 
or even you cannot generate a driller's target for the well trajectory and the geological target. In this case, you can 
consider to make applicable changes, such as:  

• Extending the geological target.  
• Choose a more accurate survey tool for the survey program to reduce the trajectory uncertainty.  
• Modify the well plan to lessen the approach angle.  
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• Reduce the confidence level of the target penetration. Currently, you cannot change the confidence level for 
EOU in Petrel. A fixed confidence level of 95% at 3D is applied. 

 
Now in Petrel, you can create a driller's target for a well plan and its geological target.  
 
Before you create the driller's target, you must have:  

• A geological target which has been attached to the well.  
• A well plan or survey which intersects the associated geological target under the same well.  
• The Survey program and valid EOU under the well plan or survey.  

 
To create the driller's target for the well plan or survey, do one of the following:  

• Right-click the plan or survey and click Make driller's target.  
• Right-click the Survey program or EOU and click Make driller's target.  
• Click the plan or survey and click Make driller's target in the Target group on the Well Design tab.  
A driller’s target object is created under the associated target folder.  

The created driller's targets are only for visualization. You cannot manually edit the driller's target. If any of the 
underlying data is changed, the related driller's targets will be updated automatically.  
 
A driller’s target can be displayed in a 3D, 2D or Map window.  
1. Activate the 3D, 2D or Map window.  
2. (Optional) Display the associated geological target and well trajectory in the window.  
3. Toggle on the driller’s target in the Input pane.  

The driller's target appears in the active window.  

 
 

4. To zoom the driller's target, right-click the driller’s target and click Zoom to object. The driller's target is 
zoomed in the window.  

5. To change the display parameters, double-click the driller's target to open its Settings dialog box. Similar to 
editing the settings for geological target, you can edit the Style settings for driller's target on the Style tab and 
change the color or name on the Info tab.  

6. To hide driller's target display in the window, toggle off the driller's target in the Input pane. 
 
You can also view the driller's target slices using the Driller's target player.  
1. On the Well design tab, in the Target group, click Digitize target. The Tool palette for Well design 

appears.  
2. Activate the Driller's target player tool on the Tool palette.  
3. Click the driller's target.  

The name of the target appears in the extended pane.  
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4. Set player settings such as the increment, dip and azimuth of the slice.  
To set the plane direction orthogonal to the well plan, select the Orthogonal to plan check box.  
To hide the target if the well plan is outside the well plan, select the No target if outside well plan check 
box.  

5. Play forward or backward the driller's target plane to observe the driller's target slice.  

 

Drilling: Well Construction 

2014.2 
Well Construction 
This is a new module in Petrel that provides relief well dynamic simulation for well contingency planning. Relief well 
geometries can quickly be evaluated and the requirements to kill any proposed well plan are simulated using the 
OLGA* dynamic multi-phase simulator. This enables rapid screening of new well designs for contingency planning 
purposes. Reports are produced as an output to conform with regulatory requirements in many countries, including 
quantification of “worst-case discharge rate” for the proposed well. 
 
Well Construction is the module name of a suite of drilling engineering tools. For Petrel 2014, Well Construction will 
include only Petrel Relief Well. 
 
Petrel Relief Well is a quick screening tool to evaluate the feasibility of a relief well. This is achieved through: 

• A simple workflow based tool that incorporate full physics blowout simulation 
• Meaningful and easy to understand results 
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From this simple-to-use tool, some key parameters are given and a full Drillbench Blowout Control simulation is run to 
provide accurate results highlighting whether or not the well can be killed. The entire input process only takes a few 
minutes and the results are presented in a concise report. 
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The Petrel relief well tool is designed as an integral part of the Petrel process and will use the target and relief well 
trajectories in the Petrel project directly without the need to exchange data through error prone import and export. 
Typically, a blowout study will require a number of inputs that can be time consuming to collect and enter. These 
data may also be highly uncertain in the early stages of a well design. This is why the input has been scaled down to 
key parameters that have a critical impact on the analysis. The rest of the parameters to the underlying simulator are 
automatically set based on conservative assumptions, so that a "successful kill" obtained through the Petrel relief 
well simulation will remain successful if a more detailed study is performed. 
 
The only pre-requisite to run a Petrel relief well simulation is to have two trajectories defined in the Petrel project 
that intersect. After opening and entering the required input into the Petrel relief well interface, the simulation will 
be performed as a background process. The process window can be closed during the simulation. The simulation 
process can take some time (from a few minutes to an hour). Run time depends on the complexity of the trajectory 
and the simulated flow rates. When the simulation is completed, the results will be given in the form of a PDF report. 
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Production 
Production: General 

2014.1 
OFM Data Connector 

Well Matching 

When importing OFM wells into your Petrel project, you can now match OFM wells to Petrel wells based on UWI, 
name, or well head location. 
 
The well matching feature provides the following options: 
• Defining well matching criteria 
• Auto-matching OFM and Petrel wells that have a 1:1 match 
• Manually matching an OFM well that has multiple Petrel well matches 
• Manually matching unmatched wells (for OFM wells that do not have a Petrel well match based on your 

matching criteria) 

Production: Well Deliverability 

2014.1 
Fluid Data Matching 

The Fluid Properties feature provides new options for viewing and modifying Viscosity, Calibration, and Thermal 
properties to match your field fluid data. The software also provides correlation mappings for data imported from 
PIPESIM. 
 

The Fluid Properties feature provides the following options for entering field fluid data: 
 

Option  Description 

Viscosity • Oil viscosity correlations: undersaturated oil, live 
oil, dead oil temperature and viscosity 

• Emulsion viscosity method 

• Watercut 
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Option  Description 

Calibration • Fluid data 

• Pressure 

• Temperature 

• Correlations 

Thermal • Specific heat capacity: gas, oil, and water 

• Thermal conductivity: gas, oil, and water 

• Enthalpy calculation method and specific latent 
heat of vaporization 

Flow Correlation Data Matching 

The Flow Correlation Data Matching feature provides an updated user interface, including new options for 
automatically retrieving log data and observed data, for matching pressure and temperature along the wellbore, and 
for manually entering data for pressure and temperature. The software also provides correlation mappings for data 
imported from PIPESIM. 
 
The Flow Correlation Data Matching process optimizes the algorithm that is used for running VFP and Nodal Analysis 
simulations. Different sets of pressure and temperature data are used for matching purposes and automated retrieval 
and manually entered data types are supported. You can also perform quality control checks by graphically displaying 
the observed data in context with the selected optimized algorithms. 

ECLIPSE Defined Well Productivity Index (PI) Models 

The IPR Model Manager now allows you to automatically retrieve fluid and reservoir properties and IPR data from an 
ECLIPSE case.  
 
You can retrieve fluid and reservoir properties and IPR data by importing them from an ECLIPSE Simulation Case. For 
each inserted time step, the software automatically populates perforation pressure, temperature, phase ratio 
properties, and liquid Well PI when available in the ECLIPSE case. 

Import and Export PIPESIM well models 

In addition to the current import functionality, you can now export a well model in a production model format (.pips) 
so that you can open it in PIPESIM v2013. 
 
For each exported well, the following well data is exported: deviation profile, fluid data, fluid and reservoir 
association to each completion, surface equipment, and the associated flow correlation. 
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Production: Production Analytics 

2014.1 
Ocean API on completion level data 
A plug in writer/creator has the ability to populate a completion level data object in Petrel through a plug-in. The 
types of data that are supported are:  
• Pressures 
• Temperatures 
• Rates 
• Ratios 

Ocean API on Split Set Manager 
A plug in writer/creator has the ability to programmatically create a split set, edit existing split sets, and delete split 
sets in a Petrel project.  
 
The end user can create a split set by: 
• Importing split set data from an Excel spreadsheet or an ASCII file. 
• Copying/pasting information from an Excel spreadsheet or ASCII file directly into the Split Set Manager. 
• Editing the well's perforation allocation directly in the Split Set Manager. 
 
The Ocean API will allow the plug-in developer to: 
• Create split sets with data from external sources. 
• Edit/delete existing split sets. 
 

Production: Production Interpretation 

2014.3 
Production Interpretation (PI) provides a streamlined workflow for interpretation of rate and pressure data to yield key 
reservoir and well parameters using quick semi-analytical simulation and industry standard interpretation tools. PI 
allows engineers to identify productivity problems and efficiently perform production management at early stages. 
The toolkit can be used to quickly evaluate production performance, interpret production data, and optimize 
production, stimulation and completion operations. 
 
PI delivers the Forecasting and Rate transient analysis workflows. 
 
The Forecasting workflow enables the quick setup and simulation of multiple models for screening, sensitivity 
analysis, and evaluating ‘what-if’ scenarios; aids you in performing pre-job design and sensitize/optimize on 
stimulation/completion parameters for unconventional wells.  
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The main features of the Forecasting workflow are: 
• Creates analytical simulation model with Petrel wells/completions 
• Creates analytical simulation case  
• Runs analytical production simulation/forecasting 
 
The Rate transient analysis workflow allows you to quickly estimate key reservoir/well parameters and run 
analytical simulation to match production. User performs flow regime recognition on diagnostic plots. Industry 
standard and Schlumberger-developed diagnostic plots (e. g., RNI diagnostic plot and Poe’s plot) are provided. With 
user supplied analytical case, PI constructs diagnostic plots to aid you in identifying the flow regimes with fit-line 
technique. Interpretation results can be used to update the model. You can run analytical simulation with 
interpretation calibrated model. Alternatively, PI supports manual input of model parameters to run simulation. 
The main features of the Rate transient analysis workflow are: 
• Creates RTA diagnostic plots for production data 
• Estimates key reservoir/well parameters from flow regimes on diagnostic plots 
• Runs analytical simulation to match production 
• Provides nonlinear regression 
 
PI also provides these additional features: 
• Data reduction to reduce data size through value and time threshold 
• BHP computation to compute BHP from WHP and production rates using VFP table 
• PTA pressure diagnostic plotting to create PTA log-log plots for observed data and ECLIPSE simulated data 
• RTA diagnostic plotting to create RTA plots for observed data and ECLIPSE simulated data 

Create analytical simulation model 

This model defines wells and completions, fluid and reservoir properties. An analytical reservoir model includes the 
static archive of wells and completions, fluid and reservoir properties. Petrel existing wells, completions, black oil 
fluid model and saturation function can be consumed. Alternatively, you can easily create wells, perforations, 
fractures from scratch inside PI. A simplified grid (1x1xN) is generated to represent a multilayer model geometry and 
properties.  
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Create analytical simulation case and run simulation 

Select analytical model and define historical or predicted production scheme. Run analytical simulation for pressure 
and rate prediction. The case is simulated by analytically solving a diffusion equation in multi-well context. 

 
 

Rate transient analysis 

The Rate transient analysis workflow allows you to quickly estimate key reservoir/well parameters and run an 
analytical simulation to match production. You can perform flow regime recognition on diagnostic plots. Industry 
standard and SLB developed diagnostic plots (for example, RNI diagnostic plot and Poe’s plot) are provided. With a 
user-supplied analytical case, PI constructs diagnostic plots to aid in identifying the flow regimes with fit-line 
technique. Interpretation results can be used to update the model. You can run an analytical simulation with 
interpretation calibrated mode. Alternatively, PI supports user manual input for the parameters to run simulation. 
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Non-linear regression 

NLR (Non-linear regression) is a process employed to determine the most possible values of parameters that 
adequately model the observed data. The process consists of adjusting the analytical simulation model’s parameters 
so that the simulation model reproduces the historic reservoir performance. 
 
Regression points selection is the identification of the observed data where the observed-to-simulated matches need 
to be improved. A fundamental part of history matching is the selection of parameters to improve the match. It is 
essential, however, to ensure changes are within the model’s geological uncertainty. A set of regression control 
parameters defines criteria for termination of regression. 
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Data reduction 

You can reduce data size through value and time threshold. 
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BHP computation 

You can compute BHP from WHP and production rates using vertical flow performance (VFP) table. It applies to multi-
well BHP computation. PI uses VFP table imported from ECLIPSE format keyword file or generated from the Petrel 
Well Deliverability module. 
 

 
Pressure transient diagnostic plot 

You can create pressure transient diagnostic plot from observed dataset, numerical simulation case or analytical 
simulation case. The pressure derivative diagnostic plot is used to spot trends in actual data that characterize well or 
reservoir system. Draw down and build up periods can be automatically detected. Alternatively, user can define 
specific transient periods to view the pressure transient plot overlay.  
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Rate transient diagnostic plot 

You can create rate transient diagnostic plot from observed dataset, numerical simulation case or analytical 
simulation case.  
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Shale 
2014.4 
Raster Logs 

Importing *.lic files with additional keywords 

In Petrel 2014.4, *.lic files may contain additional keywords such as PAYPIX and DIGTRK, which are repeating 
keywords that refer to data, in the same way that DEPPIX does in the files. Importing *.lic files that include these 
keywords is now supported. 

2014.3 
Raster Logs 
The performance for opening the “Advanced selection of files…” dialog while reconnecting multiple missing raster 
log files is improved. 

2014.2 
Geosteering 

Creating a Curtain Section with Changes 

You can create a cloned curtain section with your current changes at any point, while geosteering the well. The 
cloned curtain section can then be updated with one or all changes that you have made to your current curtain 
section. 
 
During geosteering of the well, you may want to create a cloned curtain section of your current work to make 
changes to the current curtain section to compare two or more scenarios.  
 
To create a cloned curtain section, go to the Models pane, navigate to the Curtain sections folder, and right-click 
the curtain section name with which you want to create a new curtain section with changes you have made. Select 
Create curtain section with changes from the right-click menu. A new curtain section is created in the models 
pane with the name “Clone of…” plus the name of the previous curtain section.  
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A Curtain section changes dialog box appears. The source curtain section is grayed out and set to the curtain 
section that you right-clicked. Set the THL limit for the curtain section changes to be applied, if needed, by dragging 
the slider or by entering a value in the box.  
 
Check the Show advanced settings box to display the curtain section changes that you have made. Any 
Automatic log matching or smoothing done to the curtain section is not included in the changes and cannot be 
applied. 
 

Click  to select all changes. Click  to unselect all changes. Click  to apply the next selected change. 
Changes can be undone by clicking on the Undo button in the Geosteering window toolbar or Geosteering tab 
(with the Ribbon activated). Click Apply once finished, or OK to apply the changes and exit. Click Cancel to close the 
dialog without making changes. 

Applying Changes to Curtain Section 

You can apply changes that you have made to the source curtain section to the cloned curtain section during 
geosteering of the well. 
 
To apply changes to the cloned curtain section, go to the Models pane, under the Curtain sections folder and right-
click the curtain section where you want to apply the changes that you have made to the source curtain section. 
Right-click Apply curtain section changes and the Curtain section changes dialog box appears. Select the 
source curtain section from the Curtain section: drop-down list.  
 



 

Petrel Platform What’s New Guide 2014 230 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Check the Show advanced settings box to display the curtain section changes. Changes made previously to curtain 
sections created with versions prior to 2014.2 are not included. Any Automatic log matching or smoothing done 
to the curtain section are not included in the changes and cannot be applied.  
 

Click  to select all changes. Click  to unselect all changes. Click  to apply the next selected change. 
Changes can be undone by clicking the undo button in the Geosteering window toolbar or on the Geosteering tab. 
Click Apply once the selected changes are satisfactory, or OK to apply the changes and exit. Click Cancel to close 
the dialog without making changes. 

Creating Blocks 

Hinges now appear as you select a point to rotate. Subsequent hinges create blocks that are rotated or translated 
individually. The hinges can be edited in the geosteering window. This is done by clicking a hinge and editing it in the 
Edit hinge dialog. 
 
Blocks are now created as you rotate selected horizons. This allows you to better control the blocks dip and throw. 
Two hinges define a block, and as you click to rotate a point, a new block is created. A block can also be clicked on 
when you select Translate Selected Horizons to translate it.  
 
To edit a hinge, in the Geosteering window, click the hinge that you want to edit or delete. The Edit hinge dialog 
box opens.  
 

 
 
Rotate or Translate selected horizons or Insert Slanted Faults must be active for Edit hinge to work. The hinge 
line will only appear for hinge rotation.  



 

Petrel Platform What’s New Guide 2014 231 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

 
 
Select the Edit selected hinge radio button. Use the trackbar to edit the THL of the hinge or enter a value in the 
THL: box. Use the Rotate horizons trackbar to rotate the horizons. Alternatively, you can enter a value in the Offset 
Y (-100~100) box. 

Rotating horizons will rotate only the selected block. 
 

To delete the hinge from the curtain section, select Remove selected hinge radio button. This does not delete the 
previous changes you have made with this hinge. Click OK to apply the changes or remove the hinge and close the 
dialog box. 

Pad Placement 

Deleting a Pad Configuration 

You can delete a pad configuration in Pad Placement. 
 
Created configurations can be removed from the pad configuration selection list. This action is irreversible whether or 
not you have saved the existing project, since the system removes it from the WellPadDesignPadConfigurations.xml 
file. 
 
To delete a configuration from the Drilling tab in the Pad well design group, click Pad placement. The Pad 
placement process dialog box appears. Click the Pad selection tab. Click the Create or add pad configurations 

icon .  
 

Select a configuration to delete from the Preview or edit existing: drop-down list. Click the  icon to delete 
the selected pad configuration. A warning dialog appears, asking if you want to continue to delete the configuration 
from the configuration file. Click OK to continue the deletion, or Cancel to stop the operation. 
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Creating a New SAGD Configuration 

You can create a new SAGD pad placement configuration or preview and edit the existing SAGD configuration. 
Creating a new SAGD pad configuration is similar to creating a new pad placement configuration. 
 
To create a new SAGD pad placement configuration:  

1. From the Home tab, select the Shale Perspective. 
 

2. From the Drilling tab in the Pad well design group, click Pad placement. The Pad placement process 
dialog box appears. 

 
3. Click the Pad selection tab. 
 

4. Click the Create or add pad configuration icon . 
 
5. Click Create new to create a new configuration. 

 
6. Enter the number of wells. 
 
7. Check the SAGD check box if creating a SAGD pad configuration. If the SAGD option is checked, the 

preview display shows an injector/producer (I1/P1, for example) pair at the wellhead instead of well (W1, 
for example). 
 

8. Click Next. 
Specify the following options: 
o Number of rows 
o Space between wellheads 
o Row space 

 
9. Click Next. The Wellhead view is automatically displayed. 
 
10. If you want to specify lateral directions for individual wells, click Specify individual lateral direction. 

Clicking this option displays North and South options that you can click for each well. 
 
11. Customize or use the default values for the following options: 

o Horizontal spacing 
o Step out 
o Well length 

 
This is for preview display purposes only and is not used in the Pad placement Pad Selection dialog. 
 
12. Click Apply to save the new pad configuration. 
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This configuration will appear in the Preview or edit existing menu. Clicking Apply automatically updates 
and saves the WellPadDesignPadConfigurations.xml file. 

Buffer Zone Cost Function 

You can create the cost function by entering in a buffer zone. Enter Min and Max values where the drillable area is 
between. Optionally, you can select the Advanced Settings check box to define a cost function following the 
previous workflow. 

New Radial Pad Configuration 

A new radial pad configuration is available for you to use. The radial pad configuration is in a radial pattern and 
based on a required angle.  

Production Estimates 

Use the Production estimates tab to estimate production and profit, based on typical P10, P50, and/or P90 
production decline curves for your field or project, average cost of the well, and average price of oil or gas.  
 

Drop in decline curves for P10, P50, and P90 by selecting the appropriate function and clicking  .These are 
functions created with a New Function object or imported. The template for x-axis must be set to time, and the y-axis 
template must be set to Oil production rate or Gas production rate. Set these templates in the Function tab of the 
Settings for the function.  
 
The Scaling factor allows you to enter a reference length to use a linear scaling factor relative to this set reference 
length to estimate production for the new planned wells. Alternatively, a scaling function to define the scaling factor 
at a given lateral length can be defined.  
 
The Production Period indicates how long you want to estimate production for each decline curve. You can estimate 
production for 1, 3, or 5 years, or output production estimates for all three time periods by checking the required 
boxes. 
 
Profit estimates per well and per pad can be computed for each decline curve and production period. Indicate the 
average cost per well and average price of oil/gas. Profits are not estimated if the average price of oil/gas or the 
average cost per well is set to 0. 
 
Once all the parameters are set properly, click Estimate production. An attribute is created for each decline curve 
and production period defined, as well as profit estimates on the Pad locations and Laterals that were generated 
previously. The attribute created is named Pxx-xYear for production estimates, and Pxx-xYearProfit for profit 
estimates. Right-click on the Pad locations and select Spreadsheet to view the results for each pad, or right-click on 
the Laterals and select Attribute Spreadsheet to view the results for each well.  
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Well Restriction Data Type 

You can now use wells or all wells in a well folder as a restriction type. The restrictions are selected in the Geometric 
restriction fields in the Regional geometry tab of the Pad placement dialog box. 
 
Restriction Data Type shows the type of restriction that has been dropped in the process. Any well or well folder can 
now be dropped and the restrictions will include all active plans or definitive surveys. If the surface applicable 
location is selected, the wellhead location is used as a constraint, and if the reservoir applicable location is selected, 
the full trajectory will be considered as a restriction.  

Interactive Pad Functions in 2D windows 

You can now create, edit, or delete new pads interactively in the 2D windows. This is achieved through using the 
new Tool Palette, which allows you to click a reservoir surface to create a new pad. Click an existing pad to edit the 
pad by moving interactively or updating the parameters or delete it. 
 
To open the Tool Palette: 

1.  On the Home tab, select Shale Perspective. 
2.  From the Drilling tab, in the Pad well design group, click Pad editing. The Tool Palette appears for Pad 

editing. 
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To add a new pad: 

1. From the Tool Palette, click Add pad. The Pad specification dialog box appears. Enter the required 
parameters, using the sliding bar or enter the value directly in the boxes. The pad will update interactively. These 
parameters are exactly the same as those used for the Pad selection tab of Pad Placement. See the online 
Help for this tab for more details on what each of the parameters is used for.  

2. Click the 2D window to place the new pad where appropriate. Click and drag the new pad to the appropriate 
location. An active reservoir surface is required to place the pad. 

3. Check the Snap to ground location to grid box to snap the new pad to the grid, or uncheck the box to place 
the pad wherever you want. 

4. Click OK to apply the changes and close the dialog box. 
 
To edit a pad: 

1. From the Tool Palette, click Edit pad.  
2. In the 2D window, select a pad to edit. The Pad specification dialog box appears.  
3. Enter the required parameters, using the sliding bar or enter the value directly in the boxes. The pad will update 

interactively. These parameters are exactly the same as those used for the Pad selection tab of Pad 
Placement. See the online Help for this tab for more details on what each of the parameters is used for. 

4. Click and drag the new pad to the appropriate location, if required.  
5. Click OK to apply the changes and close the dialog box. 
To delete a pad: 

1. From the Tool Palette, click Delete pad. 
2. In the 2D window, click a pad to delete. The pad is automatically deleted. There is no undo function for this, so 

be careful when using this tool.  

Raster Logs 
The Raster Log module is now licensed to either Well Correlation or Shale Suite. Twenty-four-bit depth images are 
now supported in the module. 
 



 

Petrel Platform What’s New Guide 2014 236 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Studio 
Studio: Studio Client Petrel 

2014.3 
Annotate 
You can now reorganize and move your annotate objects (e.g., notes, attachments, etc.) into several folders within 
the Annotate folder. 

Find 
Checkshot and Maximum inclination of a Well have been added to the repository index and can now be found and 
filtered on by using Studio Find in Petrel. 

2014.2 
Synchronization 
To accommodate input that is less than an hour, the synchronization interval has been enhanced to accept a decimal 
value with the minimum of 0.05 hour. 

Annotate 
Annotate functionalities (such as, send to email, send to blog, etc.) are now compatible with Microsoft Office 2013. 

Find 

Studio search button 

The Studio search button has been enhanced to be a state button. Click the button once to launch Find, click the 
button again to close Find. 

Petrel frame of reference filter 

You can use the “Petrel frame of reference” filter to narrow down the search results to only show data from Petrel 
data sources indexed in version 2014.1 and above with the same or a different frame of reference. 



 

Petrel Platform What’s New Guide 2014 237 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

2014.1 
Find 

View Content in Search Results 

A new view content display option has been added to Search Results. 
 
With the view content display option, you will be able to preview the search results (for example: preview a surface, 
window contents, etc.) before loading them to Petrel project.  

Indexing Petrel Windows  

Petrel windows now can be searched and retrieved through Find.  
 

Petrel windows will be indexed and added to default index during project indexing. They will be available in the 
search result and can be retrieved for you to reuse so that you don’t have to set up new windows with the same 
display and settings. Windows that are open during indexing will have their thumbnails created and displayed under 
search results (with the content viewer display option or by opening the detailed information on the search result) so 
you can identify the contents easily. 

Related Items Filter  

A new related items filter has been added to allow users to search for data items related to an object through Find. 
 
With the related items filter, you will be able to search all annotations attached to a specific object, all windows that 
contain a specific object, and all objects being used in a specific window that have been indexed. 

Search Results Color Code Enhancements 

The ability to use Petrel native and custom color tables to color code search results has been added. 
 
You now have the ability to apply Petrel native color table or create a custom color table to be applied to discrete 
filters. Corresponding search results will be color coded accordingly, based on the specified color table. This feature 
is only available for the Find in Petrel interface. 

Square Maps Display for Search Results 

Search data is now displayed in square maps for visual analysis.  
 
You have the ability to apply square charts to a filter category with numeric value. The search data will be displayed 
as square maps for visual analysis – where the size of the squares reflects the attribute values. 

Filter the values of Filter Category 

A text filter has been added to narrow down the list of values of a filter category. 
 
You will be able to filter the values of a filter category based on a certain keyword. The list of available filter values 
will be updated and the values that match the keyword will be listed in bold at the top of the list. 
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Studio: Studio Server 

2014.3 
Data Transfer 
Automatic re-parenting of seismic cubes and interpretations  
Automatic re-parenting of seismic cubes and interpretations is now available during the transfer of superseding 
seismic survey from the repository to the Petrel project. The data administrator can supersede an existing small 
seismic survey to a new larger survey in the repository. This automatic re-parenting feature is optional - if enabled, 
when transferring the superseding survey from repository into the Petrel project, Studio will automatically re-parent 
the cubes and the 3D interpretations of the superseded survey to the superseding survey. 

Automatic user attributes matching for well data  
Automatic user attributes matching for well data is now available during data transfer to prevent proliferation of user 
attributes with different GUIDs. This feature is optional and can be enabled on your Studio repository by your Data 
Administrator. If enabled, well user attributes that have the same attribute name, attribute type, and template GUID, 
but a different attribute GUID between Petrel and the repository, will be matched during data transfer. The current 
automatic user attribute matching only covers a one-to-one scenario. 

2014.1 
Supported Data 
Additional information is being preserved in Studio. The following additional information is being preserved in and 
can be retrieved from Studio: 

1. Shapefiles with holes 
Petrel now supports display of holes for imported shapefiles. The hole information will be preserved when the 
shapefile is round tripped through Studio.  
Note: Displaying a shapefile with holes in a 3D window might cause the interface to flicker. 

2. Pre-defined log attributes 
• Log alias 
• Log type 
• Log source 
• Log version 
• Run date 
• Sample rate 
• Tool type 

3. Well uncertainty properties 
Uncertainty properties for well head position and ground offset: 
• Seabed or ground level elevation to MSL (Z unit) 
• Uncertainty of well head location – Radius (XY unit) 
• Uncertainty of well head location – Standard deviation(s) (unitless) 
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4. Well and Drilling 
• Support for multiple surveys per well  
• Definitive survey flag 
• Survey program 

5. Multi-Z interpretation 
Multi-Z interpretation is now supported by Studio and available in all Studio workflows (transfer, find, filter 
subscriptions, data tables, etc.). Plane information, dip and azimuth information will be preserved in Studio. 
Normals are required to be assigned for the multi-Z to be transferable to Studio.  
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Technology 
Technology: General 

2014.3 
Polygon Dragger 
Petrel 2014.3 introduces significant improvements to polygon editing in the 3D window by enhancing the usability of 
the dragger to move knee points in 3D space. 

Technology: Licensing 

2014.3 
Profiles 
Petrel 2014.3 introduces support for global license profiles by specifying a path to a global license profile file in the 
PetrelConfiguration.xml file. 

Technology: Visualization 

2014.3 
Visualization performance 
Petrel 2014.3 introduces significant performance improvements when displaying large number of well logs and 
further improves the performance of visualizing well-related data. Depending on your graphic hardware, you can now 
work with fully interactive 3D views that display thousands of well logs. 

Technology: User Experience 

2014.2 
Pane behavior when in auto-hide mode 
A new pane auto-hide and show behavior has been implemented in Petrel 2014.2. In order to bring out panes that are 
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set in auto-hide mode and are collapsed in the left-hand side margin of Petrel you now need to click the tab of 
interest. This differs from previous Petrel versions where collapsed tabs auto-showed when hovered over by the 
mouse. As before, the tab will auto-hide again once you click in a non-pane location. 

Tool palette 

Support an option to switch between 16px Elements and 32px Elements 

A large view option has been added to the tool palette for increased readability and usability on high-resolution 
monitors. 
Available in the tool palette settings area the new ‘Large view’ toggle allows you to choose large icons and text to be 
used in the tool palette and its callouts. 
 

Figure 126: Normal versus Large tool palette views 

 

Support Styling of Contextual Tabs and Tab Groups 
Contextual tabs have been implemented with a full vertical color band in order to better discriminate them from the 
domain tabs. 

Save light tool configurations 
Light tool configurations are now saved within the 3D Window folder in the Windows pane. They can be renamed or 
copied to other 3D windows. 
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Spot light 
Petrel 2014.2 re-introduces the spot light functionality fully integrated into the Light Tool with controls to move and 
adjust the spot light. Spot light configurations can also be saved and shared through the 3D Window folder in the 
Windows pane. 

Decoration tool in the 2D and 3D window 
The rotate and zoom “thumbwheels” are reintroduced to allow single axis scene manipulation, specifically useful for 
optical stacking workflows on seismic volume rendering. 

2014.1 
Multi-Frame Display 

Global cursor tracking and camera linking 

You can now quickly enable cursor tracking for all your display windows, whether or not they are currently active or 
visible. This is useful when you use window layouts to view the same data from different perspectives or when you 
create a plot window with multiple viewports. To enable cursor tracking for all windows, click the  Track cursor 
split button, then click the Track all cursors pull-down option. To disable from all windows, click the split button 
and select the Don’t track any cursors pull-down option. 
 
You can also synchronize the camera position in all your 3D windows, so that rotating and scanning your model in the 
active 3D window will have the same effect in other 3D windows. This is useful for plot windows as well as when 
your main display is tiled. To enable camera linking in all 3D windows, click the  Link camera split button and 
select the Link all 3D cameras pull-down option. To disable from all 3D windows, click the split button and select 
the Unlink all 3D cameras pull-down option. 

System enhancements  
Petrel 2014.1 introduces a new installer that performs basic hardware and environment checks, including: 

• Validation of the minimum required Graphic Card driver version 
• Validation of the minimum required physical RAM  
• Validation of the supported OS version  

In addition to feedback on basic system requirement, the installer provides links to more detailed descriptions of the 
recommended hardware setup as described in the Petrel Installation Guide.  
 
  



 

Petrel Platform What’s New Guide 2014 243 30 June 2015 
 

Schlum
berger Private – C

ustom
er U

se 

Figure 127: Sample results of the installer system checklist 

 
 

License selection user interface 
Significant improvements in the license selection interface mean that you can now mix Stack-on-Start and License 
Packages (Bundles). This lets you top up License Packages with individual Stack-on-Start license features. You can 
also save selections as License profiles and hover over features to see descriptions. And we included a new message 
log tab, for improved error handling when selecting licenses. 
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Figure 128 illustrates the selection dialog when the core license is set to Bundle 3. This license choice extended the 
Quantitative interpretation and Data analysis features selected in the Petrel modules section. The selection is 
saved as a profile named G&G default. Also visible in Figure 128 is the mouse-over feature describing seismic 
volume rendering and extraction. The message log in this figure illustrates the kind of warnings you might receive 
while connecting to a license server. 
 

Figure 128: The 2014 Licensing selection dialog, showing mouse-over descriptions and message log reminder 

 

2D Scale bar 
There is now an auto-adjusting, configurable scale bar object for the 2D window. As you zoom in and out in the 
display, the Scale bar automatically adjusts scale and unit. To change color, position, and font settings, double-click 
the Scale bar object in the Windows pane. 
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Figure 129: Scale bars appear by default in the lower left corner of a 2D window 

 

Color legend 
A new object-related Color legend feature complements the object-independent Auto legend. A color legend can 
be added by right-clicking an object in the tree and clicking Color legend. 
 

Figure 130: Launching the Color legend from an object’s context menu 

 
 

In addition to showing the color distribution of the object, the color legend displays a histogram by default. The 
histogram is enabled and disabled from the color legend’s Settings dialog or by right-clicking the color table in the 
display and switching the histogram on and off.  
 

Figure 131: Color legend and histogram, associated with a surface 

 

Color tables 
Petrel 2014.1 significantly improves color table handling and assignment by decoupling color tables from property 
templates. This allows you to change color tables for individual or multiple objects without creating a new template. 
Color tables can exist as local color tables applied to a specific object or as global color tables when applied to 
multiple objects. Options to create local color tables or promote them to global color tables are also available. All 
necessary color table operations, including scaling, can now be done directly from the object’s Settings dialog, on the 
Colors tab or by using the Inspector.  
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There are three default scaling options: 

• Limits defined in the color table 
• Use limits from property template 
• Auto-scale color table to data 

 
Default min/max value ranges can also be defined in the property template, but they will be superseded by settings 
in the color table. 
 

Figure 132: Colors tab in the Settings dialog of a seismic horizon 

 
 

In addition to more flexible color table handling, Petrel 2014.1 introduces an easy way to select color tables from an 
extended list of more than 50 domain-specific color tables. Preset color tables are organized in a structured hierarchy 
in the Templates pane, as illustrated in Figure 133. Notice that the Recently used lists displays the last color 
tables selected. Click More to select from a searchable color table selector, as shown in Figure 134.  
 

Figure 133: The color table selections available from an object’s Settings dialog, on the Colors tab 
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Figure 134: Searchable color table selector with different view options, from details to large icons 

 
 

Visualization performance 
Petrel 2014.1 introduces significant performance improvements when displaying large number of wells and well-
related data, such as well trajectories, well tops, well symbols, and well labels. Depending on your graphic hardware, 
you can now work with fully interactive 3D views that display tens of thousands of well trajectories.  
 
Polygon rendering and editing has been optimized, making it easy to select and edit large numbers of polygons that 
represent cultural data or interpretational boundaries, while maintaining full interactivity in the 3D or 2D window. 

File Application Menu and Home Tab 
As part of 2014 user experience improvements, common features and tools can be accessed independently of the 
selected perspective by clicking the File or Home tab.  
 
The File application menu provides centralized access to project and system tools and information which was 
distributed over several menu items in previous versions of Petrel. 
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Figure 135: File tab menu gives quick access to recent projects as well as project and system settings 

 
 
When you start Petrel, the Home tab is selected by default. It contains common tools and operations, including:  
• View options for the Inspector, players, and panes 
• Insert options for data, objects, and folders 
• Petrel and Studio search features 
• Data management tools for Studio or Reference Projects 
• Notification and clipboard operations 
 

Figure 136: Petrel ribbon, showing Home tab features 

 
 
Some of the tools available on the Home tab are duplicated in the Quick Access toolbar. This means you can still 
have quick access to commonly used features when the ribbon is minimized. And the Quick Access toolbar can be 
customized. 

Output sheet  
In Petrel 2014.1, the Output sheet is saved with the project as a window, meaning that reports of results or residuals 
can be saved, and can be made part of a Layout.  
 
As a side effect of this change, Workflows that set and use visual filters may no longer work as they did previously. 
In order to recover them the window in which the filter is applied must be explicitly activated in the Workflow using 
the "Set active" command. 
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Technology: User Assistance 

2014.1 
Help Center 
Petrel 2014 introduces many enhancements to the Petrel Help Center:  
 

 
 
We continue to evolve our User Assistance offerings by moving towards a robust system with multiple entry points 
for every stage of use, giving you everything you need to fully understand your workflow. 
 
In 2014 we introduce a new Videos tile containing videos detailing the new User Experience and Interface in Petrel. 
Five detailed videos are delivered with Petrel and several dozen more, covering all domains, and are available from 
the Software Download Center, accessible from the Help Center.  
 
We have also added main tiles for the new User Experience and Shale. Clicking these takes you straight to the main 
landing pages where you can quickly get up to speed with new functionality and content. 
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Enrich Your Workflow 

Enrich Your Workflow is a new feature in Petrel 2014 that gives you the information you need to get the most out 
of your Petrel experience. Petrel offers many workflow enhancements through plug-ins, but with so many offerings, it 
can be hard to know which plug-ins are right for you and how compatible licenses and plug-ins can enrich your day to 
day workflows. So we have taken the guess work out of it. For each domain, we tell you what other licenses would 
be beneficial for your work based on your current perspective and licenses in use. In addition, Petrel 2014 achieves 
the next level of seamless integration between Ocean plug-ins and the Petrel Platform by providing you with links to 
relevant Ocean plug-ins that will specifically enrich your workflow. From the Help Center, you can click through to the 
Ocean Store where you can utilize the new Try Me functionality that enables you to test drive plug-ins from the 
cloud, giving you a sense of how your experience can be enhanced. Finally, we recognize that in the fast-paced 
environments of oil and gas, there is always something to learn, so we provide links to relevant training courses from 
NExT that will add to your domain expertise.  
 
The implementation of Enrich Your Workflow showcases the solution diversity and flexibility of our Platform, all while 
enhancing your experience as you get more out of Petrel than ever before.  

Other Features 

The Help Center also features a Document Archive, Release Notes, What’s New Guide, Ocean Store, Support Portal, 
and NExT training. 
 
Throughout the 2014 Petrel platform, we will be adding new and useful features to the Help Center that will enable 
you to get the Help you need, when you need it, for all aspects of your workflow. 
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